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1. Overview

Features

New 3624 mm Full Frame CMOS
Image Sensor

Supports image capture at resolutions up to 6048
X 4032 pixels.* By switching the imager mode, the
unit can natively support many shooting formats,
including Super 35 24.3 x 12.8 mm, 4096 X 2160
pixel resolution (equivalent to 3-perforation
motion picture film) and 4:3 Anamorphic* Super
3524.3 x 18.3 mm, 4096 x 3024 pixel resolution

(equivalent to 4-perforation motion picture film).
* Full Frame and Anamorphic modes require licenses sold
separately.

Wide Latitude

The unit supports 15+ stops of latitude. It features
very low noise for delivering phenomenal images
in conditions from searing sunlight to almost

no light, allowing for unprecedented creative
freedom in grading.

Wide Color Space Capture

Images can be captured in a color space that
exceeds DCI-P3. The degree of freedom in the
grading is dramatically improved when using
Sony’s S-Gamut and S-Gamut3.Cine color space
together with S-Log3.

Dual Base ISO

The unit supports two selectable native 1SO
settings (150500 and 1SO2500). Using Base 1SO500

under normal lighting conditions and Base
ISO2500 under low light conditions allows you
to maintain the latitude balance between bright
and low light conditions when shooting, without
graining (noise).

PL Lens Mount

Equipped with the industry-standard PL lens
mount. The lens mount supports Cooke /i
technology, and lens information is recorded as
metadata frame by frame.

E Mount Lens

E mount lenses are supported by removing the PL
lens adaptor. E mount lenses are smaller and lighter
than PL lenses, and are available in a diverse lineup for
expanded possibilities in image reproduction.

Compact Body and Intuitive
Operation

A relatively compact design for a device equipped
with a large Full Frame image sensor, achieved
using Sony’s miniaturization technology, which
allows easier shooting in confined spaces or on
drones.

The position, shape, and size of the control
buttons reflect the requirements of camera
operators for intuitive operation. They also feature
backlighting for ease of use in dark locations.

Engineered to Survive

The chassis is made from magnesium alloy for
high robustness and durability. The ventilation
system is completely isolated from all electronic
components to prevent ingress of dust, sand, and
liquids.*

The silent-running fan can be removed and
cleaned on-set quickly and easily to maintain high

readiness.
* Design protects against dust and rain, but cannot
completely prevent the ingress of dust and liquid.

Modular Design

Features a fully modular design, allowing you

to flexibly support various rigs and peripheral
equipment according to the shooting application.
The top handle and viewfinder are easily adjustable
to maintain ergonomic balance and ease of use with
lenses. The height of the optical axis is the same

as the PMW-F55, permitting the use of peripheral
devices used with the PMW-F55. And an optional
AXS-R7 Portable Memory Recorder can be securely

attached to the rear of the unit using four hex screws.

8-Position Optical ND Filter

Employs an 8-position optical ND filter. It offers
a wide ND range of 0.3ND (1/2 = 1 stop) to
24AND (1/256 = 8 stops) that reduces time lost
on set changing external ND filters. The ND filter
mechanism is servo-controllable.

Intuitive and Familiar On-Set
Operation

The menu screen is available from both sides of
the camera, with the main control display on the
Assistant side of the camera for fast access to the
camera settings by the camera assistant while
shooting.

An OLED mini display on the Operator side allows
the operator to access commonly accessed
features such as ND filter position, shutter, white
balance, exposure index (El), and frame rate (FPS),
making it convenient for the operator to check the
status of the unit.

Paint Control from RM/RCP Units

The unit supports control from an RM/RCP panel
that can be used with broadcast camcorders
and system cameras. When connected, ITU-R
Rec. 2020 color space and HLG are selectable
and adjustment of various paint parameters is
supported.

High Frame Rate (HFR) Shooting

4K RAW recording at frame rates up to 120 fps is
supported using the unit in combination with an
AXS-R7.
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Remote Control Unit Support

By connecting an RM-B170 or other remote
control unit, you can control some of the functions
of the unit from the remote control unit even
when Technical > System Configuration > RM/
RCP Paint Control (page 68) is set to Off in the

full menu.

Various Recording Formats

The unit supports recording on SxS memory cards
in XAVC 4K/QFHD, MPEG HD, and HD ProRes 422
formats. In addition, it can record in 16-bit RAW or
X-OCN format onto AXS memory cards when used
in combination with an optional AXS-R7 Portable
Memory Recorder.

Imager Block Extension

The imager block can be extended from the
camera body by 2.7 m (89 ft) or 5.5 m (18 ft) by
connecting the CBK-3610XS* Camera Extension

System.
* Update the firmware to version 3.0 or later.

Effective Picture Size

The unit supports shooting in the following effective picture sizes.

[Note]
A software license is required to shoot in 6K 17:9, 6K 1.85:1, 6K 2.39:1, 6K 3:2, 5.7K 16:9, 4K 4:3, 4K 6:5, and 4K 2.39:1.

6K 1.85:1 —1— N == 4K6:5

— : 4K 4:3
U 6K 2.39:1

—e

4K 2.39:1

4K 17:9
(DCI 4K)

5.7K16:9

L —— - —2--- 3.8K16:9
(Ultra HD)

’_______________________
T

6K 17:9 —y
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Software Licenses

You can select software licenses (optional) according to the intended usage of the unit.
Software licenses are installed using Maintenance > License Options (page 72) in the full menu.

Supported Shooting Frame Rates and De-Squeeze Values

The following table shows the supported shooting frame rates and De-Squeeze values (page 59) in
each imager mode.

Full Frame License

I Anamorphic License

High Frame Rate License

Software license Imager mode  Effective W x H(mm) Project frame rate
number of
pixels Imager mode Shooting frame rate De-Squeeze
(Image pixels) Standard Extension framerates Off (1.0x) 1.25x 1.3x 1.5x 1.8x 2.0x
License not required " 3.8K16:9 3840 x 2160 228x%x128 23,24, 25,29,50,59 6K 3:2 1to 25 Up to 60 Yes Yes Yes Yes Yes Yes
3.8K16:9 3840 x 2160 22.8%x12.8 23,24, 25,29 6K 1.85:1 1to 30 - Yes - - - - -
Surround View (4268 x 2400) (254 x 14.3) 6K 17:9 1to30 - Yes Yes Yes — — Yes
4K17:9 40962160  243x128  23,24,25,29,47,50,59 6K 2.39'1 11030 _ Yes _ _ _ _ _
4K17:9 4096 x 2160  243x128  23,24,25,29 57K 16:9 11030 _ Yes _ _ _ _ _
Surround View (4552 x 2400)  (27.0x 14.3) 2K 65 7T t0 30 — Yes _ - - - Yes
Anamorphic License 4K 4:3 4096 x 3024 243 %180 23,24, 25,29,47,502,5923 4K 43 Surround 11030 _ Yes _ Yes _ _ Yes
4K 4:3 Surround 4096 x 3024 243 x 180 23, 24, 25, 29 4K 4:3 11048 Up to 60, 66, 72’ 75 Yes _ Yes _ _ Yes
View (4552x 3360)  (27.0x 20.0) 4K17:9 Surround 11048 - Yes Yes  Yes - - Yes
4K 6:5 4096 x 3432 243 %204 23,24, 25,29
- 4K'17:9 1 to 60 66, 72,75, 88,90, 96, Yes Yes Yes - - Yes
Full Frame License " 5.7K16:9 5674 %3192 33.7x189 23,24,25,29 100,110
6K 2.39:1 60482534 359x150  23,24,25,29 [k 230 = 190 Ves - - - - -
6K 179 6054 %3192 360x190  23,24,25,29 ek oo comourd 1o 1= Yes - - - - -
6K 1.85:1 6054 x 3272 360x194  23,24,2529 38K 169 e Yes - - - - -
6K 3:2 6048 x 4032 359x240 23,24,25,29%,5023), 5923
High Frame Rate License 4K 2.39:12 4096 x 1716 243 %103 23,24, 25, 29, 50, 59

V" The Anamorphic license is required to enable ratio settings, other than Off(1.0x), for the de-squeeze function.

2 When a High Frame Rate License is activated.

3 AXS recording is supported, but AXS playback is not supported on the unit.
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Surround View

Surround View is a mode available in the following imager modes that displays an image range that
includes a 5% outer region beyond the effective picture size (top/bottom/left/right) in the viewfinder and
SDI'monitor output, allowing you to view a larger image range when shooting. The recorded image area
does not include the outer region.

38K 16:9

4K17:9

4K 4:3

[Notes]
® |n this mode, limitations on the maximum project frame rate setting may apply.
® |n 4K 4:3 mode with de-squeeze ratio of 2.0%, the image area includes only 5% of the top and bottom outer regions.
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System Configuration

Microphone Holder Base assembly (A-2182-620-A)
Rod Clamp (A-2182-621-A)
CH Rod (4-684-612-01)
L — Microphone Holder assembly (X-2596-733-2)
Screws P2.6x8 (2) (7-627-556-98)

DVF-EL200 DVF-L700 CBK-3610XS ECM-680S, ECM-678,
Viewfinder Viewfinder Camera Extension System ECM-674
(VF cable A-2203- (VF cable (A-2201-632-A or Microphone
745-A (supplied with A-2201-633-A) is required) (EC-0.5X3F5M is required) D /
unit) or 1-912-598-21 p— — -“\
is required) D &'%3
g i AXS-R7 AXS-A256524, AXS-A512548, AXS-ART, AXS-CRT
Ell: Portable Memory AXS-A512524, AXS-ATTS48, AXS Memory Card
= | Recorder AXS-A1TS24 Reader
CBKZ-3610A, = AXS Memory Card
CBKZ-3610AM,
CBKZ-3610AW SCL-PKe6,
Anamorphic SCL-P11X15 p—
License § S35PL Lens o RM-B170/B750
5 3 RCP-1000/1500/1530

90l RCP-1001/1501
Remote Control Unit

( BP-FL75, BP-FLX75
Battery Pack

U

—

| s @ FY]
Rk 3010F Anamorphic Lens / 4 <~
3 ' (PL mount / E mount) I
CBKZ-3610FM, MPC-3610
CBKZ-3610FW il —

Full Frame License

AXS-AR1
AXS Memory Card Reader

AC-DN2B, AC-DNT0A
AC Adaptor

SBAC-US30/UT100
| =y USB Card Reader
SBP-64/128/256E, SBS-32/64/128G1C
SXS Memory Card

3

Full Frame Lens
(PL mount / E mount)

VCT-FSA5
Shoulder Adaptor

CBKZ-3610H
CBKZ-3610HM
CBKZ-3610HW
High Frame Rate
License

—— QD-G32E/G64E/G120F/G240F
XQD Memory Card
(QDA-EX1 XQD ExpressCard Adaptor is required)

SELP28135G, SEL1635GM, SEL2470GM, SEL70200GM, SEL100400GM,
SEL1224G, SEL35F 1427, SEL50F14Z, SEL85F14GM, SEL90M28G,
SELT00F28GM

E Mount Lens
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| ocation and Function of Parts

7. CLIPS button If you connect earphones to the headphones

Operator Side

Press to display the clip screen on the mini
display to enable clip operations (page 78).
Simultaneously, the clip list screen is displayed

jack, the speaker output is suppressed
automatically.

- 5% memory card on the sub display and can also be used for 13 REC ACTI\./E !amp )
Airinlet slot block (page 9) ) ) The lamp is lit green when the REC button is
clip operations. enabled
12 3 4 To switch from playback mode to shooting ’
mode, press the HOME button. 14. ASSIGN (assignable) lamp 3 (page 39)
v Power switch The lamp is lit orange when the assigned
’ - function is on (enabled) or activated, and not
Set to the ON position (I) to turn the power on. lit when the function is off (disabled)
R Set to the OFF position (D) to turn the power '
Q T : ; I—J off. 15. REC (recording start/stop) button/lamp
- ﬂﬂ } ( ) 5 7 [Notes] Press to start'recording, turning the REC lamp
[ ] { e This unit uses a small amount of standby power on. Press again to stop recording, turning the
Ol even when the power switch is set to OFF. Remove REC lamp off (page 83).
% the battery pack if the unit will not be used for a The REC lamp flashes when a device error or
i;z L prolonged period. warning occurs
- { e When removing the battery pack or the DC IN 9 ’
-I 6 _ power, be sure to first set the power switch to the 16 o mark
" OFF position. Interrupting the power supply during ’ Th ki h | hei
recording or during memory card access could cause e ¢ markis on the same plane as the image
o 4&%1@ a malfunction. Sensor.
15 - M To measure the precise distance between the
2 1 9. HOME button . o unit and the subject, use the ¢ mark as a
14 Press to clear the item selection display and reference
return to the Home screen on the mini display.
If pressed when the unit is in playback state,
the unit transitions to shooting mode
13 1211109 8 7 6 a0 76)
10. LOCK switch
1. ASSIGN (assignable) buttons 1/2 (page 39) 4. Mini dlsplay Locks the operation of the buttons on the

Assign functions using the EDIT page of the
user functions screen (page 39).

The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

Displays various setup items, such as shutter
angle, that you can check or modify
(page 76).

5. ACCESS lamps (SLOT A/B)
Each lamp is lit when the recording media in
SXS card slot A/B is the target for recording/
playback and when data is being written to or
read from the recording media in SxS card slot
A/B (page 24).

Operator side. When locked, the switch
background LED lights in orange.

11. Headphones connector (stereo mini jack)
Connect to earphones for audio monitoring.
You can monitor the input audio during
shooting/recording and playback sound
during playback (page 75).

2. ASSIGN (assignable) lamps 1/2 (page 39)
Each lamp is lit orange when the assigned
function is on (enabled) or activated, and not

lit when the function is off (disabled). 2. Built-in speaker

You can monitor the input audio during
shooting/recording and playback sound
during playback. The speaker also sounds
alarms to reinforce visual warnings

(page 75).

3. Minidisplay ITEM keys 1 to 3 6. Network connector (RJ-45)
Controls the operation of functions on the Connect to a wired LAN network using a LAN
mini display (page 76). cable (not supplied) for remote control of the
unit (page 79).
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5xS memory card slot block (page 24)

The SxS memory card slots are located behind the
cover.

1.
2.

3.

Lo

SxS memory card slots A/B

Manufacturer calibration terminal
Manufacturer terminal for calibration and
servicing (cannot be used by users).

SLOT SELECT (SxS memory card select)
button
Press to switch the active slot.

Assistant Side

1.

H

D;j

HOI

@&

- FULL MENU

(©4O5 @8 i

)

[T

\
N

—|1
=

[

{

,@ D
|©~J :

LINE AESIEBU MIC
d

G

L —
e
O

14
15 13

ASSIGN (assignable) button 4 (page 39)
Assign functions using the EDIT page of the
user functions screen (page 39).

The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

ASSIGN (assignable) lamp 4 (page 39)

The lamp is lit orange when the assigned
function is on (enabled) or activated, and not
lit when the function is off (disabled).

Sub display

Allows you to check the operation status of
the unit and make various settings

(page 31).

12‘

11 10

With the Home screen displayed, press and
hold the BACK button (page 10) and turn

the SEL/SET dial to adjust the brightness of the
sub display and mini display.

The brightness can also be adjusted using
Technical > Control Display > Brightness level
(page 70) in the full menu.

Sub display ITEM keys 1 to 6
Controls the operation of functions on the sub
display (page 43).

. Tape measure hook

The tape measure hook is on the same plane
as the image sensor. To measure the precise

distance between the unit and the subject, use

the tape measure hook as a reference. You can
attach the end of a tape measure to the hook,
and measure the distance from the subject.

HOME button

Press to clear the display and return to the
Home screen on the sub display (page 33).

If pressed when the unit is in playback state,
the unit transitions to shooting mode.

MENU (menu display on/off) button (pages
43,54)

Press the MENU button to display the menu
screen on the sub display. Press and hold the
MENU button for 2 seconds or longer to
display the full menu screen on the sub
display. Press the button during menu screen
or full menu screen display to return to the
previous screen display.

SEL/SET (select/set) dial (MENU dial)
Changes the item selection or a setting within
the menu (pages 33,43, 54).

+48V power lamp

Lights in green if the AUDIO IN switch is set to
MIC and +48 V phantom power is supplied on
the AUDIO IN connector. It is not lit if phantom
power is not supplied.

You can turn +48 V phantom power on/off
using Audio category > Audio Details > Audio
Configuration > Phantom Power +48V

(page 67) in the menu.

. AUDIO IN (audio selector) switch

Select the input signal type corresponding to

the audio source connected to the AUDIO IN

connector.

LINE: When connecting an external analog
audio signal source

AES/EBU: When connecting an external digital
audio signal source

MIC: When connecting a microphone
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1.

12.

13.

14.
15.

16.

17.

18.

AUDIO IN connector (XLR 5-pin)

Input external microphone or audio
equipment signals.

When the audio source is set to LINE or MIC
using the AUDIO IN switch, this connector
functions as an AUDIO IN CH-1 and AUDIO IN
CH-2 connector.

When the audio source is set to AES/EBU using
the AUDIO IN switch, this connector functions
as the AUDIO IN CH-1/2 and AUDIO IN CH-3/4
connector.

BACK button

Cancels the menu setting and moves up one
level in the menu hierarchy during menu
display. Cancels the execution process or
pending process during process execution/
pending display (pages 33, 43, 54).

LOCK switch

Locks the operation of the buttons on the
Assistant side. When locked, the switch
background LED lights in orange.

ACCESS (SD card access) lamp (page 26)

REC ACTIVE lamp
The lamp is lit green when the REC button is
enabled.

REC (recording start/stop) button/lamp
Press to start recording, turning the REC lamp
on. Press again to stop recording, turning the
REC lamp off (page 83).

The REC lamp flashes when a device error or
warning occurs.

CLIPS button

Press to display the clip list screen on the sub
display to enable clip operations (page 73).
Simultaneously, the clip screen is displayed on
the mini display.

To switch from playback mode to shooting
mode, press the HOME button.

USER button
Press to display the user function list on the
sub display, and to operate the ITEM keys 1 to

5 user function buttons.

ITEM key 6 is the user function list EDIT button.

Press this button to display the function
selection screen for the user function buttons
and assignable buttons. Press again when the
user functions screen is displayed to return to
the previous display (page 39).

Front

AU
=1

\_‘_f | — —J

. ASSIGN (assignable) button 3 (page 39)

Assign functions using the EDIT page of the
user functions screen (page 39).

The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

PL lens mount adaptor (page 19)

. VF (viewfinder output) connector

(page 22)

LENS connector (12-pin)

Supports iris, focus, and zoom control from a
network-connected computer, smartphone, or
tablet in firmware version 4.0 or later.

. 24V OUT connector (DC OUT 24V, Fischer

3-pin)
24V DC power supply output connector
(page 90).

The output voltage and maximum output
current of this connector vary depending on
the input voltage to the unit. The maximum
current includes the output current from the
24V OUT connector on the rear panel
(page 11).
11Vto 17 Vinput

Output voltage : 24 V

Maximum output current: 1.0 A

22Vto32Vinput
Output voltage: Same as the input voltage
Maximum output current: 2.0 A
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Rear

1.

%
o]
o
20

13 =7 =
12—
11

T

N

10

T

N

24V OUT connector (DC OUT 24V, Fischer
3-pin)
24V DC power supply output connector
(page 90).
The output voltage and maximum output
current of this connector vary depending on
the input voltage to the unit. The maximum
current includes the output current from the
24V OUT connector on the front panel
(page 10).
11Vto 17 Vinput

Output voltage : 24 V

Maximum output current: 1.0 A
22Vto32Vinput

Output voltage: Same as the input voltage
Maximum output current: 2.0 A

12V OUT connector (DC OUT 12V, Hirose

4-pin)

12V DC power supply output connector

(page 90).

The output voltage and maximum output

current of this connector vary depending on
the input voltage to the unit.
11Vto 17 Vinput
Output voltage: Same as the input voltage
Maximum output current: 1.0 A
22Vto32Vinput
Output voltage: 15V
Maximum output current: 0.8 A

. MONITOR OUT connector (BNC type)

HD SDI monitor signal output connector
(page 90).

. GENLOCK (genlock input) connector (BNC

type)

To genlock the unit to an external source or to
lock the timecode of the unit to an external
source, input an external reference signal.
Digital signal and analog signal input are
supported.

Digital signal: 1.5G HDSDI interlaced signal
Analog signal: HD sync, Analog

10.

11.
12.
13.

. TCIN (timecode input) connector (BNC type)

To lock the timecode of the unit to an external
source, input a reference timecode signal.

AUX connector (LEMO 5-pin)
Outputs the timecode signal (page 91).

REMOTE (remote control) connector (8-pin)
Connect to a remote control unit or other
external control device.

12V/24V (DC power input) connector

(page 16)

DC power supply input connector for external
power supply to the unit. Supports 12V and 24
Vinput voltages.

o o
No. Signal
1 GND
2 NC
3 NC
4 DCIN(11Vto17Vor22Vto32V)

Battery attachment terminal (page 16)

SDIOUT 1 to 4 (serial digital output)
connectors (BNC type) (page 90)

Battery pack mount (page 16)
Battery release lever (page 16)

HDMI OUT connector (page 90)
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. External device connector

Used for updating an AXS-R7 AXS Recorder
(option) when the AXS-R7 is attached to the
unit (page 29) or for using camera wireless
remote control (page 79) by connecting a
CBK-WAO2 Wireless LAN Adaptor (option).

Release button (page 18)

3. Handle/VF attachment mount (page 18)

Accessory mounting screw holes

Type of screw: 1/4-20UNC (8)

Type of screw: 3/8-16UNC (10)

Length of engagement: 10 mm (3/8 inch) or
less

9]

Bottom
1 2
I W 3
o=
M — ©::£@ ©=——+©
1](©Qo0ojoe0) *
( =219 ©
N=c i
| ~ @m =
il | 6o N
( SR/ :’ ©
5
Air vent

1. Tripod plate attachment holes
Type of screw: 1/4-20UNC (2)
Type of screw: 3/8-16UNC (4)
Length of engagement: 9 mm (3/8 inch) or less

2. Bottom cover
Remove the four hex screws to remove the
cover.

3. SD card slot (page 26)
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Viewfinder/Monitor Screen

During shooting (recording or standby) and playback, the information selected in Monitoring > OSD
Appearance > Status Info A/B Setup (page 63) in the full menu is displayed.

Information displayed on the screen while recording

1.

B I 0 O 7] 220 N e s,
4K

W
N
ww W
wh U

i
-
@S

Im
—
No

L
w2

IR

— —
WOoON O U1 D~

NNON WW
NOoOWwW O —
EESH

26 25 24

Recording frame rate indicator
Displays the recording frame rate and project
frame rate.

Shutter angle/shutter speed indicator
Displays the shutter angle or shutter speed of
the electronic shutter, according to the
Technical > System Configuration setting in
the full menu.

ND filter indicator
Displays the density of the ND filter. The
display value is a LOG (base 10) value
(page 55).

CLEAR

0.3(1/2)

0.6 (1/4)

2:34:56:00))(A007C00D (T Rec )  ((XXOCN ST /MPEG 422)) || (TAXS BN 120 min ISxS B4 180 mi

23 22 21

High Ke!

<

L
N
S

(178)
(1/16)
(1/32)
(1/64)
(
(

0.9
12
1.5
1.8
2.1(1/128)
24 (1/256)

4. Thermometer icon

Displayed when a high temperature warning

message is issued.
The description is displayed in the Info
category in the menu.

10.

11.

12.

. Warning icon

Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.

Exposure index (El)/gain indicator
Displays the El value, or the gain value (dB
units) set by an RM-B170 or other remote
control unit.

[Note]

The gain value is displayed only when Technical
> System Configuration > RM/RCP Paint Control
(page 68) is set to On in the full menu.

Color temperature indicator
Displays the color temperature and Tint value
of the white balance.

Look information display
Displays the selected Look (page 57).

Battery capacity/voltage indicator
Displays the following indicators according to
the type of battery power source.

Battery type Display

InfoLithium Battery remaining capacity

battery and remaining recording
time

Anton/Bauer Remaining battery capacity

battery (% indicator)

Other batteries  Input voltage

VF LUT indicator
Displays the viewfinder LUT (page 56).

VF Double Speed Scan indicator

Displays the on/off state of the function for
doubling the frame rate of the viewfinder
display.

VF Peaking indicator
Displays the on/off state of the peaking
function of the viewfinder display.

. VF Zebra indicator

Displays the on/off state of the zebra function
of the viewfinder display (page 41).

. SDIOUT 1/2 connector LUT indicator

Displays the LUT setting of the SDI OUT 1/2
connectors (page 56).

. SDI OUT 3/4 connector LUT indicator

Displays the LUT setting of the SDI OUT 3/4
connectors (page 56).

. Monitor LUT indicator

Displays the LUT setting of the Monitor output
(page 56).

. HDMI LUT indicator

Displays the LUT setting of the HDMI output
(page 56).
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18. SDI output REC trigger indicator

Displays the SDI output REC trigger status.

State Display
Technical > System Configuration > SDI Rec Remote Recording command
Trigger in the full menu superimposed on the
SDI output
Off - (Blank)
HD SDI Remote I/F Stop command Top: SDI
Bottom: Stop
Rec command Top: SDI
Bottom: REC
Parallel Rec Stop command Top: SDI-P
Bottom: Stop
Rec command Top: SDI-P
Bottom: REC

19. Network connection status indicator

Displays the network connection status (LAN
or Wi-Fi).

State Display

Disconnected or other error (valid
network connection settings)

Flashing

Connected (valid network connection On
settings)

Network connection function not Blank

used

20. Audio level meter indicators

21.

Displays the levels of audio channels 1 and 2
while recording.

Recording media state/remaining capacity
indicator for each media slot

Displays the state and remaining capacity of
the media in SxS memory card slots A/B and
AXS memory card slots A/B.

Al mark on the left of “AXS" or “SxS” indicates
the recording target media.

An indicator A° on the upper right of the slot
A/Bicon on the right of “AXS" or “SxS" indicates
the playback target media (green indicator
indicates media is being played).

22.

23.

24,

25.

A A icon'is displayed for media if a condition
occurs that could impact recording.

High Key/Low Key indicator (Monitor output)
Displayed when the Monitor output is High
Key (screen for checking blown-out highlights)
or Low Key (screen for checking blocked-out
shadows) (displayed for Monitor Out output).

Recording media format (codec) indicator
Displays the format of the recording on an AXS
memory card or an SxS memory card.

Recording status indicator
Displays the following recording operation
states of the unit.

Display Description

Recording

Recording standby

Ix
(1]
N

Picture cache recording
standby

Clip name display

Displays the first 8 characters of the name of
the next clip to be recorded in recording
standby mode.

26.

2].

28.

29.

30.

31.

32.

33.

Displays the first 8 characters of the name of
the clip currently being recorded when
recording.

Time data display

Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 44).

Iris position indicator

Displays the iris position (only when a lens that
is compatible with the iris setting display
function is attached).

The iris position indicator displays in 1/3 stop
increments when using an E mount lens.
[Note]

The F-stop value is displayed instead of the T-stop value
if the T-stop value cannot be obtained.

Focus position indicator

Displays the focus position (only when a lens
that is compatible with the focus setting
display function is attached).

Zoom position indicator

Displays the focal length of the zoom
(displayed only when a lens that supports the
zoom setting indicator is attached).

High Key/Low Key indicator (viewfinder
output)

Displayed when the viewfinder output is High
Key (screen for checking blown-out highlights)
or Low Key (screen for checking blocked-out
shadows) (displayed for viewfinder output).

Simultaneous recording status indicator
Displays the sub clip recording format in 1-slot
simultaneous recording mode (page 84).

SxS Sub LUT indicator

Displays the LUT setting to register for a sub
clip in SxS 1-slot simultaneous recording
mode.

SxS LUT indicator
Displays the LUT setting for SxS recording.

34. Base ISO indicator
Displays the configured native sensitivity.

35. Effective picture size indicator
Displays the effective picture size and whether
anamorphic de-squeeze conversion is applied,
set using Project category > Imager Mode in
the menu. In Surround View mode, a “Sur.V"
icon is displayed below the anamorphic
conversion factor icon (page 44).

Menu display and settings on the viewfinder
screen

When a DVF-EL200 is attached to the unit, press
and hold the Menu button on the DVF-EL200 to
display the Monitoring > VF Display (page 66)
and VF Function (page 66) setup menus on the
viewfinder screen. This allows you to configure
these functions while viewing the viewfinder
screen.

4180.0 ND2.4 | A 1250El

A001C001 Rec

X-OCN ST/ MPEG 422
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Information displayed on the playback screen

8

The following information is displayed on the playback picture.

o

. Time data display

Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 44).

Playback clip name display
Displays the first 8 characters of the name of
the playback clip.

Playback status indicator
Displays the playback status.

Playback media format (codec) indicator
Displays the recording format (codec) of the
playback clip.

Playback media indicator

Displays the type of recording media being
played.

A1) icon appears on the right if the memory
card is write-protected.

[ ]

e e e N oo I s> NN
1 2 3 4 5

o N

. Audio level meter indicators

Displays the levels of audio channels 1 and 2
during playback.

. Network connection status indicator

Displays the network connection status (LAN
or Wi-Fi).

State Display

Disconnected or other error (valid Flashing
network connection settings)

Connected (valid network connection On
settings)

Network connection function not Blank
used

. Thermometer icon

Displayed when a high temperature warning
message is issued.

The description is displayed in the Info
category in the menu.

. Warning icon

Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.
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Preparing a Power Supply

You can use a battery pack or AC power via an AC
adaptor.

For safety, use only the Sony battery packs and AC
adaptors listed below.

Lithium-ion battery pack
BP-FL75
BP-FLX75

AC adaptor
AC-DN2B
AC-DN10A

Using a Battery Pack

Insert the battery pack into the battery pack

mount (page 11) of the battery adaptor, then

slide the battery pack down to lock it in place.

To remove it, unlock the battery pack by sliding

it up while pressing the battery release lever

(page 11), then remove it.

[Notes]

e Before use, charge the battery pack with the battery
charger.

e A warm battery pack immediately after use may not be
able to be fully recharged.

® Remove the battery adaptor while supporting the unit
by hand.

Checking the remaining battery charge

When recording or playback is in progress using
the battery pack, the current battery remaining
time and battery voltage are displayed on the sub
display screen (page 31) and viewfinder/monitor
screen (page 13).

The unit indicates the remaining usage time in
minutes by calculating the available time with
the battery pack if operation is continued at the
current rate of power consumption.

If the remaining battery charge becomes low

If the remaining battery charge decreases to a
certain level during operation, the remaining
battery capacity indicator flashes and the REC
lamp flashes to warn you.

If the remaining charge further decreases to a
level at which operation cannot be continued, a
battery-empty message appears.

Replace the battery pack with one that is fully
charged.

To change the message levels

Change levels using Technical > Battery
(page 70) in the full menu.

Using AC Power (DCIN Power)

The unit works with AC power using the AC-
DN10A (optional) or AC-DN2B AC adaptor
(optional) and CCDD-X2 DC cable (optional).
11Vto 17Vand 22 Vto 32 Vinput voltage ranges
are supported.

[Notes]

® When switching to the DC IN power supply during battery
operation, use a power supply with a voltage in the range
12Vto 17 V.

e When using a 22 Vto 32 V power supply, first set the
power switch to the OFF position before connecting the
power supply.

® Do not switch directly froma 11V to 17 V power supply to
a 22 Vto 32V power supply, or vice versa. This may cause
a malfunction.

Using a Battery Pack and DCIN
Power Supply Together

Whenever an active power supply is applied using
a battery pack and a DC IN power supply, the DC
IN power supply takes precedence.

[Note]

When the power supply switches from battery operation to

the DC IN power supply, operation of the unit may stop if the

following occurs.

e Chattering of the connector contacts when inserting the
DC connector

e \/oltage drop when switching between power supplies
(more prevalent when the external load is greater)
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Setting the Clock

When you use the unit for the first time, the initial
setup screen appears on the sub display when the
power is turned on.

Set the date and time of the built-in clock using
this display.

Time Zone

The value shows the time difference from UTC
(Coordinated Universal Time). Change the setting
if needed.

[Note]
When Time Zone is changed, the clock setting changes
according to the time difference.

Setting the Date and Time

Turn the MENU dial (page 9) to move the

cursor, then press the MENU dial to set each menu
item. When you press the MENU dial when the
cursor is on “Set,” the setting display disappears
and the clock setting is completed.

After the initial setup screen disappears, you can
change Time Zone and date/time settings using
Maintenance > Clock Set (page 71) in the full
menu.

[Notes]

e |fthe clock setting is cleared because the backup battery
fully discharged when no power was supplied (no battery
pack and no DC IN connection), the initial setup display
will be displayed when you next turn the unit on.

e While the initial setup display is shown, no other
operation, except turning the power off, is permitted until
you finish the setting for this display.
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Attaching the VF Attachment and Handle

Attaching the VF Attachment Attaching the Handle

] Slide the VF attachment on in the direction of 1 Slide the handle on in the direction of the
the arrow to attach it. arrow to attach it.

2 Position the VF attachment in the desired 2 Position the handle in the desired front/rear
front/rear position, then turn the lock lever to position, then turn the lock lever to secure it in
secure it in position. position.

Hex socket
bolt

Lock screw

[Notes]
® You can also attach the VF attachment in the front/ [Notes]
rear or left/right orientation. ® You can also attach a lock screw using a hex wrench
e |f the lock lever is difficult to tighten or loosen, you (5 mm) to secure it in position.
can use a hex wrench (3 mm) on the lock screw on e |[f the lock lever on the handle becomes loose during
the top of the lock lever. use, you can secure the handle by tightening a hex
socket bolt (2 mm) beside the lock screw.
e You can also attach the handle in the reverse
To remove the VF attachment orration,

Turn the lock lever to loosen, press the release T he handl
button and slide the VF attachment off in the 0 remove the handle

reverse direction from when attaching it.
s en attaching Turn the lock lever to loosen, press the release

button and slide the handle off in the reverse
direction from when attaching it.
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Mounting a Lens

Recommended PL mount lens (Super 35mm size)
SCL-PK6/F, SCL-PK6/M (set of 6 lenses,

20 mm/25 mm/35 mm/50 mm/85 mm/135 mm)
SCL-PK3/F, SCL-PK3/M (set of 3 lenses,

20 mm/25 mm/135 mm)

SCL-P11X15

Recommended E mount lens

SELP28135G, SEL1635GM, SEL2470GM,
SEL70200GM, SEL100400GM, SEL1224G,
SEL35F147, SEL50F14Z, SEL85F14GM, SELOOM28G,
SELTO0F28GM

[Note]
Control may not be supported with some E mount lenses.
Use a recommended lens.

For details about available lenses for the unit, contact a Sony
service representative.

[CAUTION]

Do not leave the lens facing the sun. Direct
sunlight can enter through the lens, be focused in
the unit, and cause fire.

[Notes]

e Turn the unit off before attaching or removing the lens
and adapter.

® Alensis a precision part. Do not place the lens down with
the mount side facing down. Attach the cap supplied
with the lens.

e The lens interface of the unit is configured by factory
default for an SCL-P11X15 and lenses with Cooke type
connector. To use an SCL-PK6, SCL-PK3, or other lenses
that do not have a Cooke type connector, set Technical >
Lens Configuration > PL-Mt Interface Position (page 68)
to Off in the full menu. If this setting is not correct, an
alert message appears when the unit is turned on after
attaching the lens.

Attaching a PL Mount Lens

Remove the mount cover from the lens mount
by turning the PL mount lever
counterclockwise.

Turn the PL mount lever counterclockwise to the
stopper position.

Insert the lens into the lens mount by aligning
the concave part of the lens with the
positioning pin on the upper right of the lens

Secure the lens by turning the PL mount lever
clockwise while holding the lens.

[Note]
Do not turn the lens when attaching the PL mount lens.
[t may cause damage to the hot shoe pin.

To attach a Cooke /ilens

Align the contacts on the lens with the hot shoe of
the unit. There are two connectors on the side of
the lens adaptor, and either can be used.

To remove the lens

] Turn the PL mount lever counterclockwise
while holding the lens from underneath.

2 Pull the lens forward.

[Note]

If another lens will not be attached soon, carefully align
the concave part of the mount cover, then secure the
mount cover by turning the PL mount lever clockwise.

Adjusting the Flange Focal Length

The unit is shipped with the flange focal length
already adjusted. If you need to adjust the flange
focal length, remove the lens mount, and change
the shims with those of the appropriate thickness.
You can adjust the thickness by 0.1 mm in 0.01
mm increments.

Shims

The following shims are supplied with the unit.
0.05 mm x 1 (circular)

0.01 mmx 15 (1/3 arc)

1/3 arc shims should always be used as a set of
three shims. Insert shims to increase the flange
focal length. The unit is shipped with the flange
focal length already adjusted using the following
three types of shims.

and Adjusting the Flange Focal Length

0.10 mm (circular)

0.05 mm (circular)

0.01T mm (1/3 arc)

A seal is attached showing the shim thickness
when shipped.

Adjusting the flange focal length

] Remove the six Torx screws and remove the PL
mount flange.

2 Loosen the four Phillips screws on both sides
of the PL connectors (two locations), and
remove the PL connectors and PL connector
plates.

3 Attach shims to the PL mount adaptor (three
locations).

PL connector plates
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When using 1/3 arc shims
Attach shims so that they have the same
thickness in all three locations.

When using circular shims
Attach with the surface that has markings on it
facing the front.

Markings

{

Markings

4 Reattach the PC connectors (two locations) to
their original positions, and tighten the four
Phillips screws with 0.18 N-m tightening
torque.

5 Reattach the PL mount flange in its original
position, and tighten the six Torx screws to a
tightening torque of 0.35 N-m using a T8
torque wrench.

(leaning the Filter

To clean the filter, first remove the adaptor.
Exercise care when wiping the adaptor center
part (shaded part) with a cloth or other material
to prevent fibers adhering to surfaces. If fibers are
adhering, wipe off using a soft brush.

Adaptor

[ L\

Removing the PL Lens Adaptor

Remove the PL lens adaptor when you want to
mount an E mount lens to the unit. Attachment/
removal is performed with the rear side of the unit
facing down.

Remove the six hex screws (2.5 mm) and remove
the PL lens adaptor.

PL lens adaptor

[Notes]

® Removing the battery and placing the rear side of the unit
face down provides stability.

® When attaching/removing the adaptor, take care not
to touch the connector contacts of the unit and PL lens
adaptor.

To attach the PL lens adaptor

1 Check that the mount lever is in the locked
position.

2 Place the PL lens adaptor back in its original
position, insert the six hex screws (2.5 mm),
and tighten the screws to a tightening torque
of 0.8 £ 0.12 N-m using a hex wrench (2.5 mm).
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Attaching an E Mount Lens

] Remove the PL lens adaptor (page 20).

2 Push the lock switch up, and turn the mount
lever clockwise to release the lock.

Mount lever

Lock switch

3 Align the mounting marks (white) on the unit
and lens mount, and then push the lens into
the mount.

4 Secure the lens by turning the mount lever
counterclockwise while holding the lens.

Mounting marks
(white)

[Note]
When an E mount lens is connected, operation using a 12-
pin lens connector is not guaranteed.

To remove the lens

1 Push the lock switch up, and turn the mount
lever clockwise to release the lock.

2 Pull the lens forward.

[Note]

If another lens will not be attached soon, carefully
align the concave part of the mount cover, then
secure the mount cover by turning the mount lever
counterclockwise.
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Attaching a Viewfinder

Available viewfinders for the unit
DVF-EL200: OLED color viewfinder
DVF-L700: LCD color viewfinder

Viewfinders are available separately.
This section describes attachment of the DVF-
EL200 as an example.

For details about attaching each viewfinder, refer to the
operating instructions of the viewfinder.

[CAUTION]

Do not leave the unit with the eyepiece of the
viewfinder facing the sun. Direct sunlight can
enter through the eyepiece, be focused in the
viewfinder, and cause fire.

[Notes]

e Attach/remove the viewfinder while the unit is turned off.

® AVF cable (A-2201-632 or A-2201-633-A) is required in

order to attach the DVF-L700. Also, turn the unit on after

setting the POWER switch of the DVF-L700 to the ON
position.

Attaching a Viewfinder

] Align the viewfinder shoe with the groove of

the viewfinder mount on the VF attachment,
and attach the viewfinder.

Turn the viewfinder lock lever in the LOCK
direction to secure it in position.

50— | ock lever

>

Connect the viewfinder and unit using the VF
connection cable.

Viewfinder side:

Position the connector with the mark (red) at
the top, and fully insert the connector.
Camera side:

Alight the concave part of the VF connector
with the connector mark (red), and fully insert
the connector.

e Clamper

[Note]
Secure the cable in the clamper as required.

To remove the viewfinder

1

Disconnect the VF connection cable from the
viewfinder and unit.

2 Turn the lock lever in the direction opposite to

LOCK, then remove the viewfinder from the VF
attachment.

Adjusting the Viewfinder Position

To adjust the front/rear position

1

2

3

Loosen one or both of the front/rear rod lock
levers of the VF attachment.

Slide the VF attachment forward/rearward to
adjust the viewfinder position.

.

S
5O
9

g

Rod lock
levers

i
A4

Tighten the rod lock levers.

[Note]

If a rod lock lever is difficult to turn, pull the lever out,
turn it to a position where it is easier to operate, and
then push the lever back in.
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To adjust the left/right position and height
(angle)

1

2

3

Loosen the rod lock lever at the front of the VF
attachment.

Slide the VF attachment rod left/right and turn
the rod up/down to adjust the viewfinder
position.

L Lock screw

Tighten the rod lock lever.

Rod lock lever

[Note]

When the rod lock lever is loosened, adjust the lock
screw using a hex wrench (3 mm) to prevent the
viewfinder from falling down.

To adjust the viewfinder angle

You can adjust the angle of the viewfinder while

shooting.

1

Loosen the rotation lock lever on the
viewfinder mount.

2 Turn the viewfinder up/down to adjust the
angle.

Rotation lock lever

3 Tighten the rotation lock lever.
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Handling SxS Memory Cards

This unit records audio and video on SxS memory
cards (optional) loaded in the card slots.

About 5xS Memory Cards

Use the following Sony SxS memory cards or XQD

memory cards.*
* When using an XQD memory card, the XQD ExpressCard
adaptor (QDA-EX1) is required.

The supported memory cards differ depending on
the recording format.

SxS PRO+
SBP-256D/E, SBP-128B/C/D/E, SBP-64B/C/D/E:
Supported for all recording formats

SXS PRO

SBP-64A, SBP-32:

MPEG 1920x1080i, HD ProRes 422,
HD ProRes 422 Proxy

SX5-1

SBS-128G1B/C, SBS-64G1A/B/C, SBS-32G1A/B/C:
MPEG 1920x1080i, HD ProRes 422,

HD ProRes 422 Proxy

XQD memory card S series, G series

QD-S64E, QD-S32E, QD-G128A/E, QD-G64A/E, QD-
G32A/E, QD-G120F, QD-G240F: Supported for all
recording formats

XQD memory card N series, M series
QD-N64, QD-M128A, QD-M64A, QD-M32A:
MPEG 1920x1080i, HD ProRes 422 Proxy

Operations are not guaranteed with other memory
cards.

These memory cards comply with the ExpressCard
standard.

For details on using SxS memory cards and usage-related
precautions, refer to the instruction manual for the SxS memory
card.

® SxS, SXS PRO, and SxS-1 are trademarks of Sony
Corporation.

® XQD is a trademark of Sony Corporation.

® The ExpressCard word mark and logo are
owned by Personal Computer Memory Card
International Association (PCMCIA) and are
licensed to Sony Corporation.

® ProRes is a registered trademark of Apple Inc.

All other trademarks are the property of their

respective owners.

Inserting an x5 Memory Card

Removing an 5xS Memory Card

] Open the cover of the card slot block
(page 9).

2 Insert the SxS memory card into the slot with
the SxS label facing to the right.
The ACCESS lamp (page 8) lights in red
then changes to green once the memory card
is ready for use.

?) Close the cover.

ACCESS lamp status

Card slots A and B each have an ACCESS lamp that
indicate the slot status.

Lamp Slot status

Lights in red Accessing the SxS memory card

(writing/reading data)

Lightsin green  Standby (ready for recording or
playback using the SxS memory

card)

Off ® No SxS memory card is loaded.
® The loaded card is invalid.
® An SxS memory card is loaded,
but the other slot is selected.

] Open the cover of the card slot block.

2 Pull out the SxS memory card.

[Note]

Data integrity is not guaranteed if the power is turned off or
a memory card is removed while it is being accessed. Data
on the card may be destroyed. Be sure that its ACCESS lamp
is lit in green or off when you turn off the power or remove a
memory card.

Switching Between SxS Memory
Cards

When SxS memory cards are loaded in both slot A
and slot B, you can press the SLOT SELECT button
(page 9) to select the SxS memory card to use.

If a card becomes full, recording continues after
automatically switching to the second card.

[Note]

The SLOT SELECT button is disabled while recording/
playback is in progress. The memory cards are not switched
even if you press the button.
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Formatting (Initializing) SxS Memory
Cards

When an unformatted SxS memory card or an SxS
memory card formatted in another specification
is loaded, a message notifying you that the media
has a different file system appears. In this case,
format the memory card in the following way.

1 Select TC/Media category > Format Media in
the menu.

2 Select SxS Slot A (slot A) or SxS Slot B (slot B),
then press the MENU dial.
A confirmation screen prompting whether to
format the card appears.

3 Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

If formatting fails

A write-protected SxS memory card or memory
card that cannot be used with this unit will not be
formatted.

A warning message is displayed. Replace the card
with an appropriate SxS memory card, according
to the instructions in the message.

[Note]

All the data, including recorded pictures and setup files, are
erased when a memory card is formatted.

Formatting while recording

Even while recording, the SxS memory card loaded
in the other card slot can be formatted.

Checking the Remaining Recording
Time

While shooting (recording or standby), you can
check the remaining capacity on the SxS memory
cards loaded in each slot using the recording
media remaining capacity indicator on the Home
screen of the sub display (page 31) or the
viewfinder/monitor screen (page 13).

The available time for recording with the current
video format (recording bit rate) is calculated
according to the remaining space on each card
and displayed in time units of minutes.

[Note]
A (#)icon appears if a memory card is write-protected.

Exchanging an SxS memory card

e [f the total remaining time on the inserted
memory cards during recording becomes less
than 5 minutes, the remaining media capacity
indicator flashes, the REC lamp flashes, and a
beep sound is emitted to warn you. Replace the
cards with those that have sufficient space.

e |f you continue recording, the message “Media
Full” appears, and recording stops when the
total remaining recording time falls to 0.

[Note]

Up to approximately 600 clips can be recorded on one SxS
memory card.

The display of remaining recording time changes to "0”
and the message “Media Full” appears when the clip limit is
reached.

Restoring an SxS Memory Card

If for any reason an error should occur in a memory
card, the card must be restored before use.

If an SxS memory card that needs to be restored is
loaded, a message prompting you to execute the

restore operation is displayed on the sub display.
To start the restore process, select Execute by
turning the MENU dial, then press the MENU dial.
The restoration starts.

During execution, a message is displayed and the
ACCESS lamp lights in red.

When restoration ends, a completion message
appears. Press the MENU dial to dismiss the
message.

If restoration fails

® A write-protected SxS memory card, or one on
which an error occurred, cannot be restored.
For such a card, a warning message is displayed.
Release the write protection or replace the card,
according to the instructions in the message.
® An SxS memory card on which an error occurred
may become usable again when reformatted.
® |n some cases, some clips can be restored while
others cannot. Playback of the restored clips
becomes possible again.
® The following operation may restore an SxS
memory card for which the message “Could not
Restore Some Clips” is repeatedly displayed each
time you try the restoration process.
[1] Copy the required clips to another SxS
memory card.
[2] Format the unusable SxS memory card on
the unit.
[3] Copy the required clips back to the newly
formatted SxS memory card.
[4] Update the management file as described
below.

[Note]

For restoration of media recorded with this unit, be sure to
use this unit.

Media recorded with a device other than this unit or with
another unit of different version (even of the same model)
may not be restored using this unit.

Updating the management file

If clips cannot be played back, updating the
management file on the card may improve the
situation.

Use TC/Media > Update Media (page 62) in the
full menu to update the management file.

If you write an XAVC file that is imported by RAW
Viewer V2.2 or later to the “XDROOT\Clip” directory
of an SxS memory card directly, that file can
become playable by executing Update Media.
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Handling SD Cards for Saving Configuration Data

You can store the configuration file of the camera
on an SD card (optional). The stored file can be
loaded from the SD card.

Supported SD Cards

SDHC memory cards* (Speed Class: 4 to 10, non-
UHS, Capacity: 2 GB to 32 GB)

SD memory cards* (File system: FAT 16, Capacity:
up to 2 GB)

* Referred to as “SD cards” in this manual.

Inserting an SD Card

Insert an SD card into the SD card slot (page 12).
The ACCESS lamp (page 10) lights in red then
changes to green once the memory card is ready
for use.

ACCESS lamp status

Lamp Slot status

Lights in red Accessing the SD card (writing/

reading data)

Off ® No SD card is loaded.
® The loaded card is invalid.

Removing an SD Card

Press the SD card in slightly, then remove the card.

[Notes]

e Data integrity is not guaranteed if the power is turned off
or a memory card is removed while it is being accessed.
Data on the card may be destroyed. Be sure that its
ACCESS lamp is lit in green or off when you turn off the
power or remove a memory card.

® Make sure that the card does not pop out when inserting
or removing it.

Formatting (Initializing) an SD Card

SD cards must be formatted the first time they are
used in the unit.

SD cards for use in the unit should be formatted
using the format function of the unit. It is also
necessary to format an SD memory card if a
caution message is displayed when the card is
loaded.

If an SD card that was formatted in an
unsupported format is loaded in the unit, a file
system mismatch message is displayed.

] Select TC/Media category > Format Media >
SD Card in the menu, then press the MENU
dial.

A confirmation screen prompting whether to
format the card appears.

2 Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

[Note]
All data is erased when an SD card is formatted, and the data
cannot be restored.

To use media formatted with this unit in the slots
of other devices

Make a backup of the media, then format it using
the other device.
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Using with AXS-R7

Y d video/audio in RAW or X-OCN . . .
100 AXS.R? AXS (Aecass Memory Card Systam) Docking modle Inserting an AXS Memory Card Switching Between AXS Memory

(ards

Recorder (optional) by attaching the recorder to
the unit.

] Press the memory card slot cover open button

[Note]
To attach an AXS-R7 to the unit, the firmware version of the to open the cover. When two AXS memory cards are loaded, press
AXS-R7 may need to be updated according to the version the SLOT SELECT button of the AXS-R7 to switch

of the unit (page 29). The following shows the version active slot.
compatibility. O
OOO S
Version of unit Version of AXS-R7 S
10,101 1.1 &o :
201 20 3
S
30 30 J
40 40 SLOT SELECT button
N|
i _ 3 Attach the AXS-R7 to the unit, and tighten the
AttaChlﬂg the AXS R7 four hex screws. 2 Insert the AXS memory card into the card slot
with the label facing as indicated below.
[Note]

Attach/remove the AXS-R7 while the unit is turned off.

Removing an AXS Memory Card

] Unscrew the four hex screws (3 mm) on the

rear of the unit, and remove the battery plate. Open the memory slot cover of the AXS-R7, and

pull out the AXS memory card.

[Note]

Data integrity is not guaranteed if the power is turned off or
an AXS memory card is removed while it is being accessed.
Data on the card may be destroyed. Be sure that its ACCESS
lamp is lit in green or off when you turn off the power or
remove a memory card.

To remove the AXS-R7

Unscrew the four hex screws, and remove the 3
AXS-R7. Close the cover.

2 Unscrew the four hex screws on the rear of the
AXS-R7, and remove the docking module from
the AXS-R7.
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Recording to an AXS Memory Card

You can select the format for recording to an AXS memory card using Project category > AXS Rec Format
(page 44) in the menu.

During AXS standalone recording on the AXS-R7, recording automatically switches to the second AXS
memory card when the first card becomes full.

If using an S24 or S48 AXS memory card, the following restrictions apply depending on the AXS Rec
Format and Imager Mode settings. If an S24 AXS memory card is detected for a setting where 524 AXS
memory cards are not supported, a warning message is displayed.

AXS Rec Format Imager Mode Shooting frame rate and $24/548 AXS memory card support
24 25 30 48 50 60 75 110 120
X-OCN XT 3.8K16:9 S24/ S24/ S24/ S24/ S24/ S24/ - - -
S48 S48 S48 S48 S48 548
4K 2.39:1 - - - - - - - - S48
4K17:9 S24/ S24/ S24/ S24/ S24/ S24/ S48 S48 -
S48 S48 S48 S48 S48 S48
4K 4:3 S24/ S24/ S24/ S48 S48 S48 - - -
S48 S48 S48
4K 6:5 S24/  S24/  S24/ - - - - - -
548 S48 S48
57K 16:9 S24/ S24/ S48 - - - - - -
S48 S48
6K 2.39:1 S24/  S24/  S24/ - - - - - -
S48 S48 S48
6K 17:9 S24/  S24/ S48 - - - - - -
S48 548
6K 1.85:1 S24/  S24/ 548 - - - - - -
S48 S48
6K 3:2 S48 S48 S48 - - - - - -
RAW SQ 4K17:9 S24/  S24/ S24/ S24/ S24/ - - - -

S48 S48 S48 S48 548

AXS Rec Format Imager Mode Shooting frame rate and $24/548 AXS memory card support
24 25 30 48 50 60 75 110 120
X-OCN ST 38K 16:9 S24/ S24/ S24/  S24/ S24/ S24/ - - -
S48 S48 S48 S48 S48 S48
4K2.39:1 - - - - - - - - S48
4K 17:9 S24/  S24/ S24/ S24/ S24/ S24/ S24/ S48 -
S48 S48 S48 S48 S48 S48 S48
4K 4:3 S24/  S24/  S24/  S24/  S24/  S24/ S48 - -
S48 S48 S48 S48 S48 S48
4K 6:5 S24/  S24/  S24/ - - - - - -
S48 S48 548
57K16:9 S24/  S24/  S24/ - - - - - -
S48 S48 S48
6K 2.39:1 S24/  S24/ S24/ - - - - - -
S48 S48 S48
6K 17:9 S24/  S24/  S24/ - - - - - -
S48 S48 548
6K 1.85:1 S24/  S24/  S24/ - - - - - -
S48 S48 S48
6K 3:2 S24/  S24/ S24/ S48 S48 S48 - - -
S48 S48 548
X-OCN LT 3.8K16:9 S24/  S24/ S24/ S24/ S24/ S24/ - - -
S48 S48 S48 S48 S48 S48
4K 2.39:1 - - - - - - - - S24/
S48
4K17:9 S24/ S24/ S24/ S24/ S24/ S24/ S24/  S24/ -
S48 S48 S48 S48 S48 S48 S48 548
4K 4:3 S24/  S24/ S24/ S24/ S24/ S24/ S24/ - -
S48 S48 S48 S48 S48 S48 S48
4K 6:5 S24/  S24/ S24/ - - - - - -
S48 S48 548
57K16:9 S24/  S24/ S24/ - - - - - -
S48 S48 548
6K 2.39:1 S24/  S24/  S24/ - - - - - -
S48 S48 S48
6K 17:9 S24/  S24/  S24/ - - - - - -
S48 S48 548
6K 1.85:1 S24/  S24/  S24/ - - - - - -
S48 S48 548
6K 3:2 S24/ S24/ S24/  S24/ S24/ S48 - - -
S48 S48 S48 S48 S48
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Formatting (Initializing) an AXS
Memory Card

AXS memory cards must be formatted the first
time they are used in the AXS-R7 attached to the
unit.

Use the format function of the unit to format
AXS memory cards for use in the AXS-R7. It is
also necessary to format an AXS memory card if
a caution message is displayed when the unit is
turned on with the AXS-R7 attached.

If an AXS memory card that was formatted in a
format not supported by the AXS-R7 is loaded, a
file system mismatch message is displayed.

1 Select TC/Media category > Format Media in
the menu, then press the MENU dial.

2 Select AXS Slot A (slot A) or AXS Slot B (slot B).
A confirmation screen prompting whether to
format the card appears.

3 Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

[Note]

All data is erased when a memory card is formatted, and the
data cannot be restored.

Checking the Remaining Recording
Time

While shooting (recording or standby), you
can check the remaining capacity on a loaded

AXS memory card using the recording media
remaining capacity indicator on the Home screen
of the sub display (page 31) or the viewfinder/
monitor screen (page 13).

The available time for recording with the current
video format (recording bit rate) is calculated

according to the remaining space of each card and

displayed in time units of minutes.

[Note]
A [@] icon appears if an AXS memory card is write-protected.

Restoring an AXS Memory Card

If for any reason an error should occur in a memory

card, the card must be restored before use.

If an AXS memory card that needs to be restored
is loaded, a message prompting you to execute
restoration is displayed.

To start the restore process, select Execute by
turning the MENU dial, then press the MENU dial.
The restoration starts.

During execution, a message is displayed and the
ACCESS lamp lights in red.

When restoration ends, a completion message
appears. Press the MENU dial to dismiss the
message.

If restoration fails

® A write-protected AXS memory card or one on
which an error occurred cannot be restored. For
such a card, a warning message is displayed.
Release the write protection or replace the card,
according to the instructions in the message.

® An AXS memory card on which an error
occurred may become usable again when
reformatted.

® |In some cases, some clips can be restored while
others cannot. Playback of the restored clips
becomes possible again.

[Note]

For restoration of media recorded with this unit, be sure to
use this unit.

Media recorded with a device other than this unit or with
another unit of different version (even of the same model)
may not be restored using this unit.

Updating the management file

If clips cannot be played back, updating the
management file on the card may improve the
situation.

Use TC/Media > Update Media (page 62) in the
full menu to update the management file.

Updating the AXS-R7 Firmware
Version

You can update the version of the AXS-R7

firmware with the AXS-R7 attached to the unit.

[Notes]

e The firmware version of the unit must be 2.0 or later in
order to perform this operation.

® Set AXS Rec Format (page 44) to Rec Off before
performing this operation.

1 Prepare a USB flash drive updater according to
the update procedure for the AXS-R7.

2 Insert the USB flash drive updater in the
external device connector (page 12).

3 Execute the AXS-R7 update function using

Maintenance > Firmware > FW Update-AXS-R7
(page 72) in the menu.
The version update process takes about 15
minutes. When the version update process
finishes, the unit automatically restarts and
“Firmware Upgrade Done” is displayed.
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Sub Display

The sub display displays the Home screen, clip list screen, playback screen, menu screen, full menu screen, and user functions screen.
You can switch between the screens on the sub display using the buttons on the Assistant side of the unit.

User functions screen

User 1
SDI Frame Line

On

T2.8

Off
Monitor
Highlight Clip Ind
User 4

User 2 U

Monitor Monitor
Status Info

LUT bypass
On Off

TG 00:00:00:00

Auto
Fan Mode

User 5

HOME button

USER button

Home screen
FPS El
Fixed—24 2
1c600:00:00:00

DCIN1 A001

MENU button

sxS B 180min
1.8 SDI 3/4: Look

ND Sx8: Log

Co04

Isxs [ 120 min  XAVC QFHD C480 BT

3200+03

WB

HOME button

USER button

CLIPS button

Clip list screen

/A001C001_180101CQ

12

CLIPS button

HOME button

MENU button

A001C002_180101G7 & B

A001C003_180101HR &
A001C004_180101WK &
A001C005_180101S8 & EM
A001C006_180101GF & B

3

Playback screen

bur 00:00:00:00 23.98fps

»» x24 DCIN 15.0V 60FPS

Sxs | & 002/010 XAVC QFHD C480
A001C002_160328WW &

MENU button

CLIPS button

[ N
Menu screen Full menu screen
Imager Mode ; Project Shutter
Project Frame Rate TC/Media ND
Color Space Monitoring Exposure Index
AXS Rec Format Y Audio White Balance
SxS Rec Format Technical LUT Select
Sub Rec Format Maintenance Look
Audio Info
s~ J

USER button
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Home Screen

Press the HOME button on the Assistant side to display the Home screen. You can check the status of the
unit and set basic settings for the unit on the Home screen.

( FPS

[tem name/Setting
value/Function
display area

1.8

Iltem name/Setting value/Function display area

ITEM key 1 ITEM key 2 ITEM key 3
1 2 3

7¢G00:00:00:00 23.98fps 3.8K 16:9
DCIN 15.0V A001 coo4

XAVC QFHD €480

| sxs 120 min
SxS B 180min

4 5 6
ITEM key 4 ITEM key 5 ITEM key 6

[Note]

The areas labeled 1 to 6 correspond to ITEM keys 1to 6
(page 39). Press an ITEM key to select the corresponding
item. The ITEM keys for functions displayed in orange text
color are enabled.

=l>500f

Fixed-24 = 2500

TcG00:00:00:00 23.98fps

DC IN 15.0V
| sxs 120 min
SxS B 180 min
SDI 3/4: Look
SxS: Log

91

Shutter

180.0

3.8K 16:9
A001 C004 :
Status
XAVC QFHD C480 display area

3200+03
WB

. FPS

Displays and sets the video frame rate.

Exposure Index/Gain

Displays and sets the exposure index (El) (top
icon displays the Base ISO sensitivity) or the
gain set by an RM-B170 or other remote
control unit.

[Note]

The gain value is displayed only when Technical
> System Configuration > RM/RCP Paint Control
(page 68) is set to On in the full menu.

Shutter
Displays and sets the shutter speed/shutter
angle of the electronic shutter.

ND Filter
Displays and sets the ND filter position.

LUT
Displays and sets the monitor LUT.

WB (White Balance)
Displays and sets the white balance.

Status display area

. Time data display

Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 44).

Displays the type of data currently shown in
the time data display, as follows.

TCG: Recorded timecode

TCR: Playback timecode

Dur: Duration

. Frame rate indicator

Displays the value of the Project category >
Project Frame Rate setting in the menu
(page 44).

. Imager mode indicator

Displays the Project category > Imager Mode
setting in the menu, and de-squeeze
information.

. Clip name display

Displays “Reel: Camera ID + Reel Number” and
“ShotNumber”.

. Audio level meters

Displays the audio recording or playback
levels. The numbers 1 and 2 Indicate channels
Tand 2.

. Simultaneous recording indicator

When 1-slot simultaneous recording is
configured for the displayed media, a “Sub”
icon appears on the right of the displayed
main recording format.

2

7.

3

Recording format (codec) indicator

Displays the format of the recording on an AXS
memory card or an SxS memory card

(page 48).

Power supply voltage/Remaining battery
capacity indicator

Displays the power supply voltage or
remaining battery capacity.

Remaining media capacity indicator

Displays the active media icon, media type, slot
type (A/B), and remaining recording time
(when recording in the current recording
format).

It also displays the clip name during playback.

. Recording status indicator

Displays the following recording operation
states of the unit.

Display Description

Stby Recording standby

@ Rec Recording

@® Cache Picture cache recording

standby

. Thermometer icon

Displayed when a high temperature warning
message is issued.

The description is displayed in the Info
category in the menu.
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12.

13.

Warning icon

Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.

Ext-LK icon

Displayed when the internal timecode
generator is locked to an external signal input
to the TC IN (timecode input) connector.
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Operations on the Home Screen of the Sub Display

Basic Operation Changing the brightness of the sub display Step Edit Operation
You can change the brightness of the sub display
1 Pressthe HOMED using Technical > Control Display > Brightness You can change the settings available for selection
ress the utton. level (page 70) in the full menu. when “Step Edit" is displayed for [TEM key 4 in step
The Home screen appears. On the Home screen, you can also press and hold 2 in the basic operation. You can add and delete

FPS El Shutter the BACK button and turn the MENU dial clockwise settings on the settings edit screen.

. to change the brightness of the sub display in the
leed—24 2 50 0 1 80 . 0 sequence Minimum — Low — Mid — High with 1 On the settings selection screen, move the

QI VHVVHV VO [VEEREEEREEE I (e current setting as the base point. cursor to the setting you want to change or
DCINT5.0v Feel A00T Shot CO04 You can also press and hold the BACK button and delete, and press the Step Edit button (ITEM
I zzz 112?):::: XAVC QFHD C480 e the MENU dial counterclockwise to change key 4). A ‘
the brightness of the sub display in the sequence The settings edit screen appears.
1.8 S S VIOIOROER  High — Mid — Low — Minimum with the +
ND SxS: Log WB current setting as the base point.

[Note] Step Edit >
The display brightness setting is common to both the sub Use buttons or
2 Select the item to set using the ITEM keys 1 to display and the mini display, and is reflected on both displays 90.0 di
6. simultaneously. ial to select.
The setting value for items that can be ) . ) ¥
changed are displayed in orange. Display and operation when RM/RCP Paint

The following diagram shows an example Control is enabled Add Delete cancel

when ITEM key 3 is pressed.
® \When Technical > System Configuration > RM/

Step / Cont. T RCP Paint Control (page 68) is set to On in 2 Todeletea setting, press the Delete button (ITEM
Current: 172.8 the full menu, the gain value set by an RM-B170 key 4).
1144.0 144.0 orqther remote corjtro\ unitis displayed in the Note]
e 90.0 Us_e buttons or El display area. In this mode, the El display area The selected setting can be deleted if the “Delete”
(1/59.95) 45.0 dial to select. is grayed out, and the El value and gain value character string is displayed in orange.
22' cannot be changed. However, the Base ISO
: 5 setting can be switched. 3 Use the B button (ITEM key 2), & button
Step Edit < Cancel In this case too, the LUT display area is grayed (ITEM key 5), or MENU dial to change the
output and cannot be operated. setting.
® The following display areas are grayed out and
3 Move the cursor to the item or setting value to cannot be operated whenan RM-B170orother /4 o\ | oress the Add button (ITEM key
select using the ‘B button (TEM key 2), 8 remote control unitis connected and Technical 4 '
button (ITEM key 5), or MENU dial. > System Configuration > RM/RCP Paint Control THe setting is added and the display returns to

(page 68) is set to On in the full menu. Set

4 press the MENU dial or Set button (ITEM key 3) thfSSehtiltZgr ;?seplrae?a(?gz control unit (page 86). o

to apply the setting. e WB display area A setting can be added if the “Add"” character string is

the setting selection screen.

displayed in orange.

When setting White Balance

On the White Balance settings edit screen, you
can press the Coarse/Fine button (ITEM key 1) to
change the 1-step increment variation to coarse
or fine. You can also press the Temp/Tint button
(ITEM key 3) to switch the value between color
temperature (Temp) and color tone (Tint).

Coarse / Fine + Temp / Tint

Step Edit * Use buttons

or dial to
(User WB) 3200K +03 select temp.

Base: 3 Coarse=100K
3200 K + 03 Fine=1K

Add Delete Cancel

FPS Operation

Press ITEM key 1 on the Home screen to display
the FPS operation screen. You can press the
Variable/Fixed button (ITEM key 4) to switch
between “Fixed” for constant speed shooting and
“Variable (Select FPS)” for variable speed shooting.

Current:

FPS 26 Use buttons or

Project: dial to select.
23.98fps

Variable/ Fixed Cancel

[Note]
Audio is not recorded in “Select FPS” mode.
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El Operation

Changing the El value

You can change the El value using ITEM key 2 on
the Home screen.

1 Press ITEM key 2 on the Home screen.
The El setup screen appears.

*
250

Current:

EI 500 320

Use buttons or

400

640

| |
v

Latitude H: dial to select.

6.0 Stops
Base ISO:500

Change Base Cancel

7 Usethe X button (ITEM key 2),  button
(ITEM key 5), or MENU dial to change the
setting.

3 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.
*
Current: 250

320
EI'500 Use buttons or
Latitude H: 'm- dial to select.

6.0 Stops 1510]0]
Base ISO:500 640

Change Base Cancel

| |
v

Switching the Base ISO

You can switch the Base ISO by pressing ITEM key
4 on the El setup screen.

1 Press ITEM key 4 on the El setup screen.
The Base ISO switching screen appears.

2 Press the two Change buttons (ITEM key 1 and
ITEM key 3) simultaneously.

Change

Change
Change Base ISO?
ISO 500 — ISO 2500
Press both Change buttons together.

Cancel

The Base ISO is changed (page 38).

AWB Operation

Press ITEM key 6 on the Home screen to display
the white balance operation screen. Press the Auto
White Bal. button (ITEM key 1) to execute white
balance. After execution, press the Add button
(ITEM key 4) to add the setting to a step. You can
also press the Temp/Tint button (ITEM key 3) to
switch the value between color temperature
(Temp) and color tone (Tint) to make fine
adjustments to the value before adding a value to
a step.

Auto White Bal. *
3200 *©
® 3200 *

Use buttons or

Current:
3200 K
+03 4300 +©
(User WB) 5500 +00

dial to select.

Step Edit

Cancel

[Note]
During AWB operation, shoot a white chart under uniform
lighting conditions.

LUT Operation

Settinga LUT

You can set a LUT for each output system using
ITEM key 5 on the Home screen.

1 Press ITEM key 5 on the Home screen.
The LUT selection screen appears.

Page/ 2
Outputs

SDI 1/2 SDI 3/4

Log E—
Look 3535-Big v3.cube (3D-CDL)

CDL : ColorCollection002
Log : El not applied

— Look —/
HDMI

Edit Look Monitor

The LUT selection screen has two pages, and
you can switch the page by pressing ITEM key
1.

On page 1, you can set the LUT settings for SDI
1/2 (display only), SDI 3/4, Monitor, and HDMI.
On page 2, you can set the LUT settings for the
viewfinder, SxS Rec, and Sub Rec.

2 Select the output to set using ITEM keys 2, 3, 5,
and 6.
The settings edit screen appears.

3 Use the B button (TEM key 2), 8 button
(ITEM key 5), or MENU dial to change the
setting.

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

Changing Preset Look

You can set a LUT when Look is selected on the
LUT selection screen using the Edit Look button
(ITEM key 4) on page 1 or page 2.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

* Select

Preset look

Category

Preset Look

Load File

2 Press the Select button (ITEM key 3).
The items that can be selected are displayed.

3 Use the T button (ITEM key 2), & button
(ITEM key 5), or MENU dial to change the
setting.

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.
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Changing the LUT category

You can change the target category for LUT
operations to User 3D LUT or Preset Look.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

7 Use the T button (ITEM key 2), & button
(ITEM key 5), or MENU dial to enable category
selection.

3 Press the MENU dial or the Select button (ITEM
key 3).

4 Use the ‘B button (ITEM key 2), 8 button
(ITEM key 5), or MENU dial to select a category
(User 3D LUT or Preset Look).

5 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

Loading a User 3D LUT file

You can load a User 3D LUT file stored on an SD
card into the unit.

[Note]

Save the User 3D LUT file in the following directory on the SD

card (page 85).
PRIVATEASONYAPRO\LUT\

1 Insert the SD card into the SD card slot
(page 12).

2 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

3 Press the Load File button (ITEM key 4).

S 5 Select
User 3D LUT
s709.cube

Category

User 3D LUT

Load File

4 Press the MENU dial or the Select button (ITEM
key 3).
The load destination numbers (01 to 16) are
displayed.
A file name is displayed for loaded numbers.

* Select
01: sLog?2 to Linear.cube
02: LMT ACES v0.1.1.cube
03: Lightlllusion_LP.cube
04: Binary_Through_17.13D
05: Test0312_EI+0.6/Cube

Load 3D LUT

»m Stepl:
Select
Destination

$ Back

5 Use the 1 button (ITEM key 2), 3 button
(ITEM key 5), or MENU dial to select a load
destination number.

6 Press the MENU dial or the Select button (ITEM
key 3).
The file name of the User 3D LUT file stored on
the SD card is displayed.

* Load
3535-Big v3.cube
Rec709 to DCI-XYZ.cube
Raw Viewer_LP2.cube
Test0312_EI+0.6.cube
ACES_RRT709_V1--_f5_V7.13

Load 3D LUT

Il Step2:

Select File to
Load on 03

¥ Back

7 Use the B button (ITEM key 2), & button
(ITEM key 5), or MENU dial to select a file.

8 Press the MENU dial or the Load button (ITEM
key 3).
When the file is loaded successfully,
"Successfully loaded” is displayed.

9 Press the OK button (ITEM key 6).

Loading an ASC (DL file

You can load an ASC CDL file stored on an SD card
into the unit.
[Note]
Save the ASC CDL file in the following directory on the SD
card (page 85).
PRIVATEASONY\PRO\CDL\
1 Insert the SD card into the SD card slot
(page 12).

2 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

3 Press the Load File button (ITEM key 4).

Select
User 3D LUT
s709.cube

ASC CDL Info *

Category
User 3D LUT

ASC CDL Process CDL Off
ASC CDL Select 03: Scene4_Dark_160830

Done

Load File ¥

4 Select Load ASC CDL File, and press the MENU
dial or the Select button (ITEM key 3).

. 5 Select
Load User 3D LUT File
Load ASC CDL File

3 Done

The file name of the ASC CDL file stored on the
SD card is displayed.

Load All Files *
ColorCorrection001
Load ASC CDL ColorCorrection002
Select Files 03:Scened_Dark_160830
on SD Card List_04082018
Loadable Files: List 04022018
88

A 4

5 Use the B button (ITEM key 2), & button
(ITEM key 5), or MENU dial to select a file.
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6 Press the MENU dial or the Load button (ITEM
key 3).
You can press the Load All Files button (ITEM
key 1) to load all files.
When the file is loaded successfully,
“Successfully loaded” is displayed.

7 Press the OK button (ITEM key 6).

8 Specify the ASC CDL processing sequence in
ASC CDL Process.

ASC CDL Info *

Select
User 3D LUT
s709.cube

Category
User 3D LUT

ASC CDL Process [&b]N0jii
ASC CDL Select 03: Scene4_Dark_160830

Load File Done

Changing the User 3D LUT File

You can change the currently selected User 3D
LUT file.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

. 5 Select
User 3D LUT
s709.cube

Category
User 3D LUT

Load File

2 Press the MENU dial or the Select button (ITEM
key 3).

3 Use the ‘B button (ITEM key 2), 8 button
(ITEM key 5), or MENU dial to change the User
3D LUT file.

* Set
01: s709.cube
User 3DLUT g3 | MT ACES v0.1.1.cube
s709 03: Lightlllusion_LP.cube
04: Binary_Through_17.13D

05: Test0312_EI+0.6/Cube

$ Cancel

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

Changing the ASC CDL File

You can change the currently selected ASC CDL
file.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

2 Select ASC CDL Select, and press the MENU
dial or the Select button (ITEM key 3).

ASC CDL Info *

Select
User 3D LUT
s709.cube

Category
User 3D LUT

ASC CDL Process CDL Off
JAN{oN o] ST gl 03: Scened_Dark_160830

Load File

3 Usethe A button (ITEM key 2), $ button
(ITEM key 5), or MENU dial to change the ASC
CDL file.

* Set
01: sLog2 to Linear.cube
02: LMT ACES v0.1.1.cube
03:Scened_Dark_160830
04: Binary_Through_17.13D
05: Test0312_EI+0.6/Cube

ASC CDL Select

03: Scene 4
Dark_1608...

@ Cancel

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

Displaying ASC CDL information

You can display information for the currently
selected ASC CDL file.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

2 Select ASC CDL Select, and press the ASC CDL
Info button (ITEM key 1).

ASC CDL Info *
Category

Select
User 3D LUT

User 3D LUT s709.cube

ASC CDL Process CDL Off
AXS{oxeip]ST-1ISI i 03: Scened4_Dark_160830

Load File

The ASC CDL information is displayed.

03: Scene4_Dark_160830

Input Description:

GeneralProducts M1 std thru GP M1 LUT4
R €] B

Slope 1.000 1.000 1.000

Offset -1.000 -1.000 -1.000

Power 1.000 1.000 1.000

Saturation 1.000

About the ASC (DL file setting ranges

The ASC CDL file setting ranges are shown below.
Files that exceed the ranges cannot be loaded.
Slope: 0.000 to 3.999

Offset: -=1.000 to 1.000

Power: 0.400 to 4.000

Saturation: 0.000 to 3.999
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: ltem Description
Home Screen [tems on the Sub Display P
FPS Sets the shooting frame rate.
The names of items and corresponding setting values are given below. Variable/Fixed: Switch between variable speed and constant speed shooting.
Default values are shown underlined and in bold text. When “Fixed" is selected, the setting is determined by the Project category >
Project Frame Rate (page 44) setting in the menu.
[Note]
The maximum shooting frame rate value varies depending on the recording format. The maximum shooting frame rate value - N
is restricted to the following during SxS standalone recording and AXS/SxS simultaneous recording. Project Frame Rate Display
4K/QFHD XAVC Intra Class 480: 30 fps (max) 23.98 Fixed-24
4K/QFHD XAVC Intra Class 300: 60 fps (max) -
MPEG HD 422 Codec: 30 fps (max) 24 Fixed-24
ProRes Codec: 60 fps (max) 25 Fixed-25
29.97 Fixed-30
47.95 Fixed-48
50 Fixed-50
59.94 Fixed-60

When “Variable" is selected, the setting changes as follows depending on the
Project category > Imager Mode (page 58) setting in the menu.

Imager Mode Setting

38K 169 1 to 60 FPS

4K 17:9

4K17:9" 1to0 60,66,72,75, 88,90, 96,
100, 110 FPS

3.8K 16:9 Surround View 110 48 FPS

4K 17:9 Surround View

4K 4:3

4K 4:3Y 1t060,66,72,75FPS

4K 239170 120 FPS

4K 4:3 Surround View 1to 30 FPS

4K 6:5

5.7K16:9

6K 2.39:1

6K 17:9

6K 1.85:1

6K 3:2 1to 25 FPS

6K 3:2" 110 60 FPS
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Item

Description

Exposure Index

Sets the El value. You can change the Base ISO setting by pressing the Change
Base button (ITEM key 4) and then simultaneously pressing the two Change
buttons (ITEM key 1 and ITEM key 3) on the subsequent screen. The available
settings vary as follows depending on the Base ISO setting.

Base 1SO 500:
125El/160El/200E1/250E1/320E1/400EIl/500El/640E1/800EI/1000El/1250E1/
1600EI/2000El

Base I1SO 2500:
640EI/800EI/1000EI/1250El/1600El/2000EI/2500E1/3200EI/4000E1/5000El/
6400EI/8000EI/10000EI

Shutter

Sets the electronic shutter angle/shutter speed.
Press the Step/Cont. button (ITEM key 1) to switch between step and continuous
selection methods.
Step: Select from up to 16 preset values registered as shutter steps. You can press
the Step Edit button (ITEM key 4) to change any setting from the preset value after
selection.
Displays the following selection options depending on the Technical >
System Configuration > Shutter Mode (page 68) setting in the full menu.

Angle: Shutter angle indicator

Default selection options
360/180/172.8/144/90/45/22.5/11.2/5.6

Speed: Shutter speed indicator

Default selection options
1/24,1/25,1/30,1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000?

[Note]

The default speed values for different Project Frame Rate (page 44) settings are
given below.

23.98/24:1/24,25:1/25,29.97:1/30,47.95: 1/48, 50: 1/50, 59.94: 1/60

Cont.: Select an angle/speed within the supported range.

Item Description
LUT Configures settings related to the LUT to apply to the output video.
Page 1

SDI 1/2 (ITEM key 2): Log
Display only, as LUT cannot be applied to the SDI 1/2 output image.
SDI'3/4 (ITEM key 3): Log/Look
Selects the LUT to apply to the SDI 3/4 output image.
Disabled when Monitoring category > Output Format > SDI 1/2 is set to 4K/
QFHD in the menu.
Monitor (ITEM key 5): Log/s709/R709(800%)
Selection becomes Log/Look when Monitoring category > Output Format >
SDI'1/2 is set to 4K/QFHD in the menu.
HDMI (ITEM key 6): Log/s709/R709(800%)
Fixed to Log when Monitoring category > Output Format > SDI 1/2 is set to
4K/QFHD and HDMI is set to 4K/QFHD in the menu. In all other cases, the
options are the same as for Monitor.
Page 2
Viewfinder (ITEM key 2): Log/s709/R709(800%)
Selects the LUT to apply to the viewfinder/monitor screen output image.
SXS Rec (ITEM key 5): Log/Look
Disabled when Project category > SxS Rec Format is set to Rec Off in the
menu, or fixed to Log when set to XAVC.
Sub Rec (ITEM key 6): Log/Look
Disabled when Project category > SXS Rec Format is set to Rec Off in the
menu.

Page 1/2 common items

Edit Look: Sets a LUT to apply as a Look.
s709 / R709(800%) / S-Gamut3.Cine/SLog3 / S-Gamut3/SLog3 / User 3D LUT

ND Filter

Sets the ND filter position. The following settings are available.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

WB (White Balance) Sets the color temperature/color tone of the white balance.
Default selection options
3200K+00/4300K+00/5500K+00
You can press the Step Edit button (ITEM key 4) to change the white balance
preset value and Tint value.
Auto White Bal.: Execute auto white balance.

" Only when a High Frame Rate License is activated.
2" The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0,
1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.
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User Functions Screen

You can press the USER button (page 10) to
display the user functions screen on the sub
display and use the ITEM keys 1 to 5 as assignable
buttons (User 1 to 5).

There are also four assignable buttons (1 to 4)
(pages 8,9, 10) on the unit and three

assignable buttons (A to C) on the viewfinder
(DVF-EL200) to which you can assign various
functions.

Functions can be assigned to these buttons using
the user functions screen, in addition to using
Project > Assignable Button in the full menu.

ITEM key 1 ITEM key 2

o o

User 1 User 2

SDI Frame Line Monitor
Status Info

On

ITEM key 3

O

User 3

Monitor
LUT bypass

On Off

7¢600:00:00:00

Auto
Fan Mode

Off
Monitor
Highlight Clip Ind

User 4

@)

ITEM key 4

User 5

@)

ITEM key 5

@)

ITEM key 6

[Note]

When a lens that supports the iris setting display function is
attached, the iris position is displayed in the center left of the
user functions screen.

Changing Button Functions

The user functions selection screen is displayed by
pressing the Edit button (ITEM key 6) on the user
functions screen. You can set the functions for the
User 1 to 5 buttons, assignable buttons 1 to 4, and
viewfinder assignable buttons A to C on the user
functions selection screen.

Select

SDI Frame Line
User 2 Monitor Status Info
User 3
User 4
User 5

Assign Btn 1

Monitor LUT bypass

Monitor Highlight Clip Ind
Fan Mode
VF Highlight Clip Ind

$ Done

1 On the user functions selection screen, move
the cursor to the button you want to change,
and press the Select button (ITEM key 3).

The functions that can be selected are
displayed.

*

No Assign
<User 1>

SDI Frame Line

SDI Frame Line
SDI Status Info

SDI LUT bypass

Monitor Frame Line

Monitor Status Info

$ Cancel

7 Use the B button (TEM key 2), & button
(ITEM key 5), or MENU dial to change the
setting.

3 When finished, press the Set button (ITEM key
3).
The display returns to the user functions
screen, and displays the changed function.

The following tables lists the functions that are assigned when the unit is shipped from the factory.

Button Function Assignable Button setting

Assignable 1 Displays clipped highlight areas in red in the VF Highlight Clip Ind
viewfinder.

Assignable 2 No assignment Not Assigned

Assignable 3 No assignment Not Assigned

Assignable 4 No assignment Not Assigned

[TEM key 1 No assignment Not Assigned

[TEM key 2 No assignment Not Assigned

[TEM key 3 No assignment Not Assigned

ITEM key 4 Displays clipped highlight areas in red on the Monitor Highlight Clip Ind
Monitor output.

ITEM key 5 Sets the fan control mode. Fan Mode

Viewfinder assignable A

Turns the focus magnifier function of the
viewfinder on/off.

VF Focus Magnifier

Viewfinder assignable B

Turns the false color function display in a
viewfinder on/off.

VF False Color

Viewfinder assignable C

Turns the information display on the viewfinder/
monitor screen output image on/off.

VF Status Info

Functions that can be Assigned to [TEM Keys 1to 5

Assignable Button
setting

Function

State when unit is powered
on

No Assign

No assignment

SDI Frame Line

Turns superimposition of frame lines on the SDI
3/4 output image on/off.

Setting retained

SDI Status Info

Turns display of information on the SDI 3/4 output
image on/off.

Setting retained

Press & Hold for SDI Log "

Disables the LUT applied to the SDI 3/4 output
image while the key is pressed, and sets Log
image quality without applying a LUT.

Setting not retained

Monitor Frame Line

Turns superimposition of frame lines on the
Monitor output image on/off.

Setting retained

Monitor Status Info

Turns display of information on the Monitor
output image on/off.

Setting retained

Press & Hold for Monitor
Log”

Disables the LUT applied to the Monitor output
image while the key is pressed, and sets Log
image quality without applying a LUT.

Setting not retained
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Assignable Button
setting

Function

State when unit is powered
on

Assignable Button
setting

Function

State when unit is powered

Monitor Highlight Clip
Ind?

Turns the function that displays clipped highlight
areas in red on the Monitor output image on/off.

Setting retained

Monitor False Color"

Turns the false color function display on a monitor
on/off.

Setting retained

Color Bars?

Turns color bars on/off.

Setting retained

AXS Slot Change

Switches the active slot when two AXS memory
cards are inserted.

Switches between A and B each time the key is
pressed.

Setting retained

SxS Slot Change

Switches the active slot when two SxS memory
cards are inserted.

Switches between A and B each time the key is
pressed.

Setting retained

Fan Mode

Sets the fan control mode.

Switches between Auto — Max — Off in Rec/
Auto — Off in Rec/Max each time the key is
pressed.

Setting retained

Format Media AXS Slot A

Formats media in AXS slot A.

Format Media AXS Slot B

Formats media in AXS slot B.

Iris Close (1/16 stop)?

Closes the lens iris.

Press and hold to close the iris until fully closed.
This function is available when an E mount lens
with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

" Does not function if the key is pressed when Technical > System Configuration > RM/RCP Paint Control (page 68) is set to

On'in the full menu.

2" Does not function if the key is pressed when an RM-B170 or other remote control unit is connected and Technical > System

Configuration > RM/RCP Pain

t Control (page 68) is set to On in the full menu.

' Does not function if the key is pressed when an RM-B170 or other remote control unit is connected.

Functions that can be Assigned to Assignable Buttons 1to 4

Assignable Button setting

Function

State when unit is
powered on

Format Media SxS Slot A

Formats media in SxS slot A.

No Assign

No assignment

Format Media SxS Slot B

Formats media in SxS slot B.

APR

Executes APR.

PL-Mt Interface Position

Sets the interface position of the PL mount lens.
Switches between Top — Side — Off each time
the key is pressed.

Setting retained

VF Highlight Clip Ind "

Turns the function to display clipped highlight
areas in red in the viewfinder on/off.

Setting retained

VF False Color"

Turns the false color function display in a
viewfinder on/off.

Setting retained

Auto White Balance?

Executes auto white balance.

Picture Cache Rec

Turns the picture cache recording function on/off.

Setting retained

Iris Open (1/16 stop) ?

Opens the lens iris.

Press and hold to open the iris until fully open.
This function is available when an E mount lens
with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

SDI Frame Line

Turns superimposition of frame lines on the SDI

3/4 output image on/off.

Setting retained

SDI Status Info

Turns display of information on the SDI 3/4
output image on/off.

Setting retained

Press & Hold for SDI Log "

Disables the LUT applied to the SDI 3/4 output

image while the button is pressed, and sets
Log image quality without applying a LUT.

Setting not retained

Monitor Frame Line

Turns superimposition of frame lines on the
Monitor output image on/off.

Setting retained

Monitor Status Info

Turns display of information on the Monitor
output image on/off.

Setting retained

Press & Hold for Monitor Log "

image while the button is pressed, and sets
Log image quality without applying a LUT.

Disables the LUT applied to the Monitor output

Setting not retained

Monitor Highlight Clip Ind "

Turns the function that displays clipped

highlight areas in red on the Monitor output

image on/off.

Setting retained
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Assignable Button setting

Function

State when unit is
powered on

Assignable Button setting

Function

State when unit is
powered on

Monitor High/Low Key "

Selects the Monitor output mode.

Switches between High Key (screen for
checking for blown-out highlights) — Low Key
(screen for checking for blocked-out shadows)
— Off (normal display) each time the button is
pressed.

Setting not retained

Auto White Balance?

Executes auto white balance. Stops execution if
pressed during auto white balance.

Picture Cache Rec

Turns the picture cache recording function on/
off.

Setting retained

Monitor False Color"

Turns the false color function display on a
monitor on/off.

Setting retained

Color Bars?

Turns color bars on/off.

Setting retained

AXS Slot Change

Switches the active slot when two AXS
memory cards are inserted.

Switches between A and B each time the
button is pressed.

Iris Open (1/16 stop)?

Opens the lens iris.

Press and hold to open the iris until fully open.
This function is available when an E mount lens
with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

SXS Slot Change

Switches the active slot when two SxS memory
cards are inserted.

Switches between A and B each time the
button is pressed.

Rec Review

Executes the Rec Review function.

Setting not retained

Iris Close (1/16 stop)

Closes the lens iris.

Press and hold to close the iris until fully closed.
This function is available when an E mount lens
with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

VF Frame Line

Turns superimposition of frame lines on the
viewfinder/monitor screen output image on/
off.

Setting retained

Rec

Starts/stops recording.

VF Zebra

Turns the zebra function of the viewfinder/
monitor screen output image on/off.

Setting retained

VF Status Info

Turns the information display on the
viewfinder/monitor screen output image on/
off.

Setting retained

VF Focus Magnifier

Turns the focus magnifier function of the
viewfinder on/off.

Setting not retained

Press & Hold for VF Log "

Disables the LUT applied to the viewfinder/
monitor screen output image while the button
is pressed, and sets Log image quality without
applying a LUT.

Setting not retained

VF Highlight Clip Ind "

Turns the function to display clipped highlight
areas in red in the viewfinder on/off.

Setting retained

VF High/Low Key "

Selects the viewfinder output mode.

Switches between High Key (screen for
checking for blown-out highlights) — Low Key
(screen for checking for blocked-out shadows)
— Off (normal display) each time the button is
pressed.

Setting not retained

VF False Color"

Turns the false color function display in a
viewfinder on/off.

Setting retained

set to On in the full menu.

System Configuration > RM/RCP Paint Control (page 68) is set to On in the full menu.

Does not function if the button is pressed when Technical > System Configuration > RM/RCP Paint Control (page 68) is
Does not function if the button is pressed when an RM-B170 or other remote control unit is connected and Technical >

Does not function if the button is pressed when an RM-B170 or other remote control unit is connected.
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Functions that can be Assigned to Viewfinder (DVF-EL200) Assignable Buttons A

to C

Assignable Button setting Function State when unit is
powered on
Picture Cache Rec Turns the picture cache recording function Setting retained

on/off.

Assignable Button setting

Function

State when unit is
powered on

No Assign

No assignment

Color Bars "

Turns color bars on/off.

Setting retained

AXS Slot Change

Switches the active slot when two AXS
memory cards are inserted.
Switches between A and B each time the

button is pressed.

Iris Open (1/16 stop) Opens the lens iris. -
Press and hold to open the iris until fully open.
This function is available when an E mount

lens with power iris is attached.

The setting isin 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop

increments.

SxS Slot Change

Switches the active slot when two SxS
memory cards are inserted.
Switches between A and B each time the

button is pressed.

Rec Review

Executes the Rec Review function.

Setting not retained

Closes the lens iris. -
Press and hold to close the iris until fully

closed.

This function is available when an E mount

lens with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

Iris Close (1/16 stop)

VF Frame Line

Turns superimposition of frame lines on the
viewfinder/monitor screen output image on/

off.

Setting retained

Rec Starts/stops recording. -

VF Zebra

Turns the zebra function of the viewfinder/
monitor screen output image on/off.

Setting retained

VF Status Info

Turns the information display on the
viewfinder/monitor screen output image on/

off.

Setting retained

VF Focus Magnifier

Turns the focus magnifier function of the

viewfinder on/off.

Setting not retained

Press & Hold for VF Log?

Disables the LUT applied to the viewfinder/
monitor screen output image while the button
is pressed, and sets Log image quality without

applying a LUT.

Setting not retained

VF Highlight Clip Ind?

Turns the function to display clipped highlight
areas in red in the viewfinder on/off.

Setting retained

VF High/Low Key ?

Selects the viewfinder output mode.
Switches between High Key (screen for
checking for blown-out highlights) — Low
Key (screen for checking for blocked-out
shadows) — Off (normal display) each time

the button is pressed.

Setting not retained

VF False Color?

Turns the false color function display in a

viewfinder on/off.

Setting retained

Does not function if the button is pressed when an RM-B170 or other remote control unit is connected and Technical >
System Configuration > RM/RCP Paint Control (page 68) is set to On in the full menu.

Does not function if the button is pressed when Technical > System Configuration > RM/RCP Paint Control (page 68) is
set to On in the full menu.

Does not function if the button is pressed when an RM-B170 or other remote control unit is connected.
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Menu Operations

By pressing the MENU button while shooting

(during recording or recording standby) or during

playback, you can display and operate the menu

screen on the sub display.

® Project category: Basic settings and recording
format settings

® TC/Media category: Timecode value and TC
format settings

® Monitoring category: SDI/HDMI/Monitor
external signal output format, OSD, and marker
overlay status settings

® Audio category: Audio source and audio level
settings

¢ |nfo category: Camera, media, and battery status
information

Controls

MENU button (page 9)
Press to display the menu on the sub display.

ITEM keys 110 6 (page 9)
Selects the category of the menu.

SEL/SET dial (MENU dial) (page 9)

Turn to move the cursor in the corresponding
direction to select setting items or setting values.
Press the MENU dial to apply the selected item.

BACK button (page 10)
Press to return to the previous menu. Unconfirmed
changes are canceled.

Basic Operation

1 Press the MENU button.
The menu screen appears.

2 Select the category to set using ITEM keys 1 to
6.

3 Turn the MENU dial to move the cursor to the
setting item to select.
For each setting item, the setting value is
displayed.

‘Menu Item List” (page 44)

Project TC/Media Monitoring
4K 17:9
Project Frame Rate 23.98
S-Gamut3.Cine/SLog3
Rec Off
XAVC 4K Class300
Rec Off

ﬁ Project Details

Imager Mode

Input Color Space
AXS Rec Format

SxS Rec Format

Sub Rec Format
Audio

4 Press the MENU dial.
The setting value selection screen appears
next to the selected item.

Project TC/Media Monitoring

4K 4:3

4K 17:9
3.8K 16:9

Imager Mode
Project Frame Rate
Input Color Space
AXS Rec Format Rec Off
XAVC 4K Class300
Rec Off

ﬁProject Details

SxS Rec Format

Sub Rec Format
Audio

5 Turn the MENU dial to move the cursor to the
setting value.

6 Press the MENU dial to apply the setting.
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Menu ltem List

The items available in each category are given below.

Project category

Default values are shown underlined and in bold text.

Item Settings

Description

Project Details
(ITEM key 6)

Displays the contents of the Project menu
(page 58) in the full menu.

" The recording formats available vary depending on the combination of the effective picture size and project frame rate
settings. For details about settings, see “Recording Format Settings” (page 48).

T(/Media category

Default values are shown underlined and in bold text.

ltem Settings Description

Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ Sets the effective picture size.
6K 2.39:1/5.7K16:9/4K 6:5/ [Notes]
4K 4:3/4K 4:3 Surround View/ ® 6K 3:2/6K 1.85:1/6K 17:9 are displayed only when a
4K17:9/ Full Frame license is installed.

4K 17:9 Surround View/
4K 2.39:1/3.8K 16:9/
3.8K 16:9 Surround View

® 4K 6:5/4K 4:3/4K 4:3 Surround View are displayed
only when an Anamorphic license is installed.

® 4K239:1is displayed only when a High Frame Rate
license is installed.

Iltem

Settings

Description

Project Frame Rate

23.98/24/25/29.97/47.95/
50/59.94

Sets the project frame rate.

Input Color Space

S-Gamut3.Cine/SLog3 /
S-Gamut3/SLog3 /
Rec.2020/HLG_Rec.2100

Sets the color space.

[Note]

Rec.2020/HLG_Rec.2100 can be selected only when
Technical > System Configuration > RM/RCP Paint
Control (page 68) is set to On in the full menu.

TC Mode

Preset F-Run (Ext-Lk)/Preset
R-Run/Int Regen

Sets the timecode mode.

Preset F-Run (Ext-Lk): Timecode
advances continuously from specified
value, regardless of whether recording or
not.

Preset R-Run: Timecode advances from
specified value only when recording.

Int Regen: Timecode continues from that
of the previous clip.

TC Display

Timecode/Duration

Switches the time data indication.

AXS Rec Format”
(Only when an AXS-R7 is

Rec Off/X-OCN XT/
RAW SQ/X-OCN ST/

Sets the recording format for AXS memory cards
when an AXS-R7 is connected.

attached) X-OCN LT

SxS Rec Format? Rec Off/XAVC 4K Class480/ Sets the main recording format for SxS memory
XAVC 4K Class300/ cards.
XAVC QFHD Class480/
XAVC QFHD Class300/

MPEG HD P/MPEG HD i/
ProRes 422 HQ HD P/
ProRes 422 HQHD i/
ProRes 422 HD P/
ProRes 422 HD i/
ProRes Proxy HD P/

TC Setting
(set when switching

Setting
(H,M,S,F)

Sets the timecode to a desired value.

to another screen) Reset

Resets the timecode to 00:00:00:00.

TC Format

DF/NDF

Sets the timecode format.
DF: Drop frame
NDF: Non drop frame

TC Source

Internal/External

Display only.

ProRes Proxy HD i
Sub Rec Format " Rec Off/MPEG HD P/ Sets the sub recording format for SxS memory
MPEG HD i/ cards.

ProRes 422 Proxy HD P/
ProRes 422 Proxy HD i

Cam D

AtoZ

Sets the camera ID used when
generating clip names.

Clip name: Camera ID + Reel Number +
Shot Number + date + random string

Reel#

001 to 999

Sets the numeric portion of the Reel
Number used when generating clip
names.

Clip name: Camera ID + Reel Number +
Shot Number + date + random string

Camera Position

C/LR

Sets the first character portion of the
Shot Number used when generating clip
names.

Clip name: Camera ID + Reel Number +
Shot Number + date + random string
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ltem Settings Description Iltem Settings Description
Format Media AXS Slot A Formats the AXS memory card in slot A. Monitor Output The available settings vary Selects the Monitor output format.”
(executed when AXS Slot B Formats the AXS memory card in slot B. Format depending on the SDI'1/2
switching to another gy gjot A Formats the SxS memory card in slot A. setting.
screen) xS Slot B Formats the SxS memory card in slot B. Status Info Info A/Info B/Off Selects the information to display
D Card Formats the SD card. superimposed on the Monitor output.
Media Details Displays the contents of the TC/Media Frame Line  Line A/Line B/Off Selecﬁs the frame lines to d‘lsplay
(ITEM key 6) menu (page 61) in the full menu. superimposed on the Monitor output.
HDMI Output The available settings vary Selects the HDMI output format.?
Format depending on the SDI 1/2
setting.
o Moni. Details Displays the contents of the Monitoring
Monitoring category (ITEM key 6) menu (page 63) in the full menu.

Default values are shown underlined and in bold text.

[Notes]

! For details about formats available for selection, see “SDI OUT Connector Output Formats” (page 96).
2 For details about formats available for selection, see “MONITOR OUT Connector/HDMI OUT Connector Output Formats”

(page 100).

e The unit supports independent configuration of Status Info and Frame Line for each system. The display information for the

A and B output images is configured using the Monitoring menu (page 63).
e |nfo and Frame Line may not be displayed depending on the Output Format setting. In this case,

setting cannot be changed.

u_n

is displayed and the

Iltem Settings Description
VF Status Info Info A/Info B/Off Selects the information to display
superimposed on the viewfinder image.
Frame Line  Line A/Line B/Off Selects the frame lines to display
superimposed on the viewfinder image.
SDI/2 Output The available settings vary Selects the SDI 1/2 output format.”
Format according to the imager
mode, project frame rate, and
SxS recording format settings.
Status Inffo - Information display is not superimposed
on the SDI 1/2 output.
Frame Line  Line A/Line B/Off Selects the frame lines to display
superimposed on the SDI 1/2 output.
[Note]
Frame lines are only superimposed if the
output format is 4K/QFHD.
SDI'3/4 Output The available settings vary Selects the SDI 3/4 output format."”
[Note] Format dep.ending on the SDI 1/2
Depending on the setting.
Output Format setting ~ Status Info Info A/Info B/Off Selects the information to display
of SDI 1/2, the Output superimposed on the SDI 3/4 output.
Format, Info, Frame Frame Line  Line A/Line B/Off Selects the frame lines to display

Line settings of SDI
3/4 may be blank and
cannot be changed.

superimposed on the SDI 3/4 output.
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Audio category

Default values are shown underlined and in bold text.

Item Settings Description
Source Switch LINE / AES/EBU / MIC Displays the position of the AUDIO IN switch
(page 9) that sets the CH1 and CH2 input
source.
CH-1 Audio Level Auto/Manual The audio recording level is adjusted
-99to £0 to +99 automatically when set to Auto.
The audio recording level is adjusted manually
when set to Manual.
CH-2 Audio Level Auto/Manual The audio recording level is adjusted
-99to £0 to +99 automatically when set to Auto.

The audio recording level is adjusted manually
when set to Manual.

MIC Reference

-60dB/-50dB/-40dB

Selects the reference input level of the
microphone.

Monitor CH

When Monitor Output CH Pair
is set to CH-1/CH-2
CH-1/CH-2, CH-1,CH-2
When Monitor Output CH Pair
is set to CH-3/CH-4
CH-3/CH-4, CH-3, CH-4

Selects the audio channel that is output to the
headphones and speaker.

Monitor Level

0to 99

Adjusts the monitor audio level.

CH1 Level Meter

Displays the CH1 level meter.

CH2 Level Meter

Displays the CH2 level meter.

CH3 Level Meter

Displays the CH3 level meter.

CH4 Level Meter

Displays the CH4 level meter.

Audio Details
(ITEM key 6)

Displays the contents of the Audio menu
(page 67) in the full menu.

Checking the Status using the Info Category

You can check the status of media and the battery, and check the contents of warnings and errors that
are issued using the Info category. The contents of the display update in realtime as the status of the unit

changes.
The Info category consists of the following seven information pages. Turn the MENU dial to switch the
page.

No. Page Description

1 Camera Condition Displays warning messages and error messages. When there are
no messages, “All Systems are OK" is displayed at the top of the
display area.

2 Firmware Displays the serial number and firmware version of the unit, and
the serial number and firmware version of the AXS-R7 attached
to the unit.

3 License Displays the name and installation status/validity of option
software licenses. If an option is not added, “Not Installed” or
"Expired” is displayed for the installation status.

4 System Displays the following system information.
® Date and time
® Fan rotation speed
® Sensor detection temperature
® Hours meter
® |P Address
[Notes]

e |[f the sensor detection temperature reaches 65 °C (149 °F), a high
temperature warning message is issued.
e “0.0.0.0"is displayed if the IP address cannot be obtained.

5 Battery Displays the following battery information.
® Detected battery name or type
® Remaining capacity (%)
® Estimated remaining time
® Remaining capacity (Ah)
® \/oltage (V)

e Number of times that the battery has been charged
® Power source
® Supplied power source voltage
6 Media Displays the remaining capacity, remaining recording time, and

lifespan data of SxS memory cards, AXS memory cards (when
AXS-R7 is attached), and SD cards.
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No. Page Description
7 Lens Displays the following information for the lens attached to the
unit.

® [ ens model name

® Tvalue of iris
[Note]
The F-stop value is displayed instead of the T-stop value if the T-stop
value cannot be obtained.

® Focal length

Focus distance

Depth of field

® Serial number

8 Network Displays the network connection setup information.
e Status (LAN/Wireless Access Point/Wireless Station/Off)
® |P Address
e SSID
® MAC Address

[Note]
“0.0.0.0" is displayed if the IP address cannot be obtained.
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Recording Format Settings

The following recording formats can be selected for different combinations of effective picture size and project frame rate settings.
If a value shown underlined and in bold text is selected, a Log or LUT setting can be applied to the recorded video signal.

AXS Rec Format and SxS Rec Format combinations

Effective picture size (Imager Mode)

Main recording format

Project Frame Rate

AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94
6K 3:2 X-OCN XT None Yes Yes Yes Yes - Yes Yes
(6048x4032) X-OCN ST 4K XAVC-l Class480 Yes Yes Yes Yes - - -

X-OCNLT 4K XAVC-l Class300 Yes Yes Yes Yes - Yes Yes

MPEG HD422 P Yes - Yes Yes - - -
MPEG HD422 i - - - - - Yes Yes
FHD ProRes 422 HQ P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 Proxy P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 Proxy i - - - - - Yes Yes
6K 1.85:1 X-OCN XT None Yes Yes Yes Yes - - -
(6054%3272) X-OCN ST 4K XAVC-| Class480 Yes Yes Yes Yes - - -
X-OCNLT 4K XAVC-l Class300 Yes Yes Yes Yes - - -
MPEG HD422 P Yes - Yes Yes - - -
FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
FHD ProRes 422 P Yes Yes Yes Yes - - -
FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
6K 17:9 X-OCN XT None Yes Yes Yes Yes - - -
(6054x3192) X-OCN ST 4K XAVC-l Class480 Yes Yes Yes Yes - - -
X-OCNLT 4K XAVC-l Class300 Yes Yes Yes Yes - - -
MPEG HD422 P Yes - Yes Yes - - -
FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
FHD ProRes 422 P Yes Yes Yes Yes - - -
FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
6K 2.39:1 X-OCN XT None Yes Yes Yes Yes - - -
(6048x2534) X-OCN ST 4K XAVC-l Class480 Yes Yes Yes Yes - - -
X-OCN LT 4K XAVC-I Class300 Yes Yes Yes Yes - - -
MPEG HD422 P Yes - Yes Yes - - -
FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
FHD ProRes 422 P Yes Yes Yes Yes - - -
FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
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Effective picture size (Imager Mode) Main recording format Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94
57K16:9 X-OCN XT None Yes Yes Yes Yes - - -
(5674x3192) X-OCN ST QFHD XAVC- Class480 Yes - Yes Yes - - -
X-OCNLT QFHD XAVC-| Class300 Yes - Yes Yes - - -
MPEG HD422 P Yes - Yes Yes - - -
FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
FHD ProRes 422 P Yes Yes Yes Yes - - -
FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
4K 6:5 X-OCN XT None Yes Yes Yes Yes - - -
(4096x3432) X-OCN ST 4K XAVC-l Class480 Yes Yes Yes Yes - - -
X-OCNLT 4K XAVC-l Class300 Yes Yes Yes Yes - - -
MPEG HD422 P Yes - Yes Yes - - -
FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
FHD ProRes 422 P Yes Yes Yes Yes - - -
FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
4K 4:3 X-OCN XT None Yes Yes Yes Yes Yes Yes Yes
(4096%3024) X-OCN ST 4K XAVC-| Class480 Yes Yes Yes Yes - - -
X-OCN LT 4K XAVC-I Class300 Yes Yes Yes Yes - Yes Yes
MPEG HD422 P Yes - Yes Yes - - -
MPEG HD422 i - - - - - Yes Yes
FHD ProRes 422 HQ P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 Proxy P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 Proxy i - - - - - Yes Yes
4K 4:3 Surround X-OCN XT None Yes Yes Yes Yes - - -
(4096x3024) X-OCN ST MPEG HD422 P Yes - Yes Yes - - -
Picture size X-OCNLT FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
(4552x3360) FHD ProRes 422 P Yes Yes Yes Yes - - -

FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
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Effective picture size (Imager Mode) Main recording format Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94
4K17:9 X-OCN XT None Yes Yes Yes Yes Yes Yes Yes
(4096x2160) RAW SQ 4K XAVC-l Class480 Yes Yes Yes Yes - - -
X-OCN ST 4K XAVC-I Class300 Yes Yes Yes Yes - Yes Yes
KOCNLT MPEG HD422 P Yes - Yes Yes - - -
MPEG HD422 i - - - - - Yes Yes
FHD ProRes 422 HQ P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 HQ i - - - - - Yes Yes
FHD ProRes 422 P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 i - - - - - Yes Yes
FHD ProRes 422 Proxy P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 Proxy i - - - - - Yes Yes
4K 17:9 Surround X-OCN XT None Yes Yes Yes Yes - - -
(4096x2160) RAW SQ MPEG HD422 P Yes - Yes Yes - - -
Picture size X-OCN ST FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
(4552>2400) KOCNLT FHD ProRes 422 P Yes Yes Yes Yes - - -
FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
4K 4096x1716 2.39:1 X-OCN XT None Yes Yes Yes Yes - Yes Yes
X-OCN ST
X-OCN LT
3.8K (QFHD) 16:9 X-OCN XT None Yes Yes Yes Yes - Yes Yes
(3840x2160) RAW SQ QFHD XAVC-I Class480 Yes - Yes Yes - - -
X-OCN ST QFHD XAVC-l Class300 Yes - Yes Yes - Yes Yes
KOCNLT MPEG HD422 P Yes - Yes Yes - - -
MPEG HD422 i - - - - - Yes Yes
FHD ProRes 422 HQ P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 HQ i - - - - - Yes Yes
FHD ProRes 422 P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 i - - - - - Yes Yes
FHD ProRes 422 Proxy P Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 Proxy i - - - - - Yes Yes
3.8K (QFHD) 16:9 Surround X-OCN XT None Yes Yes Yes Yes - - -
(3840x2160) RAW SQ MPEG HD422 P Yes - Yes Yes - - -
Picture size X-OCN ST FHD ProRes 422 HQ P Yes Yes Yes Yes - - -
(4268x2400) KOCNLT FHD ProRes 422 P Yes Yes Yes Yes - - -

FHD ProRes 422 Proxy P Yes Yes Yes Yes - - -
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SXS Rec Format and Sub Rec Format combinations

Effective picture size (Imager Mode)

Recording format

Project Frame Rate

SxS main recording format SxS sub recording format 23.98 24.00 25.00 29.97 47.95 50.00
(SxS Rec Format) " (Sub Rec Format)?
6K 3:2 4K XAVC-| Class480 None - - - - - -
(6048%4032) 4K XAVC-| Class300 None - - - - - -
FHD XAVC- None - - - - - -
MPEG HD422 P None - - - - - -
FHD ProRes 422 HQ P None - - - - - -
FHD ProRes 422 P None - - - - - -
FHD ProRes 422 Proxy P None - - - - - -
6K 1.85:1 4K XAVC-I Class480 None Yes Yes Yes Yes - -
(6054x3272) MPEG HD422 P Yes - Yes Yes - -
ProRes 422 Proxy P Yes Yes Yes Yes - -
4K XAVC-I Class300 None Yes Yes Yes Yes - -
MPEG HD422 P Yes - Yes Yes - -
ProRes 422 Proxy P Yes Yes Yes Yes - -
MPEG HD422 P None Yes - Yes Yes - -
FHD ProRes 422 HQ P None Yes Yes Yes Yes - -
FHD ProRes 422 P None Yes Yes Yes Yes - -
6K 17:9 4K XAVC-I Class480 None Yes Yes Yes Yes - -
(6054x3192) MPEG HD422 P Yes - Yes Yes - -
ProRes 422 Proxy P Yes Yes Yes Yes - -
4K XAVC-I Class300 None Yes Yes Yes Yes - -
MPEG HD422 P Yes - Yes Yes - -
ProRes 422 Proxy P Yes Yes Yes Yes - -
6K 2.39:1 4K XAVC-I Class480 None Yes Yes Yes Yes - -
(6048x2534) MPEG HD422 P Yes - Yes Yes - -
ProRes 422 Proxy P Yes Yes Yes Yes - -
4K XAVC-I Class300 None Yes Yes Yes Yes - -
MPEG HD422 P Yes - Yes Yes - -
ProRes 422 Proxy P Yes Yes Yes Yes - -
MPEG HD422 P None Yes - Yes Yes - -
FHD ProRes 422 HQ P None Yes Yes Yes Yes - -
FHD ProRes 422 P None Yes Yes Yes Yes - -
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Effective picture size (Imager Mode)

Recording format

Project Frame Rate

SxS main recording format SxS sub recording format 23.98 24.00 25.00 29.97 47.95 50.00 59.94
(SxS Rec Format) " (Sub Rec Format)?
57K16:9 QFHD XAVC-I Class480 None Yes - Yes Yes - - -
(5674x3192) MPEG HD422 P Yes - Yes Yes - - -
ProRes 422 Proxy P Yes - Yes Yes - - -
QFHD XAVC-l Class300 None Yes - Yes Yes - - -
MPEG HD422 P Yes - Yes Yes - - -
ProRes 422 Proxy P Yes - Yes Yes - - -
MPEG HD422 P None Yes - Yes Yes - - -
FHD ProRes 422 HQ P None Yes Yes Yes Yes - - -
FHD ProRes 422 P None Yes Yes Yes Yes - - -
4K 6:5 4K XAVC-| Class480 None Yes Yes Yes Yes - - -
(4096x3432) MPEG HD422 P Yes - Yes Yes - - -
ProRes 422 Proxy P Yes Yes Yes Yes - - -
4K XAVC-I Class300 None Yes Yes Yes Yes - - -
MPEG HD422 P Yes - Yes Yes - - -
ProRes 422 Proxy P Yes Yes Yes Yes - - -
MPEG HD422 P None Yes - Yes Yes - - -
FHD ProRes 422 HQ P None Yes Yes Yes Yes - - -
FHD ProRes 422 P None Yes Yes Yes Yes - - -
4K 4:3 4K XAVC-I Class480 None Yes Yes Yes Yes - - -
(4096x3024) MPEG HD422 P Yes - Yes Yes - - -
ProRes 422 Proxy P Yes Yes Yes Yes - - -
4K XAVC-I Class300 None Yes Yes Yes Yes - Yes Yes
MPEG HD422 P Yes - Yes Yes - - -
MPEG HD422 i - - - - - Yes Yes
ProRes 422 Proxy P Yes Yes Yes Yes - - -
ProRes 422 Proxy i - - - - - Yes Yes
MPEG HD422 P None Yes - Yes Yes - - -
MPEG HD422 i None - - - - - Yes Yes
FHD ProRes 422 HQ P None Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 P None Yes Yes Yes Yes - Yes Yes
4K 4:3 Surround MPEG HD422 P None Yes - Yes Yes - - -
(4096x3024) FHD ProRes 422 HQ P None Yes Yes Yes Yes - - -
Picture size FHD ProRes 422 P None Yes Yes Yes Yes - - -

(4552x3360)
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Effective picture size (Imager Mode)

Recording format

Project Frame Rate

SxS main recording format SxS sub recording format 23.98 24.00 25.00 29.97 47.95 50.00 59.94
(SxS Rec Format) " (Sub Rec Format)?
4K17:9 4K XAVC-I Class480 None Yes Yes Yes Yes - - -
(4096x2160) MPEG HD422 Yes - Yes Yes - - -
ProRes 422 Proxy P Yes Yes Yes Yes - - -
4K XAVC-I Class300 None Yes Yes Yes Yes - Yes Yes
MPEG HD422 P Yes - Yes Yes - - -
MPEG HD422 i - - - - - Yes Yes
ProRes 422 Proxy P Yes Yes Yes Yes - - -
ProRes 422 Proxy i - - - - - Yes Yes
3.8K (QFHD) 16:9 QFHD XAVC-| Class480 None Yes - Yes Yes - - -
(3840x2160) MPEG HD422 P Yes - Yes Yes - - -
ProRes 422 Proxy P Yes - Yes Yes - - -
QFHD XAVC-I Class300 None Yes - Yes Yes - Yes Yes
MPEG HD422 P Yes - Yes Yes - - -
MPEG HD422 i - - - - - Yes Yes
ProRes 422 Proxy P Yes - Yes Yes - - -
ProRes 422 Proxy i - - - - - Yes Yes
MPEG HD422 P None Yes - Yes Yes - - -
MPEG HD422 i None - - - - - Yes Yes
FHD ProRes 422 HQ P None Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 HQ i None - - - - - Yes Yes
FHD ProRes 422 P None Yes Yes Yes Yes - Yes Yes
FHD ProRes 422 i None - - - - - Yes Yes
3.8K (QFHD) 16:9 Surround MPEG HD422 P None Yes - Yes Yes - - -
(3840x2160) FHD ProRes 422 HQ P None Yes Yes Yes Yes - - -
Picture size FHD ProRes 422 P None Yes Yes Yes Yes - - -
(4268x2400)

V" When the SxS main recording format is set to XAVC, the LUT is off (fixed) for XAVC recording.
2 When the SxS recording format is set to MPEG or ProRes, either Log or Look can be selected (FHD only).
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Full Menu Operations

The full menu for configuring the required settings
for shooting and playback is displayed on the sub

display be pressing and holding the MENU button
for 2 seconds or longer.

Menu Structure

Shooting menu

Menu used to make settings related to shooting.

Project menu

Menu used to make basic settings for a project.

TC/Media menu

Menu used to make settings related to timecode
and recording media.

Monitoring menu

Menu used to make settings related to video
output and viewfinder output.

Audio menu

Menu used to make settings related to audio.

Technical menu

Menu used to make settings related to technical
matters.

Maintenance menu

Menu used to make unit settings, such as the clock

and language settings.

Controls Setting Menu ltems
Turn the MENU dial to move the cursor to the
MENU button (page 9) menu item you want to set, then press the MENU

Press and hold for 2 seconds or longer to display
the full menu on the sub display.

SEL/SET dial (MENU dial) (page 9)

Turn to move the cursor in the corresponding
direction to select setting items or setting values.
Press the MENU dial to apply the selected item.

BACK button (page 10)
Press to return to the previous menu. Unconfirmed
changes are canceled.

dial to select that item.

® The menu item selection area can show a
maximum of nine lines. When all the selectable
items cannot be displayed at one time, you can
scroll the display up or down by moving the
cursor.

® Foritems having a wide range of available
values (example: =99 to +99), the selection
area is not displayed. The current setting is
highlighted to indicate that the value can be
changed.

® |f you select Execute for an executable item, the
corresponding function is executed.

® \When you select an item that you must confirm
before execution, a confirmation message
appears. Follow the instructions in the message
to execute or cancel the operation.
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Full Menu List

The functions and available settings of each menu item are given below. Shooting > Shutter
Makes settings related to the electronic shutter.

[Note]
. Shutter is grayed out and cannot be operated when an RM-B170 or other remote control unit is connected and Technical >
ShOO“ ﬂg Meﬂ u System Configuration > RM/RCP Paint Control (page 68) is set to On in the full menu.
Menu item Settings Description
) ! h | When Sh M | h | i
Default values are shown underlined and in bold text. Shutter Select When Shutter Mode (page 68) Selects shutter angle or speed of the electronic
. is set to Speed shutter.
Shooting > FPS A Default selection options The default speed values for different Project
Sets the shooting frame rate. 1/24,1/25,1/30,1/48,1/50,  Frame Rate (page 58) settings are given below.
[Note] 1/60, 23.98/24:1/24
FPS cannot be configured if Project > Basic Setting > SxS Rec Format in the full menu is set to interlaced recording. In this 1/100, 1/120, 1/250, 1/500, 25:1/25
case, the Fixed/Variable Select setting changes to Fixed. 1/1000, 1/2000" 29.97:1/30
Menu item Settings Description When Shutter Mode (page 68) 47.95:1/48
Fixed/Variable Select Fixed/Variable Selects whether the FPS setting is set to constant is set to Anglg _ 50:1/50
speed shooting or variable speed shooting. Default selection options 59.94:1/60
360.0/180.0/172.8/144.0/
(Note] 90.0/45.0/22.5/11.2/56

Set to Variable (fixed) when Project > Basic Setting > ;
Imager Mode (page 58) is set to 4K 2.39:1 in the full Wheh Step/Cont. Seleq Is setto
menu. Continuous, the selection range

is 360.0 to 4.2 (Angle) or 1/24" to

FPS Select When Fixed/Variable Select is set ~ Selects the shooting frame rate.
to Fixed, one of the following The default values vary as shown below 1/80007 (Speed).
values is displayed. depending on the Project Frame Rate setting. Step/Cont. Select Step/Continuous Selects whether the electronic shutter values are
Fixed 24/Fixed 25/Fixed 30/ step values or continuous.
Fixed 48/Fixed 50/Fixed 60 Project  Default when Display value Add/Change Step Adds or edits a selection option available in
Frame Fixed/Variable  when Fixed/ Shutter Select in Step mode.
Rate Select is Variable Variable Select is Up to 16 selection options can be added.
Fixed Delete Step Deletes a selection option available in Shutter
59.94 60 Fixed 60 Select in Step mode.
50 50 Fixed 50 Shooting >ND
47.95 48 Fixed 48 Sets the ND filter position.
29.97 30 Fixed 30 Menu item Settings Description
25 25 Fixed 25 ND Position Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/  Selects the density of the ND filter.
24 24 Fixed 24 24
2397 24 Fixed 24
[Note]

Set to 120 (fixed) when Project > Basic Setting > Imager
Mode (page 58) is set to 4K 2.39:1 in the full menu.
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Shooting > Exposure Index
Sets the El value.

[Note]
Exposure Index is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint
Control (page 68) is set to On in the full menu.

Menu item Settings Description

El Select The setting changes as follows Selects the El value.
depending on the Project > Basic
Setting > Base ISO (page 58)
setting in the full menu.

1SO 500:
125EI/160El/200El/250E1/
320EI/400El/500EI/640El/
800EI/1000EIl/1250EI/1600EI/
2000E!

ISO 2500:
640EI/800El/1000EI/1250El/
1600El/2000El/2500El/
3200EI/4000EI/5000El/
6400EI/8000El/10000E!

[Note]

The settings are fixed to the following values when
Technical > System Configuration > RM/RCP Paint
Control (page 68) is set to On in the full menu.
When Base ISO is set to ISO500: 500EI

When Base ISO is set to 1SO2500: 2500E!

Shooting > LUT Select
Makes settings related to the LUT to apply to the output image.

[Notes]

® | UT Select is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint
Control (page 68) is set to On in the full menu.

® The HLG setting is configured (fixed) only when Project > Basic Setting > Input Color Space (page 58) is set to Rec.2020/
HLG_Rec.2100 in the menu.

Shooting > White Balance
Makes settings related to white balance.

[Note]
White Balance is grayed out and cannot be operated when an RM-B170 or other remote control unit is connected and
Technical > System Configuration > RM/RCP Paint Control (page 68) is set to On in the full menu.

Menu item Settings Description
Color Temp. Select 3200K+00/4300K+00/ Displays and selects the color temperature/color
5500K+00 tone of the white balance.

+ other added options (up to 16)

Add/Change Step Adds or edits a selection option by changing the
color temperature and tint value of white balance.
Delete Step Deletes an added selection option.

Auto White Balance Execute/Cancel Executes auto white balance (execute by

selecting Execute).

Menu item Settings Description
SDI1/2 Log/HLG Display only, as LUT cannot be applied to the SDI
1/2 output image.
SDI'3/4 Log/Look/-—/HLG Selects the LUT to apply to the SDI 3/4 output
image.
Monitor Log/s709/R709(800%)/Look/--/  Selects the LUT to apply to the Monitor output
HLG image.
The default values are given
below.
When Output Format > SDI
1/2 is 2K/HD: s709
When Output Format > SDI
1/2 is 4K/QFHD: Look
HDMI Log/s709/R709(800%)/Look/ Displays the LUT to apply to HDMI output image.
HLG
The default values are given
below.
When Output Format > SDI
1/2 is 2K/HD: 5709
When Output Format > SDI
1/2 is 4K/QFHD and HDMI is
not 4K/QFHD: Look
When Output Format >
HDMI is 4K/QFHD: Log
VF LUT Log/s709/R709(800%) Selects the LUT to apply to the viewfinder/
monitor screen output image.
[Notes]
® Set to R709(800%) (fixed) when Technical > System
Configuration > RM/RCP Paint Control (page 68) is
set to On in the full menu.
® An SDR gain value (-12 dB) is applied to the
viewfinder/monitor output image.
SXS Rec Log/Look/--/HLG Selects the LUT to apply to SDI Main clip recorded
video.
Sub Rec Log/Look/-—-/HLG Selects the LUT to apply to SDI Sub clip recorded

video.
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Shooting > Look
Makes settings related to Preset Look.

[Note]

Look is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint Control

(page 68) is set to On in the full menu.

Shooting > Look
Makes settings related to Preset Look.

[Note]

Look is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint Control

(page 68) is set to On in the full menu.

Menu item Settings Description Menu item Settings Description
Category Preset Look/User 3D LUT Selects the LUT category. ASC CDL Process CDL Off/Look-> CDL/CDL -> Sets whether to apply ASC CDL to the output
Preset Look Select 5709 / R709(800%) / S-Gamut3.  Selects the Preset Look. Look video. When applying, specify the ASC CDL
Cine/SLog3 / S-Gamut3/SLog3  Outputs images that are suitable as the starting processing sequence.
point for color grading or images that are close to CDL Off: Do not apply ASC CDL to the output
print film quality. video.
$709: Cinema color CDL -> Look: Apply CDL before applying Look.
R709(800%): Faithful color Look -> CDL: Apply CDL after applying Look.
S—Gamut3/$Log3: Wide color space N [Notes]
S-Gamut3.Cine/SLog3: Color space for digital e ASCCDL is enabled for outputs for which Look is
cinema selected in Shooting > LUT Select (page 56) in the
full menu.
[Notes]l . e The conditions under which the ASC CDL Process
e Configurable only when Category is set to Preset options are enabled are given below.
Look. When an ASC CDL file is not selected:
® S-Gamut3/SLog3 can be selected only when Project > CDL Off
Basic Setting > Input Color Space (page 58) is set to When an ASC CDL file is selected, and Shooting >
S-Gamut3/SLog3 in the full menu. Look > Category (page 57) is set to Preset
User 3D LUT Select File name (01 to 16) of User 3D Selects the User 3D LUT file. Look:
LUT files stored in internal Note] CDL Off / Look -> CDL
memory © ? ) When an ASC CDL file is selected, Shooting > Look >
Configurable only when Category is set to User 3D LUT. Category is set to User 3D LUT, and Preset Look
Select (page 57) is set to s709:
CDL Off / Look -> CDL
When an ASC CDL file is selected, Shooting > Look >
Category is set to User 3D LUT, and Preset Look
Select is not set to s709:
CDL Off / Look -> CDL / CDL -> Look
ASC CDL Select No File/Not Selected Selects the ASC CDL registered in the unit.

ASC CDL Information

Displays information about the ASC CDL selected
by ASC CDL Select.
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Shooting > Look File
Loads a User 3D LUT file into the unit.

[Note]
Look File is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint Control
(page 68) is set to On in the full menu.

Project Menu

Default values are shown underlined and in bold text.

Project > Basic Setting

Makes settings related to picture size and project frame rate.

Menu item

Settings

Description

Menu item Settings Description

Load User 3D LUT Loads a User 3D LUT file stored on an SD card into
the unit.

Reset User 3D LUT Resets a User 3D LUT data setting.

Reset All User 3D LUTs  Execute/Cancel Resets all User 3D LUT data settings (execute by
selecting Execute).

Load ASC CDL Loads ASC CDL data from an SD card.

Reset ASC CDL Resets an ASC CDL data setting.

Reset Al ASC CDLs Execute/Cancel Resets all ASC CDL data settings (execute by

selecting Execute).

Imager Mode

6K 3:2/6K 1.85:1/6K 17:9/
6K 2.39:1/5.7K 16:9/4K 6:5/
4K 4:3/4K 4:3 Surround View/

4K 17:9/4K 17:9 Surround View/

4K 2.39:1/3.8K 16:9/
3.8K 16:9 Surround View

Selects the effective picture size.

[Notes]

® (6K 3:2/6K 1.85:1/6K 17:9 are displayed only when a
Full Frame license is installed.

® 4K 6:5/4K 4:3/4K 4:3 Surround View are displayed only
when an Anamorphic license is installed.

® 4K239:1 is displayed only when a High Frame Rate
license is installed.

U The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0,
1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.

2 The options are 1/7000 and preceding values when the project frame rate is 50.0 or 25.0, and 1/6000 and preceding values
when 24.0 or 23.98.

Project Frame Rate

23.98/24/25/29.97/47.95/
50/59.94

Selects the project frame rate.

Input Color Space

S-Gamut3.Cine/SLog3 /
S-Gamut3/SLog3 /
Rec.2020/HLG_Rec.2100

Sets the color space.

[Note]

Rec.2020/HLG_Rec.2100 can be selected only when
Technical > System Configuration > RM/RCP Paint
Control (page 68) is set to On in the full menu.

AXS Rec Format
(Only when an AXS-R7
is attached)

Rec Off/X-OCN XT/RAW SQ/
X-OCN ST/X-OCN LT

Selects the video format for recording onto an
AXS memory card inserted into an AXS-R7.

SxS Rec Format

Rec Off/XAVC 4K Class480/
XAVC 4K Class300/
XAVC QFHD Class480/
XAVC QFHD Class300/
MPEG HD P/MPEG HD i/
ProRes 422 HQ HD P/
ProRes 422 HQ HD i/
ProRes 422 HD P/
ProRes 422 HD i/

ProRes Proxy HD P/
ProRes Proxy HD i

Selects the video format to be recorded on an SxS
memory card.

Sub Rec Format

Rec Off/MPEG HD P/
MPEGHD i/

ProRes 422 Proxy HD P/
ProRes 422 Proxy HD i

Selects the sub recording format for SxS memory
cards.

Base ISO

ISO 500/150 2500

Sets the base ISO sensitivity.
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Project > Basic Setting

Makes settings related to picture size and project frame rate.

Project > Special Recording

Makes settings related to picture cache recording.

Picture cache recording is not supported (set to

Off and grayed out) in the following cases.

® When XAVC-I Class480 (4K, QFHD) recording
format is selected

® For some combinations of effective picture size
and system frequency settings

® \When AXS Rec Format and SxS Rec Format are
both set to Rec Off

® During simultaneous AXS and SxS recording

Menu item Settings Description Menu item Settings Description
SxS/Output Off (1.0x)/1.25%/1.3%x/1.5%/ Sets the de-squeeze processing for SxS recording Max Cache Rec 2sec/4sec/6sec/8sec/10sec/ Sets the playback duration of video to cache in
De-Squeeze 1.8%/2.0x signals and video output signals. Duration 15sec/24sec/30sec picture cache memory.
This setting is available when an Anamorphic The maximum value that can be set for each
license is installed and Imager Mode is set to 4K memory card is given below.
4:3/4K 4:3 Surround View/4K 6:5/4K 17:9/4K 17:9
Surround View/6K 3:2/6K 17:9, or when an When recording to an SxS memory card
Anamorphic license and Fu“ Frame license are SxS Rec Format Project Frame Rate
installed and Imager Mode is set to 6K 3:2/6K 17:9.
The options vary depending on the picture size. L 2 i3 R GTED Y Sl
4K/QFHD XAVC-I Class480 — - - - - - -
Imager Mode SxS/Output De-Squeeze 4K/OQFHD XAVC-l Class300 2 5 5 5 B 7 7
Off (1.0x)  1.25x 13x 1.5x  1.8x  2.0xX JK/FHD ProRes 422 HOP 2 5 5 5 ~ ~ 7
6K 6048x4032 3:2 Yes Yes Yes Yes Yes Yes 2K/FHD ProRes 422 HQ 1 — B 7 7 7 5 5
6K6054x319217:9 Yes Yes Yes - - Yes 2K/FHD ProRes 422 P 6 6 6 6 B 5 5
4K 4096x3432 6:5 Yes - - - - Yes 2K/FHD ProRes 422 | ~ ~ ~ ~ ~ 6 6
4K'4096x3024 4:3 Yes - Yes - - Yes MPEG HD422 P 15 7 15 15 B B B
4K 4096x3024 4:3 Surround  Yes - Yes - - Yes MPEG HD422 | - B B - - 15 15
4K 40962160 17:9 Yes Yes Yes - - Yes
4K 4096x2160 17:9 Yes Yes Yes - - Yes
Surround
Project > Special Recording
Makes settings related to picture cache recording.
Menu item Settings Description
Cache Rec Select On/Off Turns the picture cache recording function on/off.
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Project > Special Recording
Makes settings related to picture cache recording.

Project > Special Recording
Makes settings related to picture cache recording.

Menu item Settings Description Menu item Settings Description

When recording to an AXS memory card

Imager AXS Rec Project Frame Rate Imager AXS Rec Project Frame Rate

Mode Format 5398 24 25 2997 4795 50 5994 Mode Format 5398 24 25 2997 4795 50  59.94
6K X-OCNXT 4 4 2 2 - - - 4K X-OCNXT 15 15 10 0 - - -
6048x4032  X-OCNST 8 8 8 6 - - - 4096x3024  X-OCNST 24 24 24 15 - - -
3:2 X-OCNLT 15 15 15 15 - 6 4 43Suround Y OCNLT 30 30 30 30 - - -
6K X-OCNXT 6 6 6 4 - - - 4K RAWSQ 24 24 24 15 8 8 6
6054x3272  X-OCNST 10 10 0 8 - - - 4096x2160  X-OCNXT 24 24 24 15 8 8 6
1851 X-OCNLT 24 24 24 15 - - - 179 X-OCNST 30 30 30 30 15 15 10
6K X-OCNXT 6 6 6 4 - - - X-OCNLT 30 30 30 30 30 30 24
6054x3192  X-OCNST 10 10 10 8 - - - 4K RAWSQ 24 24 24 15 - - -
17:9 X-OCNLT 24 24 24 15 - - - 4096x2160  X-OCNXT 24 24 24 15 - - -
6K X-OCNXT 10 10 0 6 - - - 17:9 X-OCNST 30 30 30 30 - - -
6048x2534  X-OCNST 15 15 15 0 - - - suround T 5eNTT 30 30 30 30 - - -
2391 X-OCNLT 30 30 30 24 - - - 4K X-OCNXT 30 30 30 24 - 10 10
5.7K X-OCNXT 6 6 6 4 - - - 4096x1716  X-OCNST = 30 30 30 30 - 15 15
5674x3192  X-OCNST 10 10 0 8 - - - 2391 X-OCNLT 30 30 30 30 - 30 30
16:9 X-OCNLT 24 24 24 15 - - - 38KQFHD) X-OCNXT 24 24 24 15 - 8 6
4K X-OCNXT 10 10 10 8 - - - 3840x2160  X-OCNST 30 30 30 30 - 15 10
4096x3432  X-OCNST 15 15 15 15 - - - 16:9 X-OCNLT 30 30 30 30 - 30 24
6:5 X-OCNLT 30 30 30 30 - - - 38KQFHD) X-OCNXT 24 24 24 15 - - -
4K X-OCNXT 15 15 10 10 4 4 2 3840x2160  X-OCNST 30 30 30 30 - - -
4096x3024  X-OCNST 24 24 24 15 8 8 6 16:9 X-OCNLT 30 30 30 30 - - -
43 X-OCNLT 30 30 30 30 15 15 15 surround
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Project > Assignable Button
Assigns functions to assignable buttons.

For details about assigning functions, see “User Functions Screen” (page 39).

TC/Media Menu

Default values are shown underlined and in bold text.

Menu item Settings Description

<1> page 39 Assigns a function to assignable button 1. TC/Media > Timecode

<2> page 39 Assigns a function to assignable button 2. MakesiseWings iclated WOMimECodel

<3> page 39 Assigns a function to assignable button 3. Menu item Settings Description

<4> page 39 Assigns a function to assignable button 4. Mode Preset F-Run (Ext-Lk)/Preset Selects the timecode mode.

<VF A> page 39 Assigns a function to assignable button A on the R-Runy/Int Regen Preset FfRun (Ext-L): T\mGCQQe advanc'es
ot o e e

<VF B> page 39 Assigns a function to assignable button B on the Preset R-Run: Timecgde advancesl from specified
viewfinder (DVF-EL200). value only when recording.

<VFC> page 39 Assigns a function to assignable button C on the Int Regen: Timecode continues from that of the
viewfinder (DVF-EL200). previous clip.

<User 1> page 39 Assigns a function to ITEM key 1. Manual Setting 00:00:00:00 to 23:59:59:29 Sets an arbitrary timecode value.

<User 2> page 39 Assigns a function to ITEM key 2. Reset Execute/Cancel Resets the timecode to 00:00:00:00 (execute by

<User 3> page 39 Assigns a function to ITEM key 3. selecting Execute).

<User 4> page 39 Assigns a function to ITEM key 4. TC Format DF/NDF Selects the timecode format.

<User 5> page 39 Assigns a function to ITEM key 5. DF: Drop frame

Project > All File NPF: Non drop frame

TC Source Internal/External Displays the TCG sync source.

Makes settings related to All-settings files.

Menu item Settings

Description

Time Data Display Timecode/Duration

Selects the time data to display.

TC/Media > Clip Name Format

Sets clip names. (Clip name: Camera ID + Reel Number + Shot Number + date + random string)

Load SD Card Load an All-settings file from an SD card.

Save SD Card Save an All-settings file on an SD card.

File ID Displays the file ID of the All-settings file for
editing.

Format SD Card Formats an SD card.

Menu item Settings Description

Camera ID AtoZ Sets the camera ID used when generating clip
names.

Reel Number 001 to 999 Sets the numeric portion of the Reel Number
used when generating clip names.

Camera Position C/L/R Sets the first character portion of the Shot

Number used when generating clip names.
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TC/Media > Clip Name Format

Sets clip names. (Clip name: Camera ID + Reel Number + Shot Number + date + random string)

TC/Media > Update Media

Updates the media’s management file.

Menu item Settings

Description

Menu item Settings

Description

SxS Root Folder Name ~ XDROOT/Cam ID + Reel#

Sets the naming format for the volume label and

root folder names on an SxS card.

XDROOT: Root folder is named “XDROOT".

Cam ID + Reel#: Volume label name and root
folder name follow the Cam ID naming
format.

[Notes]

e [fthe setting is changed, playback is not possible on
Sony camcorders and VTRs other than the MPC-3610
and PMW-PZ1 (setting must be changed on PMW-
PZ1).

e Changes to volume label name and root folder name

are applied when recording starts.

e On media in which the root folder name has been set

to Camera ID naming format, the root folder name
cannot be reset to “XDROOT" using this setting.

e The root folder is set to “XDROOT" when media is
formatted.

e |f media recorded with a root folder name in Camera
ID naming format is inserted into a device that does
not support Camera ID naming format (including
Venice V2.0 or earlier), an XDROOT folder is created
and recognized as the root folder (because a root
folder in Camera ID naming format cannot be
recognized).

AXS Slot A Execute/Cancel
(Only when an AXS-R7

is attached)

Updates the management file on the AXS
memory card in slot A of the AXS-R7 (execute by
selecting Execute).

AXS Slot B Execute/Cancel
(Only when an AXS-R7
is attached)

Updates the management file on the AXS
memory card in slot B of the AXS-R7 (execute by
selecting Execute).

SxS Slot A Execute/Cancel

Updates the management file on the SxS memory
card in slot A (execute by selecting Execute).

SxS Slot B Execute/Cancel

Updates the management file on the SxS memory
card in slot B (execute by selecting Execute).

TC/Media > Format Media
Formats media.

Menu item Settings Description

AXS Slot A Execute/Cancel Initializes the AXS memory card in slot A (execute

(Only when an AXS-R7 by selecting Execute).

is attached)

AXS Slot B Execute/Cancel Initializes the AXS memory card in slot B (execute

(Only when an AXS-R7 by selecting Execute).

is attached)

SXS Slot A Execute/Cancel Initializes the SxS memory card in slot A (execute
by selecting Execute).

SXS Slot B Execute/Cancel Initializes the SxS memory card in slot B (execute
by selecting Execute).

SD Card Execute/Cancel Formats the SD card (execute by selecting

Execute).
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Monitoring Menu

Default values are shown underlined and in bold text.

Monitoring > Output Format
Makes settings related to output format.

Monitoring > OSD Appearance
Makes settings related to information and frame lines superimposed on each output signal.
On/Off setting is selected using a checkbox (excluding Frame Line on Playback).

On: Checkbox selected
Off: Checkbox cleared

Menu item

Settings

Description

HDMI

Same as SDI/Same as Monitor

Selects whether the information displayed
superimposed on the HDMI output signal is the
same as for the SDI output or Monitor output.

Menu item Settings Description

SDI/2 The available settings vary Selects the SDI 1/2 output format.
according to the imager mode,  Settings vary according to the recording format
project frame rate, and SxS (page 96).
recording format settings.

SDI 3/4 The available settings vary Selects the SDI 3/4 output format.
depending on the SDI 1/2 Settings vary according to the recording format
setting. (page 96).

Monitor The available settings vary Selects the Monitor output format.
depending on the SDI 1/2 Settings vary according to the recording format
setting. (page 100).

HDMI The available settings vary Selects the HDMI output format.

depending on the SDI 1/2
setting.

Settings vary according to the recording format
(page 100).

Monitoring > OSD Appearance
Makes settings related to information and frame lines superimposed on each output signal.
On/Off setting is selected using a checkbox (excluding Frame Line on Playback).

On: Checkbox selected
Off: Checkbox cleared

Menu item Settings Description

VF Status Info (On/Off, Selects the information to display superimposed
Info. A/Info. B) on the viewfinder/monitor screen output image.
Frame Line (On/Off, Selects the frame lines to display superimposed
Line A/Line B) on the viewfinder/monitor screen output image.

SDI Status Info (On/Off, Selects the information to display superimposed

SDI1/2 Info. A/Info. B) on the SDI 3/4 output signal.

SDI'3/4 Frame Line (On/Off, Selects the frame lines to display superimposed

[Note] Line A/Line B) on the SDI 3/4 output signal.

The display changes

according to the Output
Format > SDI 1/2 and SDI

3/4 settings.

Status Info A/B Setup

Project
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the project in the
output information set for Status Info A and Status
Info B.

Timecode
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the timecode in the
output information set for Status Info A and Status
Info B.

Audio Level Meter
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display an audio level meter in
the output information set for Status Info A and
Status Info B.

Look Status
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the type of selected
Look in the output information set for Status Info
A and Status Info B.

Output LUT
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the output LUT in the
output information set for Status Info A and Status
Info B.

Recording LUT
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the recording LUT in
the output information set for Status Info A and
Status Info B.

VF Status
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the viewfinder status in
the output information set for Status Info A and
Status Info B.

Lens Status
Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the lens status in the
output information set for Status Info A and Status
Info B.

Remote Control Status

Info. A (On/Off)
Info. B (On/Off)

Selects whether to display the remote control
status in the output information set for Status Info
A and Status Info B.

Monitor

Status Info (On/Off,
Info. A/Info. B)

Selects the information to display superimposed
on the SDI 3/4 output signal.

Frame Line (On/Off,
Line A/Line B)

Selects the frame lines to display superimposed
on the SDI 3/4 output signal.
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Monitoring > OSD Appearance

Makes settings related to information and frame lines superimposed on each output signal.
On/Off setting is selected using a checkbox (excluding Frame Line on Playback).

On: Checkbox selected
Off: Checkbox cleared

Monitoring > OSD Appearance

Makes settings related to information and frame lines superimposed on each output signal.
On/Off setting is selected using a checkbox (excluding Frame Line on Playback).

On: Checkbox selected
Off: Checkbox cleared

Menu item Settings Description Menu item Settings Description

Frame Line A/B Setup ~ Center Marker Selects whether to display the center marker in Aspect Ratio Type Selects the display form of the aspect ratio marker.
Line A (On/Off) the output information set for Frame Line A and Option (Line/Mask/ Line: Displays lines with color set by Color.
Line B (On/Off) Frame Line B. Line&Mask) Mask: Displays a lower video signal level for areas
Option (Cross/Open Cross/  Selects the display form (Cross/Open Cross/Dot) outside the marker area.
Dot) of the center marker. Line&Mask: Displays lines with color set by Color

Aspect Ratio Selects whether to display the aspect ratio marker and a lower video signal level for areas

Line A (On/Off) in the output information set for Frame Line A outside the marker area.
Line B (On/Off) and Frame Line B. Mask Level Selects the brightness of the image outside the

Option (17:9/16:9/15:9/14:9/
13:9/4:3/1.66:1/1.85:1/2:1/

2.35:1/2.39:1)

Selects the mode (17:9/16:9/15:9/14:9/13:9/4:3/
1.66:1/1.85:1/2:1/2.35:1/2.39:1) when displaying
the aspect ratio marker.

Aspect Safety Zone
Line A (On/Off)
Line B (On/Off)
Option

(809%/90%/92.5%/95%)

Selects whether to display the aspect safety zone
in the output information set for Frame Line A
and Frame Line B.

Selects the size (percentage of the entire screen)
of the aspect safety zone marker.

Option (0to 15 (12))

marker when Aspect Ratio Type or Surround View
Type is set to Mask.

Frame Line on Playback
Option (On/Off)

Turns the function to superimpose frame lines
during playback on/off.

Monitoring > Monitor Display
Makes settings related to monitor display.

Menu item Settings

Description

Picture Area
Line A (On/Off)
Line B (On/Off)

Selects whether to display the picture area in the
output information set for Frame Line A and
Frame Line B.

Focus Distance Format Meter/Feet

Selects the focus position display units.

Safety Zone
Line A (On/Off)
Line B (On/Off)
Option

(80%/90%/92.5%/95%)

Selects whether to display the safety zone in the
output information set for Frame Line A and
Frame Line B.

Selects the range (80%/909%/92.5%/95%) of the
safety zone.

Monitoring > Frame Line

Makes settings related to lines and markers displayed on the output image.

Menu item Settings

Description

Center Marker Cross/Open Cross/Dot

Selects the display form of the center marker.

Aspect Ratio
1/1.85:1/2:1/2.35:1/2.39:1

17:9/16:9/15:9/14:9/13:9/4:3/1.66:

Selects the mode when displaying the aspect
ratio marker.

User Frame Line
Line A (On/Off)
Line B (On/Off)

Selects whether to display the user frame lines in
the output information set for Frame Line A and
Frame Line B.

Color

Option (White/Yellow/Cyan/
Green/Magenta/Red/Blue)

Sets the display color of frame lines.

Aspect Safety Zone 80%/90%/92.5%/95% Selects the size (percentage of the entire screen)
of the aspect safety zone marker.

Safety Zone 80%/90%/92.5%/95% Selects the safety zone range.

Color White/Yellow/Cyan/Green/ Selects the display color of frame lines.

Magenta/Red/Blue

Surround View Type
Option (Line/Mask/

Line&Mask)

Selects the display form of the Surround View

marker.

Line: Displays the recording area using lines.

Mask: Displays the recording area by masking
(reducing) the video signal level outside the
recording area.

Line&Mask: Displays the recording area using lines
and by masking (reducing) the video signal
level outside the recording area.

Surround View Type Line/Mask/Line&Mask

Selects the display form of the Surround View

marker.

Line: Displays the recording area using lines.

Mask: Displays the recording area by masking
(reducing) the video signal level outside the
recording area.

Line&Mask: Displays the recording area using lines
and by masking (reducing) the video signal
level outside the recording area.
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Monitoring > Frame Line

Makes settings related to lines and markers displayed on the output image.

Menu item Settings

Description

Aspect Ratio Type Line/Mask/Line&Mask

Selects the display form of the aspect ratio marker.

Line: Displays lines with color set by Color.

Mask: Displays a lower video signal level for areas
outside the marker area.

Line&Mask: Displays lines with color set by Color
and a lower video signal level for areas
outside the marker area.

Monitoring > False Color
Makes settings related to false colors.

[Note]

False Color is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint Control

(page 68) is set to On in the full menu.

Menu item

Settings

Description

Red Upper Limit

0.0% to 109.0% (96.1%)
(0.1% increments)

Sets the upper limit for display in red.

Red Lower Limit

0.0% to 109.0% (93.4%)
(0.1% increments)

Sets the lower limit for display in red.

Yellow

On/Off

Turns the display of yellow on/off.

Mask Level 0to15(12) Selects the brightness of the image outside the
marker when Aspect Ratio Type or Surround View
Type is set to Mask.

Frame Line on On/Off Turns the function to superimpose frame lines

Playback during playback on/off.

Yellow Upper Limit

0.0% to 109.0% (93.4%)
(0.1% increments)

Sets the upper limit for display in yellow.

Yellow Lower Limit

0.0% to 109.0% (91.3%)
(0.1% increments)

Sets the lower limit for display in yellow.

Monitoring > User Frame Line

Makes settings related to the user frame lines.

Orange

On/Off

Turns the display of orange on/off.

Orange Upper Limit

0.0% to 109.0% (90.6%)

Sets the upper limit for display in orange.

Menu item Settings Description (0.19% increments)

Width 3t0 479 (240) Sets the user frame line width (distance from the Orange Lower Limit 0.0% to 109.0% (87.7%) Sets the lower limit for display in orange.
center to the left and right edges). (0.1% increments)

Height 310269 (135) Sets the user frame line height (distance from the Pink On/Off Turns the display of pink on/off.
center to the top and bottom edges). Pink Upper Limit 0.0% to 109.0% (58.0%) Sets the upper limit for display in pink.

H Position Max. 476 to 476 (0) Sets the horizontal position of the center of the (0.1% increments)
user frame lines. Pink Lower Limit 0.0% to 109.0% (54.3%) Sets the lower limit for display in pink.
The setting range becomes narrower as the Width (0.1% increments)
setting increases above 3. Light Pink On/Off Turns the display of light pink on/off.

V Position Max. -266 to 266 (+0) Sets the vertical position of the center of the user Light Pink Upper Limit ~ 0.0% to 109.0% (50.8%) Sets the upper limit for display in light pink.
frame lines. (0.1% increments)
Th? setting‘ ra”,ge becomes narrower as the Light Pink Lower Limit ~ 0.0% to 109.0% (47.8%) Sets the lower limit for display in light pink.
Height setting increases above 3. (0.1% increments)

Monitoring > False Color Cyan On/Off Turns the display of cyan on/off.

Makes settings related to false colors.

[Note]

False Color is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint Control

(page 68) is set to On in the full menu.

Cyan Upper Limit

0.0% to 109.0% (46.5%)
(0.1% increments)

Sets the upper limit for display in cyan.

Menu item Settings

Description

Cyan Lower Limit

0.0% to 109.0% (43.8%)
(0.1% increments)

Sets the lower limit for display in cyan.

Level Preset/Manual

Sets whether to use the preset on/off setting and
threshold of each false color in the viewfinder/
monitor output or to set colors manually.

When Manual is selected, the following items can
be configured.

Green

On/Off

Turns the display of green on/off.

Green Upper Limit

0.0% to 109.0% (42.2%)
(0.1% increments)

Sets the upper limit for display in green.

Green Lower Limit

0.0% to 109.0% (38.9%)
(0.1% increments)

Sets the lower limit for display in green.

Red On/Off

Turns the display of red on/off.

Light Blue

On/Off

Turns the display of light light blue on/off.

Light Blue Upper Limit

0.0% to 109.0% (34.4%)
(0.1% increments)

Sets the upper limit for display in light blue.
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Monitoring > False Color
Makes settings related to false colors.

[Note]

False Color is grayed out and the setting cannot be changed when Technical > System Configuration > RM/RCP Paint Control

(page 68) is set to On in the full menu.

Monitoring > VF Function

Makes settings related to viewfinder functions.

Menu item

Settings

Description

Zebra Select

Menu item

Settings

1/2/Both

Selects the zebra pattern type (Zebra 1, Zebra 2,
Both).

Description Zebral Level

Light Blue Lower Limit

0.0% to 109.0% (24.6%)
(0.1% increments)

0% to 107% (41%)

Sets the display level of zebra 1.

Sets the lower limit for display in light blue.

Zebral Aperture Level

1% to 20% (10%)

Sets the aperture level of zebra 1.

Zebra2 Level

Blue

On/Off

0% to 109% (61%)

Sets the display level of zebra 2.

Turns the display of blue on/off. Assign<VF A>

Blue Upper Limit

0.0% to 109.0% (5.6%)
(0.1% increments)

Sets the upper limit for display in blue.

page 39

Assigns a function to assignable button A on the
viewfinder (DVF-EL200).

Assign<VF B>

Blue Lower Limit

0.0% to 109.0% (3.5%)
(0.1% increments)

Sets the lower limit for display in blue.

page 39

Assigns a function to assignable button B on the
viewfinder (DVF-EL200).

Assign<VF C>

Purple

On/Off

Turns the display of purple on/off.

Purple Upper Limit

0.0% to 109.0% (3.5%)
(0.1% increments)

page 39

Assigns a function to assignable button C on the
viewfinder (DVF-EL200).

Sets the upper limit for display in purple.

Purple Lower Limit

-7.3% to 109.0% (-7.3%)
(0.1% increments)

Sets the lower limit for display in purple.

Reset

Execute/Cancel

Resets the on/off setting and threshold of each
color (execute by selecting Execute).

Monitoring > VF Display
Makes settings related to the viewfinder display.

Menu item Settings Description

VE LUT Log/s709/R709(800%) Selects the LUT to apply to the viewfinder/
monitor screen output image.

Status Info Info. A/Info. B/Off Selects the information to display superimposed
on the viewfinder/monitor screen output image.

Frame Line Frame Line A/Frame Line B/Off  Selects the frame lines to display superimposed

on the viewfinder/monitor screen output image.

VF Magnifier Ratio %x2.0 / x40/ %x2.0/x4.0 Selects the focus magnification ratio for the
viewfinder.
Color -99 10 £0 to +99 Adjusts the color depth of the viewfinder image.

Monitoring > VF Function
Makes settings related to viewfinder functions.

Menu item Settings Description

Double Speed Scan On/Off Turns the viewfinder double speed scan function
on/off.

Peaking Frequency Normal/High Selects whether the peaking frequency is normal

or high during peaking.

[Note]
The peaking level is set using the viewfinder menu.

Zebra

On/Off

Turns the zebra function on/off.
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Audio Menu

Default values are shown underlined and in bold text.

Audio > Audio Configuration

Makes settings related to audio input/output.

Audio > Audio Input
Makes settings related to audio recording levels.

Menu item Settings Description

AGC Mono/Stereo Mono/Stereo Automatically adjusts the input level of analog
audio signals recorded on channels 1 and 2, and
selects whether to make the adjustments
separately for each channel (Mono) or in stereo
mode (Stereo).

MIC Input Mono/ Mono/Stereo Selects whether the front microphone is

Stereo monaural (Mono) or stereo (Stereo).

Phantom Power +48V  On/Off Turns the function to supply a +48 V external

source (phantom power) to the microphone on/
off.

Monitor Output CH
Pair

CH-1/CH-2, CH-3/CH-4

Sets the audio output channels to either channels
1and 2 or channels 3 and 4.

[Note]

The audio recording level with AES/EBU signal selected is fixed.

Menu item Settings Description

CH-1 Audio Select Auto/Manual Automatically adjusts the audio recording when
set to Auto.

CH-2 Audio Select Auto/Manual Automatically adjusts the audio recording when
set to Auto.

CH-1 Audio Level -99 to £0 to +99 Adjusts the audio recording level when CH-1
Audio Select is set to Manual.

CH-2 Audio Level -99 to £0 to +99 Adjusts the audio recording level when CH-2

Audio Select is set to Manual.

Headphone Mono/ST

Mono/Stereo

Sets the headphones output to monaural (Mono)
or stereo (Stereo).

MIC Reference -60dB/-50dB/-40dB

Selects the reference input level of the
microphone.

Audio > Audio Monitor
Makes settings related to audio monitoring.

Menu item Settings

Description

Monitor CH When Monitor Output CH Pair is
set to CH-1/CH-2
CH-1/CH-2, CH-1, CH-2
When Monitor Output CH Pair is
set to CH-3/CH-4
CH-3/CH-4, CH-3,CH-4

Selects the audio channel that is output to the

headphones and speaker.

CH-1/CH-2 (CH-3/CH-4): Channel 1+2 (Channel
3+4)

CH-1 (CH-3): Channel 1 (Channel 3) only

CH-2 (CH-4): Channel 2 (Channel 4) only

Monitor Level 0to99

Adjusts the monitor audio level.

Audio > Audio Configuration
Makes settings related to audio input/output.

Menu item Settings

Description

Alarm Level 0to 99

Adjusts the alarm audio level.

[Note]

This also sets the audio level of the beep emitted when
recording starts/stops if Technical > Switch & Rec Light >

Rec Start/Stop Beep is set to On in the full menu.

Off/-6dB/-9dB/-12dB/-15dB/
-17dB

Input Limiter Mode

Selects the limiter characteristic (saturation level)

for large input signals when adjusting the audio
input level manually. Select Off if not using the
limiter.

AGC Level

-6dB/-9dB/-12dB/-15dB/-17dB  Selects the AGC characteristic (saturation level).
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Technical Menu

Default values are shown underlined and in bold text.

Technical > System Configuration
Makes settings related to control of the unit.

Menu item Settings

Description

Technical > Test Signals
Makes settings related to color bars.

RM/RCP Paint Control  On/Off

Turns the paint functions of an RM-B170 or other
remote control unit on/off.

[Note]

All settings on the unit are initialized when the RM/RCP
Paint Control setting is changed. However, the RM/RCP
Paint Control setting is not changed.

SDI Rec Remote Off / HD SDI Remote I/F / Parallel
Trigger Rec

Selects the SDI remote mode control method.

Off: Disables remote control.

HD SDI Remote I/F: Uses HD SDI Remote control
method.

Parallel Rec: Uses valid flag control method.

Menu item Settings Description

Color Bars On/Off Turns color bars on/off.
[Note]
When an RM-B170 or other remote control unit is
connected, the setting from the remote control unit is
displayed and grayed out.

Color Bars Type ARIB/SMPTE Selects the type of color bars.

1KHz Tone on Color On/Off Turns the function to output a 1 kHz test signal in

Bars color bars mode on/off.

Test Saw On/Off Turns the test signal on/off.

SD HDMI On/Off

Turns the function to set the HDMI output signal
to SD format on/off.

Technical > Switch & Rec Light
Makes settings related to the REC button.

Shutter Mode Speed/Angle

Selects the operating mode of the electronic
shutter.

Menu item Settings Description
Lock Operator Side without Rec Button/with Rec Sets whether to lock the REC button operation
Button when buttons are locked using the LOCK switch

on the Operator side.

Technical > Special Configuration

Makes settings related to screen flip and noise reduction functions.

Lock Assistant Side without Rec Button/with Rec

Sets whether to lock the REC button operation

Button when buttons are locked using the LOCK switch
on the Assistant side.
Rec Light On/Off Turns the REC lamp on/off.
Rec Start/Stop Beep On/Off Turns the function to emit a beep sound when

recording starts and stops on/off.

Technical > System Configuration
Makes settings related to control of the unit.

Menu item Settings

Description

Menu item Settings Description
Flip Image Normal/Horizontal Flip Turns the screen flip function on/off.
[Note]
AXS recording images are stored unflipped.
NR(4K 17:9/16:9 AXS)  On/Off Turns the 4K 17:9/16:9 AXS recording image noise

reduction on/off.

[Note]

Set to Off (fixed) when the following functions are
enabled.

® Select FPS

e SxS/Output De-Squeeze: Settings other than Off(1.0x)
® Flip Image: Horizontal Flip

Auto / Max / Off in Rec/Auto /
Off in Rec/Max

Fan Control

Selects the fan control mode.

Auto: Controls the fan automatically in response
to the internal temperature.

Max: Fan rotates at maximum speed.

Off in Rec/Auto: The fan is silent when recording,
and operates automatically in response to the
internal temperature when not recording.

Off in Rec/Max: The fan is silent when recording,
and rotates at maximum speed when not
recording.

Technical > Lens Configuration
Makes settings related to lenses.

Menu item Settings Description
PL-Mt Interface Top/Side/Off Sets the lens interface, before attaching a lens,
Position according to the lens type to attach.

[Note]
If changing this setting while the lens is attached to the
unit, turn the turn off and then on again.
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Technical > Lens Configuration
Makes settings related to lenses.

Technical > Network

Makes settings related to the network.

Menu item Settings Description Menu item Settings Description
Lens 12pin On/Off Turns the 12-pin lens interface on/off. Wireless Network Mode (Access Point/ Sets the network mode for wireless connections.
[Note] Station)
If changing this setting while the lens is attached to the Scan Networks (Execute/Cancel)  Scans for access points for connection
unit, turn the turn off and then on again. destinations (execute by selecting Execute).
E-Mount Shading Auto/Off Sets whether to compensate for a drop in

Comp.

peripheral lighting when a compatible lens is
attached.

E-Mt Chro. Aber. Comp. Auto/Off

Sets whether to compensate for chromatic
aberration in peripheral lighting when a
compatible lens is attached.

Technical > Authentication
Makes basic settings related to network authentication.

Menu item Settings Description
User Name (Displays the current user name.) ~ Sets the user name to use for access
authentication.
Set to “admin” by factory default.
Password G Sets the password to use for access

authentication.
Set to “mpc3610” by factory default.

Technical > Network
Makes settings related to the network.

Menu item Settings Description
Setting LAN/Wireless/Off Turns the network connection on/off.
LAN DHCP (On/Off) Enables/disables DHCP.

When set to [On], an IP address is automatically
assigned to the unit. To enter the IP address of the
unit manually, set to [Off].

IP Address (DHCP/On: obtain
automatically, DHCP/Off:
192.168.2.50)

Enter the IP address of the unit.
Enabled only when DHCP is [Off].

Subnet Mask (DHCP/On: obtain
automatically, DHCP/Off:
255.255.255.0)

Enter the subnet mask of the unit.
Enabled only when DHCP is [Off].

[Note]
Configurable only when Network Mode is set to Station.

SSID

When Network Mode is set to Access Point
Displays the SSID for the wireless connection
to the unit.

When Network Mode is set to Station
Displays/configures the SSID of the
connection destination access point.

[Note]

Valid characters for display and entry:
Alphabetic (Ato Z,ato z)

Numeric (0 to 9 -~.@—_())

Symbols (I"#$%8&*+,/;<=>? A" {}~)

Password

When Network Mode is set to Access Point
Displays the password for wireless connection
to the unit.

When Network Mode is set to Station
Displays/configures the password of the
connection destination access point.

[Note]

Valid characters for display and entry:
Alphabetic (Ato Z,ato z)

Numeric (0 to 9 -~.@—_())

Symbols ("#$%8&*+,/;<=>? A" {}~)

WPS (Execute/Cancel)

Starts connection setup using WPS (execute by
selecting Execute).

Channel (Auto(5GHz)/Auto/CH1/
CH2/CH3/CH4/CH5/CH6/CH7/
CH8/CHY9/CH10/CH11)

Sets the channel of the access point.

[Notes]

e Configurable only when Network Mode is set to
Access Point.

® Auto(5GHz) may not be displayed, depending on
the wireless LAN module being used. Check whether
use of the wireless LAN module is supported in your
country/region. For details, refer to the operating
instructions of the wireless LAN module.
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Technical > Network
Makes settings related to the network.

Technical > Battery
Makes settings related to batteries.

Menu item Settings Description Menu item Settings Description

DHCP (On/Off) Enables/disables DHCP. End:Sony Battery 11.0Vto 11.5V (0.1Vincrements) ~ Sets the threshold value for displaying the “Battery
When set to [On], an IP address is automatically End” warning when using a Sony non-InfoLithium
assigned to the unit. To enter the IP address of the battery.
unit manually, set to [Off]. Near End:Other Battery 11.5Vto 17V (11.8V) (0.1V Sets the threshold value at which the remaining
[Note] increments) battery capacity indicator starts flashing when
Configurable only when Network Mode is set to Station. using a non-Sony battery.

IP Address (DHCP/On: obtain Enter the IP address of the unit. End:Other Battery 11.0V to 14V (0.1V increments) Sets the threshold value for displaying the “Battery

automatically, DHCP/Off:
192.168.1.50)

Enabled only when DHCP is [Off].

[Note]
Configurable only when Network Mode is set to Station.

End” warning when using a non-Sony battery.

Subnet Mask (DHCP/On: obtain
automatically, DHCP/Off:
255.255.255.0)

Enter the subnet mask of the unit.
Enabled only when DHCP is [Off].

[Note]
Configurable only when Network Mode is set to Station.

Detected Battery Sony Info Battery/Sony Battery/
Other Battery/DC IN (12V)/DC IN

(24v)

Displays the result of automatic battery pack type
detection.

Technical > DC Voltage Alarm
Sets alarms relating to external DC supply voltage.

MAC Address

Displays the MAC address of the wireless LAN
adaptor connected to the unit.

Menu item Settings

Description

Regenerate Password (Execute/
Cancel)

Regenerates the password (execute by selecting
Execute).

[Note]
Executable only when Network Mode is set to Access
Point.

DC Low Voltage1 11.5V to 17V (0.1V increments)

Sets the threshold value for displaying a low
voltage warning when using an external power
source connected to the DC IN connector.

DC Low Voltage2 11.0V to 14V (0.1V increments)

Sets the threshold value for displaying an
undervoltage warning when using an external
power source connected to the DC IN connector.

Technical > APR

Executes APR (Auto Pixel Restoration: auto adjustment of the image sensor).

DC(24V) Low Voltagel  22.5V to 34.0V (0.1V increments)

Sets the threshold value for displaying a low
voltage warning when using a 24 V external
power source connected to the DC IN connector.

DC(24V) Low Voltage2  22.0V to 28.0V (0.1V increments)

Sets the threshold value for displaying an
undervoltage warning when using a 24 V external
power source connected to the DC IN connector.

Menu item Settings Description

APR Execute/Cancel Executes the automatic pixel noise reduction
function (execute by selecting Execute).

Reset Execute/Cancel Deletes white flecks added by execution of the

APR function (execute by selecting Execute).

Technical > Control Display
Makes settings related to the displays.

Technical > Battery
Makes settings related to batteries.

Menu item Settings

Description

Menu item Settings

Description

Brightness level High/Mid/Low/Minimum

Adjusts the brightness of the sub display and mini
display.

Near End:Info Battery 5% to 100% (5% increments)

Sets the threshold value at which the remaining
battery capacity indicator starts flashing when
using an InfoLithium battery.

Technical > Genlock
Makes settings related to genlock.

Menu item Settings

Description

End:Info Battery 0% to 5%

Sets the threshold value for displaying the “Battery
End” warning when using an InfoLithium battery.

Near End:Sony Battery ~ 11.5V to 17V (0.1V increments)

Sets the threshold value at which the remaining
battery capacity indicator starts flashing when
using a Sony non-InfoLithium battery.

Input Source HD SDI/Analog

Selects the genlock input signal.
HD SDI: Digital
Analog: Analog
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Technical > Genlock
Makes settings related to genlock.

Menu item Settings

Description

Reference Lock Type Internal/External(HD)/
External(SD)

Displays the genlock status. Displays the signal

type when genlocked.

Internal: Not genlocked.

External(HD): Genlocked by the HD signal.
External(SD): Genlocked by the SD signal.

Maintenance Menu

Default values are shown underlined and in bold text.

Maintenance > Clock Set
Makes settings related to the built-in clock.

Menu item Settings

Description

Time Zone
to UTC = 12:00 (30-minute
increments)

UTC + 14:00 to UTC Greenwich

Selects the difference in time from UTC
(Greenwich Mean Time) in increments of 30
minutes.

Date Mode

YYMMDD/MMDDYY/DDMMYY

Selects the display format for dates.
YYMMDD: Year, month, day
MMDDYY: Month, day, year
DDMMYY: Day, month, year

Date

Sets the current date (apply by pressing Set).

Time

Sets the current time (apply by pressing Set).

Maintenance > Language

Selects the display language for menus and messages.

Menu item Settings

Description

Select English/ 532 (f&)

Selects the display language for the full menu and
messages.

Maintenance > Hours Meter
Displays the accumulated usage time.

Menu item Settings

Description

Camera(System)

Displays the accumulated time of use of the unit
(cannot be reset).

R7 Recorder

(System)

(Only when an AXS-R7
is attached)

Displays the accumulated time of use of the
AXS-R7 connected to the unit (cannot be reset).

Camera(Resettable)

Displays the accumulated time of use of the unit
(can be reset).

R7 Recorder
(Resettable)
(Only when an AXS-R7
is attached)

Displays the accumulated time of use of the
AXS-R7 connected to the unit (can be reset).

Reset-Cam Execute/Cancel Resets the Camera(Resettable) display to 0
(Resettable) (execute by selecting Execute).
Reset-R7 Execute/Cancel Resets the R7 Recorder(Resettable) display for the

(Resettable)
(Only when an AXS-R7
is attached)

AXS-R7 connected to the unit to O (execute by
selecting Execute).
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Maintenance > Reset to Default
Returns the unit to factory default state.

Maintenance > Firmware
Displays the version of the unit and AXS-R7, and updates the unit.

Menu item Settings Description Menu item Settings Description
Reset Execute/Cancel Initializes all unit settings (execute by selecting FW Update-camera Execute/Cancel Updates the unit (execute by selecting Execute).
Execute). FW Update-AXS-R7 Execute/Cancel Updates the firmware version of the AXS-R7
Maintenance > License Options connected to the unit (execute by selecting
Execute).

Installs software options.

Menu item Settings Description

Install: <target_ Execute/Cancel Installs software options (execute by selecting
license> Execute).

Anamorphic Permanent License Installed/XX  Displays whether the Anamorphic option is

days Remaining (YY keys)/
Expired/Not Installed

enabled.

Permanent License Installed: Permanent license is
installed

XX days Remaining (YY keys): Expiration of timed
license

Expired: Timed license has expired

Not Installed: Not installed

Full-Frame Permanent License Installed/XX
days Remaining (YY keys)/
Expired/Not Installed

Displays whether the Full Frame option is
enabled.

Permanent License Installed: Permanent license is
installed

XX days Remaining (YY keys): Expiration of timed
license

Expired: Timed license has expired

Not Installed: Not installed

High Frame Rate Permanent License Installed/XX
days Remaining (YY keys)/
Expired/Not Installed

Displays whether the High Frame Rate option is
enabled.

Permanent License Installed: Permanent license is
installed

XX days Remaining (YY keys): Expiration of timed
license

Expired: Timed license has expired

Not Installed: Not installed

Unique Device ID

Displays the ID used for issuing the software
option license key.

Maintenance > Firmware

Displays the version of the unit and AXS-R7, and updates the unit.

Menu item Settings Description
Camera Displays the firmware version of the unit (Vx.xx).
AXS Displays the firmware version of the AXS-R7

(Only when an AXS-R7
is attached)

connected to the unit (Vx.xx).
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Clip Operations on the Sub Display

Clip operations are performed using the clip list screen and the playback screen. You can play a clip by
selecting the clip to play from the clip list screen displayed on the sub display.

When AXS Rec Format is not set to Rec Off in the Project category in the menu, AXS media becomes
playable. Similarly, when SxS Rec Format is not set to Rec Off, SxS media becomes playable.

(lip List Screen

Press the CLIPS button (page 10) on the Assistant side to display the clip list screen for playable media
on the sub display.

1 A001C001_180101CQ & M
1 A001C002_180101G7 & B
1 A001C003_180101HR & B
1 A001C004_180101WK & BN

A001C005_180101Sg & B
A001C006_180101GF & B

1. Media select button Icon  Meaning

Displays “SxS/AXS" if both SxS and AXS media

Clip with a created sub cli
are playable. Press ITEM key 1 to switch the Sub P P

playback media. Locked (write protection) clip

2. Cursor up button
Press ITEM key 2 to select the clip to play from 5

o . Cursor down button
the clip list.

Press ITEM key 5 to select the clip to play from
3. Playback start button the clip list.
Press ITEM key 3 to display the playback screen 6

. Clip position in playback media
(page 15) and start playback. bP pay

Displays the number of the clip indicated by

4. Clip list the cursor and total number of clips.
Displays a list of clips on the active playback 7. Creation date and time
media. It also displays the clips status using

Displays the creation date and time of the clip

Icons. indicated by the cursor.

10.

11.

12.

13.

Format (codec)
Displays the recording format (codec) of the
clip indicated by the cursor.

Picture size indicator

Displays the effective picture size when the
clip indicated by the cursor was recorded.
[Note]

Not displayed when the playback media is an SxS
memory card.

Project frame rate/special recording mode
indicator

Displays the project frame rate and special
recording mode of the clip indicated by the
cursor.

Duration (Dur)
Displays the duration of the clip indicated by
the cursor.

Timecode (TCR)
Displays the timecode of the first frame of the
clip indicated by the cursor.

Active playback media
Displays the active playback media of the
displayed list.
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Playback Screen

The playback screen is displayed when you select a clip to play on the clip list screen and press the MENU
dial or Play button (ITEM key 3).

Function display area

Dur 00:00:00:00 23.98fps 3.8K 16:9

»» x24 DCIN 15.0V 30FPS
SXS @ 002/010 XAVC QFHD C480
A001C002_160328WW &

1. FRev button 4. Prev button
Play back at high speed in the reverse Skip to the start of the previous clip.

direction. 5. Stop/Clips button

2. Play/Pause button

Play a clip or pause playback. 6. Next button

3. FFwd button Skip to the start of the next clip.
Play back at high speed in the forward

direction.

Stop playback and return to the clip list screen.

Status display area

. Time data display

Displays the timecode of the playback
position.

. Clip number

Displays the Current playback clip number/
Total number of playable clips.

. Frame rate/imager mode indicator

Displays the project frame rate and picture
size.
[Note]

The picture size is not displayed when the playback
media is an SxS memory card.

. Special recording mode indicator

Displays the special recording mode
information of the playback clip.

. Audio level meters

Displays the playback audio level.

. Playback clip format (codec) indicator

Displays the format (codec) of the playback
clip.

Icon display
Displays the clip status using icons.

Icon Meaning

Sub Clip with a created sub clip

Locked (write protection) clip

Clip name indicator
Displays the name of the clip.

Media indicator
Displays the media being played.

. Playback status indicator

Displays the playback status.
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Playback

You can play recorded clips while the unit is in
standby mode.

[Note]

The playback controls appear on ITEM keys 1 to 6

(page 9). Press an ITEM key to select the corresponding
item.

1 Insert the SxS memory card to play.

2 Press the CLIPS button (page 10) on the
Assistant side.
The clip list on the active playback media
appears on the sub display.

3 Use the 4 button (ITEM key 2), § button
(ITEM key 5), or MENU dial to select a clip to

play.

4 Press the MENU dial or the Play button (ITEM
key 3).
The playback image appears on the
viewfinder/monitor screen.

12:34:56:00 _ A001C001

Play XCON ST

Playback operations

Playback operation is performed using the buttons

on the sub display (page 74).

Play/Pause button: Pause playback. To resume
playback, press this button again.

F Fwd button/F Rev button: Fast forward/reverse.
To return to normal playback, press the Play/
Pause button.

Stop/Clips button: Stop playback and return to the
clip list screen.

Monitoring audio

In normal playback mode, you can monitor the
recorded audio through the built-in speaker
(page 8) or connected headphones.

When headphones are connected to the
headphones connector (page 8), the built-in
speaker is turned off.

You can select the channel to monitor and adjust
the volume using Audio category > Monitor CH
and Monitor Level (page 46) in the menu.

Cueing up

To play from the start of a clip, press the Prev
button on the sub display (page 74).

You can skip clips and cue-up another clip
by pressing the Prev button or Next button
repeatedly.

Switching the SxS memory cards

When two SxS memory cards are loaded, press
the SLOT SELECT button (page 9) to switch
memory cards.

[Note]

You cannot switch SxS memory cards during playback.
Continuous playback of cards in slots A and B is not possible.

Switching to an AXS memory card

You can quickly play video recorded on an AXS
memory card in the AXS-R7.

To switch to an AXS memory card, press ITEM key
1 (page 73) on the sub display.

(ases where playback on the unit is not supported

Clips recorded on AXS media under the following

conditions cannot be played back on the unit.

Play the clips using a PC application, such as RAW

Viewer.

® \When Imager Mode is set to 6K 3:2 and Project
Frame Rate is set to 59.94P or 50P

® \When Imager Mode is set to 4K 4:3 and Project
Frame Rate is set to 59.94P or 50P
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Operations on the Home Screen of the Mini Display

You can check the status of the unit and set basic (page 68) is set to On in the full menu. Set C | B . O .
settings for the unit on the Home screen of the these using the remote control unit (page 87). ontrols dsIC peratlon
mini display. ® Shutter

® \WB (White Balance)

1 Press ITEM key 1, 2, or 3.
1 PS leed 2 HOME button (page 8) The cursor appears.

Press to return to the Home screen. Unconfirmed

changes are canceled.
9 2 Select the item to set using the B button

TEM key 1 (4 (page 8 (ITEM key 1) or & button (ITEM key 3).

5 WB WB_5600+99 Press to select items on the Home screen. FPS Fixed 24

A 180.0
1. FPS gfehfskfg i (.I) Efwaeggeégllcted item A Clear
Sets the shooting frame rate. PPy ’ m 500
+00
2. Shutter ITEM key 3 (&) (page 8) wB 5600
Displays and sets the shutter speed/shutter Press to select items on the Home screen.
angle of the electronic shutter. 3
3. ND Filter Press the @ button (ITEM key 2).

The setting value selection screen appears for

Displays and sets the density of the ND filter. the selected itern.

4. Exposure Index/Gain
Displays and sets the exposure index (El), or
displays the gain value (dB units) set by an
RM-B170 or other remote control unit.

[Note]

The gain value is displayed only when Technical
> System Configuration > RM/RCP Paint Control
(page 68) is set to On in the full menu.

5. WB (White Balance) [Note]
Displays and sets the white balance. o _
The @ mark indicates the current setting.
Display and operation when RM/RCP Paint 4 A .

. Move the cursor to the item or setting value
Controlis enabled using the B button (ITEM key 1) or & button
® The gain value is displayed instead of the (TEM key 3).

Exposure Index when Technical > System
Configuration > RM/RCP Paint Control 5 Press the @ button (ITEM key 2) to apply the
(page 68) is set to On in the full menu. In this setting.
mode, the El value cannot be changed.
¢ The following items cannot be operated 6 Press the HOME button to hide the cursor.

when an RM-B170 or other remote control
unit is connected and Technical > System
Configuration > RM/RCP Paint Control
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3. Camera Operations: Operations on the Home Screen of the Mini Display

Home Screen [tems on the Mini Display

The names of items and corresponding setting values are given below.
Default values are shown underlined and in bold text.

Iltem

Description

Item

Description

FPS

Sets the shooting frame rate.

Variable/Fixed: Switch between variable speed and constant speed shooting on
the Home screen (page 37) of the sub display.

When “Fixed" is selected, the setting is determined by the Project category >
Project Frame Rate (page 44) setting in the menu.

Project Frame Rate Display
2398 Fixed 24
24 Fixed 24
25 Fixed 25
29.97 Fixed 30
47.95 Fixed 48
50 Fixed 50
59.94 Fixed 60

When “Variable" is selected, the setting changes as follows depending on the
Project category > Imager Mode (page 58) setting in the menu.

Imager Mode Setting

38K 169 1to 60 FPS

4K 179

4K 17:9" 11060, 66,72,75, 88,90, 96,
100, 110 FPS

3.8K 16:9 Surround View 1to 48 FPS

4K 17:9 Surround View

4K 4:3

4K 4:3" 1t060,66,72,75FPS

4K2.39:17" 120 FPS

Imager Mode Setting

4K 4:3 Surround View 110 30 FPS
4K 6:5

57K16:9

6K 2.39:1

6K 17:9

6K 1.85:1

6K 3:2 110 25 FPS
6K 3:27 110 60 FPS

Exposure Index

Sets the El value. The setting changes as follows depending on the Project > Basic
Setting > Base ISO (page 58) setting in the full menu.
ISO 500:
125E1/160E1/200EI/250E1/320EI/400EI/500EI/640EI/800EI/1000El/
1250E1/1600El/2000EI
1ISO 2500:
640EI/800EI/1000EI/1250El/1600E1/2000El/2500EI/3200EI/4000E1/
5000EI/6400EI/8000EI/10000E|

Shutter Sets the electronic shutter angle/shutter speed.
Select from preset values registered as shutter steps.
[Note]
Not available when the electronic shutter operation is set to Continuous.
Displays the following selection options depending on the Technical > System
Configuration > Shutter Mode (page 68) setting in the full menu.
Angle (A): Shutter angle indicator
360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2/5.6%
Speed (SS): Shutter speed indicator
1/24,1/25,1/30,1/48,1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 ?
ND Filter Sets the density of the ND filter. The following settings are available.

Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

WB (White Balance)

Sets the color temperature of the white balance.
Select from preset values registered as WB steps.
3200K+00/4300K+00/5500K+00?

U Only when a High Frame Rate License is activated.
2" The selection options can be changed using Step Edit on the Home screen of the sub display.
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Clip Operations on the Mini Display

You can play a clip by selecting the clip to play
from the clip screen displayed on the mini display.
When AXS Rec Format is not set to Rec Off in the
Project category in the menu, AXS media becomes
playable. Similarly, when SxS Rec Format is not set
to Rec Off, SxS media becomes playable.

When both AXS and SxS media playback is
enabled, you can select the active media on the
clip list screen (page 73) of the sub display.

(lip Screen

Press the CLIPS button (page 8) on the
Operator side to display the clip screen for
playable media on the mini display.

1. Playback status indicator
Displays the clip playback status.

2. Active playback media
Displays the active playback media of the
selected clip.

3. Clip name
Displays the clip name of the selected clip.

4. Clip position in playback media
Displays the clip number/total number of the
selected clip.

5. FFwd/Next button
Jumps to the next clip when ITEM key 3 (&) is
pressed while playback is paused.
Fast forwards the clip when ITEM key 3 (&) is
pressed during playback.

6. Play/Pause button
Plays/pauses clip playback when ITEM key 2
(@) is pressed.

7. F Rev/Prev button
Jumps to the previous clip when [TEM key 1
(1) is pressed while playback is paused.
Fast reverses the clip when ITEM key 1 () is
pressed during playback.

Playing

You can play recorded clips while the unit is in
standby mode.

1 Insert the SxS memory card to play.

2 Press the CLIPS button (page 8) on the
Operator side.
The active playback clip appears on the mini
display.

3 Use the Prev button (ITEM key 1) or Next
button (ITEM key 3) to select a clip to play.

4 Press the Play/Pause button (ITEM key 2).
The playback image appears on the
viewfinder/monitor screen.

XCON ST

12:34:56:00  A001C001 Play

Playback operations

Playback operation is performed using the buttons
on the mini display (page 78).

Play/Pause button: Pause playback. To resume
playback, press this button again.

F Fwd button/F Rev button: Fast forward/reverse.
To return to normal playback, press the Play/Pause
button.

Monitoring audio

In normal playback mode, you can monitor the
recorded audio through the built-in speaker
(page 8) or connected headphones.

When headphones are connected to the
headphones connector (page 8), the built-in
speaker is turned off.

You can select the channel to monitor and adjust
the volume using Audio category > Monitor CH
and Monitor Level (page 46) in the menu.

Switching the SxS memory cards

When two SxS memory cards are loaded, press
the SLOT SELECT button (page 9) to switch
memory cards.

[Note]

You cannot switch SxS memory cards during playback.
Continuous playback of cards in slots A and B is not possible.
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4. Network

Network Setup and Operations

Connecting the unit to a network allows you

to control various settings of the unit from a
computer, smartphone, tablet, or other device and
to display information about the unit.

Overview of Network Function

When the unit and a device are connected
via wired LAN or wireless LAN, the unit can be
accessed from a browser on the device, displaying
the web remote control and enabling the
following operations.
® Control recording on the unit (page 82)
e Control playback on the unit (page 82)
e Configure shooting settings on the unit
(page 82)
e Control the lens attached to the unit
(page 82)
® Configure and operate assignable buttons on
the unit (page 82)
Using the web remote control allows you to start/
stop recording or configure settings remotely,
and is useful in applications where the unit is fixed
in a remote location or mounted on a crane, for
example.

Compatible Devices

You can use a computer, smartphone, or tablet
to configure and operate the unit. The supported
devices, OS, and browsers are shown in the
following table.

Device oS Browser

Microsoft Windows 8.1/ Chrome
Microsoft Windows 10

Computer

macOS 10.13/10.14 Safari

Device oS Browser
Smartphone Android 8.x/9.0 Chrome
i0OS 11.x/12x Safari
Tablet Android 6.x/7 x Chrome
iOS 11.x/12.x Safari
[Note]

The controls may not be displayed normally, depending on
the version of the browser you are using. Operation in the
following versions of the browsers has been verified.

Safari: 11,12

Chrome: V69

Connecting the Unit and Device via
Wired LAN

You can connect the unit to a device via a wired
LAN connection or via a router using the network
connector of the unit.

1 Connect the network connector (page 8)
of the unit and computer using a LAN cable.
Or connect the network connector of the unit
and router using a LAN cable.

2 Set Technical > Network > Setting (page 69)
in the full menu to LAN.

3 Configure the unit.
To obtain the IP address of the unit
automatically:
Set Technical > Network > LAN > DHCP
(page 69) in the full menu to On, then select
Set to apply the setting.
To enter the IP address of the unit manually:
Set Technical > Network > LAN > DHCP in the
full menu to Off, enter the specified address
using LAN > IP Address, and select Set to apply
the setting.

[Note]

Select Set on the Technical > Network > LAN setup
screen in the full menu. If Set is not selected, the
configured settings are not applied.

When the wired LAN connection is enabled,
the LAN icon of the network connection status
indicator (page 14) is displayed on the
viewfinder/monitor screen.

Connecting the Unit and Device via
Wireless LAN

2 Attach the protective cap (supplied) to the
USB connector of the USB extension adaptor.

The unit can connect to devices using wireless
LAN connection by attaching the CBK-WAOQ2
Wireless LAN Adaptor (option) to the unit.

Attaching the (BK-WAQ2

[Note]

Always turn the unit off before connecting the CBK-WAQ2. 3 o h fih | devi
pen the cover of the external aevice

connector block, and insert the USB connector
of the USB extension adaptor into the external
device connector.

] Attach the USB extension adaptor to the point
shown in the following diagram, and turn the
retaining screw clockwise to secure it in
position.

Retaining screw

J USB extension adaptor

You can adjust the position of the USB
extension adaptor over the range shown in the
following diagram.
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4 Insert the CBK-WAO02 into the USB connector of
the USB extension adaptor.

Connecting in access point mode

The unit can connect to devices that are set up as
an access point.

Smartphone/ Computer

Tablet

Connecting using WPS-equipped devices
Devices that support WPS can be connected using
WPS.

] Set Technical > Network > Setting (page 69)
in the full menu to Wireless.

2 Set Technical > Network > Wireless > Network
Mode (page 69) in the full menu to Access
Point.

3 Select Technical > Network > Wireless > WPS
(page 69) in the full menu.

4 Select Execute by turning the MENU dial, then
press the MENU dial.

5 Open the device Network Settings or Wi-Fi
Settings, and turn Wi-Fi on.

6 Press the WPS push button in the device
Network Settings or Wi-Fi Settings preferences.

[Note]
The steps will vary depending on the device used.

Connecting using SSID and password on the device
Connect by entering the SSID and password on
the device.

] Set Technical > Network > Setting (page 69)
in the full menu to Wireless.

2 Set Technical > Network > Wireless > Network
Mode (page 69) in the full menu to Access
Point.

3 Open the device Network Settings or Wi-Fi
Settings, and turn Wi-Fi on.

4 Select the unit’s SSID from the Wi-Fi network
SSID list, then enter a password to connect.
For the unit's SSID and password, see Technical
> Network > Wireless > SSID and Password
(page 69) in the full menu.

[Note]
The steps will vary depending on the device used.

Connecting in station mode

The unit can connect to existing wireless LAN
access points as a client.
The device connects via the access point.

Computer

Smartphone/
Tablet

~
N’
SN—YV

Access
point

Connecting to an access point using WPS
If an access point supports the WPS function, you
can connect using a basic setting.

] Turn the access point on.
2 Turn the unit on.

3 Set Technical > Network > Setting (page 69)
in the full menu to Wireless.

4 Set Technical > Network > Wireless > Network
Mode (page 69) in the full menu to Station.

5 Select Technical > Network > Wireless > WPS
(page 69) in the full menu.

6 Select Execute by turning the MENU dial, then
press the MENU dial.

7 Press the access point WPS button.
For details about WPS button operation, refer
to the instruction manual for the access point.
[Note]

If the connection fails, perform the procedure again from
step 1.

Connecting by entering a SSID and password
Connect by entering the SSID and password on
the unit.

] Set Technical > Network > Setting (page 69)
in the full menu to Wireless.

2 Set Technical > Network > Wireless > Network
Mode (page 69) in the full menu to Station.

3 Set the following items in Technical > Network
> Wireless (page 69) in the full menu.
e SSID
® Password
® DHCP
® |P Address
® Subnet Mask

4 Select Set to confirm.

[Note]
Always use Set to confirm the settings. If the settings are not
confirmed using Set, the configured settings are not applied.
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Connecting using access point auto detection

The unit can connect by detecting connection
access points automatically, without having to
enter the SSID manually.

1 Set Technical > Network > Setting (page 69)
in the full menu to Wireless.

2 Set Technical > Network > Wireless > Network
Mode (page 69) in the full menu to Station.

3 Select Technical > Network > Wireless > Scan
Networks (page 69) in the full menu.

4 Select Execute by turning the MENU dial, then
press the MENU dial.
The unit starts auto detection of connection
access points. When auto detection finishes,
networks available for connection are
displayed in a list.

5 Select the network to be connected by turning
the MENU dial, then press the MENU dial.

6 Select Set to confirm.
A password input screen appears.

7 Enter the password, then select Done.
The Wireless preferences screen appears.

8 Set the following items in Technical > Network
> Wireless in the full menu, then select Set to
confirm.

e DHCP
® |P Address
® Subnet Mask

[Note]
Always use Set to confirm the settings. If the settings are not
confirmed using Set, the configured settings are not applied.

Displaying the Web Remaote Control

The web remote control is displayed when the
unit is accessed from the browser of a device. The

web remote control screen is automatically resized

to match the screen size of the connected device.

1

Connect the unit and device as described in
“Connecting the Unit and Device via Wired
LAN" or “Connecting the Unit and Device via
Wireless LAN",

Launch a browser on the device and enter
"http://IP address of unit/rm.html” in the URL
bar.

You can check the IP address of the unit using
Info category > System > IP Address

(page 46) in the menu.

For example, if the IP address is 192.168.1.1,
enter “http://192.168.1.1/rm.html" in the URL
bar.

Enter the user name and password (Technical
> Authentication (page 69) in the full menu)
on the browser screen.

When connection is successful, the web
remote control screen appears on the device.

[Note]

The page may not be displayed correctly on a smartphone
or other device if the viewing mode is set to mobile pages.
Change the viewing mode to desktop pages.

Web Remote Control Screen

Global Menu

select & at the top left of the web remote control

screen to display the Global Menu. Select the item
you want to configure.

Full Menu

0SS Information

Camera Control screen

The Camera Control screen contains the Camera
screen and Lens screen. Select the Camera tab to
display the Camera screen, and select the Lens tab

to display the Lens screen.

Various display items and operation buttons are
displayed on the Camera Control screen (common

to Camera screen, Lens screen, and playback

screen).

e Network connection status (Connected/
Disconnected)

® Camera ID*

® Rec button

® Assignable buttons (1 to 4, Ato Q)
* The Camera ID text color is the same color set using
Frame Line A/B Setup > Color.

Camera screen

ID:A Camera ®Connected

= Camera Control
()
()
Lens

FPS £l Em Shutter

24 500 | 180.0
:00:07:00 2388ips 4K 17:9
BAT 16.4V A001 S0l GO0t
Isxs 66 XAVC 4K C300

3200 +00

ws

CLIPS Clear
ND

You can configure the same items that are

displayed on the Home screen of the sub display

on the Camera screen.

[Note]

Similarly as for the sub display screen, the El display area
switches to become the Gain display area and restrictions
apply to the items (page 33) that can be operated when
Technical > System Configuration > RM/RCP Paint Control
(page 68) is set to On in the full menu.

® Shooting settings (page 31)
FPS, El, Shutter, ND, LUT, WB

® Camera status display (page 31)
Operating status, time data, audio level meter,
clip name, recording format, media status/
free space, battery voltage/remaining battery
capacity

Lens screen

= Camera Control ID:A Camera ® Connected

Assign

@ v omoncim o Assignod [ @ o rssionea

Camera Lens
oPEN

Lens controls for zoom, focus, and iris are
displayed on the Lens screen.

Full Menu screen

Select Full Menu in the Global Menu to display
the full menu screen in order to configure items
(page 55).

[Note]

Some items may not be configurable from the web remote
control.
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= Full Menu ID:ACamera ®Connected

g > Imager Mode

2 Special Recording Project Frame Rate
Al File Input Color Space
] 5 SXS Rec Format
Timecode Sub Rec Format
Clip Name Format Base ISO
Output Format

OSD Appearance

Monitor Display

0SS (Open Source Software) Information screen

Select OSS Information in the Global Menu to
display the open source software information.

Playback screen

= Camera Control ID:ACamera ®Connected

o-

Play/Pause
11

07:00 23.980ps
v 24FPS

164V
001/001 XAVC 4K C300
AQD1C001_180109D1
e u

Prev Stop/Clips.

You can play clips on the playback screen.
Information about the playback clip is also
displayed in the status display area on the screen.
® Function display (page 74)
F Rev, Play/Pause, F Fwd, Prev, Stop/Clips, Next
® Playback status display (page 74)
Time data, clip number, frame rate/playback clip
picture size (AXS only), special recording mode,
audio level meter, playback clip format (codec),
icon (protection, sub clip), clip name, playback
media, and playback status.

HOME button

Press the HOME button to return to the Camera
screen.

When the camera is in playback mode, pressing
the HOME button returns to the camera shooting
status even when the playback screen is displayed
on the web remote control screen.

CLIPS button

Press the CLIPS button to return to the playback
screen. (The unit switches to the clip list screen
(page 73))

Recording

Press the Rec button on the Camera Control
screen to start recording and to display the REC
lamp in red. Click again to stop recording.

The Rec button is enabled when the REC ACTIVE
lamp below and to the right of the Rec button is
green.

To lock the Rec button

Slide the Lock slider below the Rec button to the
right to disable the Rec button operation.

Playing

Press the CLIPS button on the Camera screen to
return to the playback screen in playback state.
(The sub display on the unit displays the clip list
screen (page 73).)

Select the clip you want to play on the playback
screen, and use the playback controls to play the

clip.
To switch between playback media

The media select button is displayed when the
unitis in playback state. If both SxS and AXS media

are playable, the media select button is enabled.
Press the button to switch the playback media.

Configuring Shooting Settings

You can configure and operate the same items
that are displayed on the Home screen of the sub
display of the unit on the Camera screen.

[Note]
Step Edit operation for Shutter is not supported.

The operation is the same as on the Home screen
of the sub display.

“Operations on the Home Screen of the Sub Display” (page 33)

Controlling the Lens

You can check the status of E mount lens settings
(zoom, focus, iris) on the Lens screen, and also
control the zoom, focus, and iris using sliders if the
attached lens is controllable.

PL mount Cooke lens communication control is
supported on the Lens screen.

Also, 12-pin lens communication control is
supported on the Lens screen.

[Note]

The sliders are grayed out and cannot be operated when
an RM-B170 or other remote control unit is connected and
Technical > System Configuration > RM/RCP Paint Control
(page 68) is set to On in the full menu. The focus and
zoom sliders are grayed out when remote control of focus
and zoom, respectively, are enabled.

Configuring/Operating Assignable
Buttons

Assignable buttons 1 to 4 and viewfinder
assignable buttons A to C are displayed on the
Camera Control screen.

Press assignable buttons 1 to 4 and DVF-EL200
assignable buttons A to C to toggle the assigned
functions between on/off (enable/disable) or to
activate the assigned functions in the same way as
assignable buttons on the unit.

Select the function name of an assignable button
to display selection options in a pull-down. Select
an option to change the function assigned to the
assignable button.

“Functions that can be Assigned to Assignable Buttons 1 to 4"
(page 40)

“Functions that can be Assigned to Viewfinder (DVF-EL200)
Assignable Buttons A to C" (page 42)

[Note]
Functions assigned to assignable switches that are enabled
only while a button is pressed or are enabled by a long press
cannot be operated from the assignable buttons of the web
remote control. These comprise the following functions.

- Press &Hold for SDI Log

- Press &Hold for Monitor Log

- Press &Hold for VF Log

- Iris Open (1/16 stop)
Iris Close (1/16 stop)

Locking the Web Remote Control
Screen
You can disable web remote control screen

operation by sliding the Lock slider to the right on
the top right of the web remote control screen.
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Basic Operations

Basic recording can be performed with the
following procedures.

1 Make sure that the necessary devices are
attached to the unit and power is supplied to
them.

2 Set the power switch (page 8) to the ON
position.
The recording screen is displayed on the
viewfinder screen.

3 Load the memory card(s).
If you load two AXS memory card or SxS
memory cards, recording is continued by
automatically switching to the second card
when the first card becomes full.
[Note]

The cards do not switch automatically during
simultaneous recording.

4 Press the REC button (pages 8, 10).
The REC lamp lights and recording begins.
[Note]
If the unit cannot start recording immediately after the

pressing the REC button, the REC lamp flashes. The REC
lamp lights when recording starts.

5 To stop recording, press the REC button again.
Recording stops and the unit enters STBY
(recording standby) mode.

When you stop recording, the video, audio,
and subsidiary data from the start to the end
of the recording are recorded as a single clip.

(lip names

Clip names are recorded using the “Cam ID +
Reel#” format. The clip name is created according
to the following rules.

® \When there is already a clip that is stored using

the “Cam ID + Reel#” name format on the

inserted SxS memory card or AXS memory card,
the new file inherits from the last file.

Example: If “B002CO03_XXXXXXXX" exists on the

AXS memory card, the next created clip will be

named “B002C004_XXXXXXXX."

If the inserted AXS memory card has no files, “1"

is added to the Reel Number of the clip that was

recorded last.

Example: If you record on empty card 2 after

recording up to “D00TCXXX_XXXXXXXX" on

card 1, the next created clip will be named

“D002CO0T_XXXXXXXX." The clip name is

displayed underlined until recording starts.

e [fyou set Camera ID and Reel Number using TC/
Media category > Clip Naming in the menu, that
information is applied.

Example: If you change Camera ID to “F” and
Reel Number to “001" in the menu for the
AXS memory card that has recorded up to
"EO03CXXX_XXXXXXXX,” the next clip will
be named “FOOTCXXX_XXXXXXXX." When
you change Camera ID only, Reel Number is
changed to “001."

Maximum duration of a clip

The maximum single clip length that you can
record to an SxS memory card is 6 hours. The
maximum recording time is 24 hours.

Recording will span clips if the recording time
exceeds the maximum clip duration.

Recording stops when the recording time reaches
24 hours.
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Useful Functions

Simultaneous Recording

You can simultaneously record two sizes of
pictures on an SxS memory card in one slot. You
can also simultaneously record an HD signal on an
SxS memory card in the unit while recording video
and audio in RAW format on the AXS-R7.

You can perform simultaneous recording using
Project category > AXS Rec Format and SxS Rec
Format or SxS Rec Format and Sub Rec Format

in the menu as described in “Recording Format
Settings” (page 48).

In 1-slot simultaneous recording, the XAVC 4K
Class480/XAVC 4K Class300/XAVC QFHD Class480/
XAVC QFHD Class300 clip is recorded in the
XDROOT/Clip directory on the SxS memory card,
but the MPEG2 19201080 clip is recorded in the
XDROQOT/Sub directory on the SxS memory card.
The suffix “S02" is appended to the end of the clip
name.

Picture Cache Recording

The unit always maintains a cache of video and
audio data for a set interval (maximum of 30
seconds) in memory when shooting, allowing you
to record several seconds of footage before the
start of recording.

When you start recording with Project > Special
Recording > Cache Rec Select (page 59) set

to On in the full menu, video of duration set by
Project > Special Recording > Max Cache Rec
Duration (page 59) is recorded retroactively.

You can also turn picture cache recording on/
off using an assignable button assigned with the
Picture Cache Rec function.

[Notes]

® Restrictions to the Max Cache Rec Duration setting may
apply, depending on the system frequency, recording
format, and recording media. For details, see page 59.

e Changing system settings, such as the recording format,
clears all images stored in memory. Consequently, images
shot just before changing settings cannot be recorded, if
recording is started immediately after changing settings.
Picture cache mode is automatically released.

e Picture cache mode recording is not available during
1-slot simultaneous recording or AXS/SxS simultaneous
recording.

® The picture cache settings cannot be changed during
recording.

e When recording in MPEG 422 at low shooting frame rates,
it may take some time to stop recording or to switch
between memory cards.

Recording Review (Rec Review)

You can review the last recorded clip on the
screen by assigning the Rec Review function to
one of assignable buttons 1 to 4 (page 39).
When you stop recording and press the button
assigned with Rec Review, the clip is played at
normal speed starting from the first frame.

The clip is played to the end, then Rec Review
ends and the unit returns to STBY (recording
standby) mode.

If the HOME button is pressed on the Operator
side or Assistant side during playback, playback
stops and the unit switches to shooting mode.

High-Definition Focus Magnifier
Function

By pressing the FOCUS MAG button of the
viewfinder (DVF-EL200, DVF-L700) attached to

the unit, you can expand the center part of the
viewfinder, making it is easier to adjust the focus.
The magnified display does not affect the recorded
image or output signal.

Normal focus magnification reduces the resolution
because it simply magnifies a part of the displayed
image. However, the two-times (x2) focusing

by the unit provides focus magnification while
maintaining the display resolution by cutting out
the portion to magnify from the 4K signal instead
of the recorded image or other output signal.
Four-times (x4) focus magnification selection

is also supported using the 4K image cutout
function.

The FOCUS MAG button magnification sequence
can be changed using Monitoring > VF Display >
VF Magnifier Ratio (page 66) in the full menu.
When VF Magnifier Ratio is set to x2.0/x4.0, the
magnification sequence each time you press
assignable buttons 1 to 4 assigned with VF Focus
Magnifier is x2.0 — x4.0 — x1.0 = x2.0.

[Note]

In High Frame Rate mode (shooting frame rate of 61 fps or
higher), the x2 focus display image resolution decreases
because cutout display from a 4K image is not supported.
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Highlight Clip Indicator

You can display clipped highlight areas in red in
the Monitor output image and viewfinder output
image.

Press the assignable buttons (pages 39, 40)
assigned with Monitor Highlight Clip Ind and VF
Highlight Clip Ind to switch the highlight clip
indicators on/off.

[Note]

Highlight clip indicators do not function when Technical >
System Configuration > RM/RCP Paint Control (page 68) is
set to On in the full menu.

High Key / Low Key

You can check for blown-out highlights and
blocked-out shadows in the Monitor output image
and viewfinder output image.

Turn High Key on to differentiate areas of high
luminance, making them easier to see, to check for
blown-out highlights.

Turn Low Key on to differentiate areas of low
luminance, making them easier to see, to check for
blocked-out shadows.

Press assignable buttons 1 to 4 (page 40)

assigned with Monitor High/Low Key and VF
High/Low Key to switch the high key and low key
settings.

[Note]

High/Low key does not function when Technical > System

Configuration > RM/RCP Paint Control (page 68) is set to
On in the full menu.

False Color Display

You can display false color in the viewfinder by
pressing the B/False Color button (DVF-EL200)
or SPARE button (DVF-L700) on the viewfinder
attached to the unit.

You can also display false color on the monitor
output.

Display  Signal level

color S-Log3 (default)  S-Log2 (PMW-F55
reference)

Red 93.4% to 96.1% 105.5% to 109.5%

Yellow 91.3% to 93.4% 102.5% to 105.5%

Orange 87.7% to 90.6% 97.4% to 101.5%

Pink 54.3% to 58.0% 50.2% to 55.2%

41.5% to 45.4%
(18% gray + 1 stop)

Light pink  47.8% to 50.8%
(18% gray + 1 stop)

Cyan 43.8% to 46.5% 36.3% to 39.6%
Green 38.9% to 42.2% 30.4% to 34.4%
(18% gray) (18% gray)
Light blue 24.6% to 34.4% 15.5% to 25.2%
Blue 3.5% to 5.6% 3.0% to 4.0%
Purple ~7.3% t0 3.5% -7.3% t0 3.0%

® You can set whether to use the preset on/
off setting and threshold of each false color in
the viewfinder and monitor output, or to set
colors manually using Monitoring > False Color
(page 65).

® You can turn the false color function display in
a viewfinder on/off by pressing an assignable
button assigned with VF False Color.

® You can turn the false color function display
on a monitor on/off by pressing an assignable
button assigned with Monitor False Color.

[Notes]

e On the DVF-L700, display is supported only when
Gamma is set to S-Log?2 for the video signal output in the
viewfinder.

e The false color function does not operate when Technical
> System Configuration > RM/RCP Paint Control
(page 68) is set to On in the full menu.

Viewfinder Double Speed Scan
Function

If the project frame rate is 23.98P, 24P, 25P, or
29.97P, the image may become blurred and hard
to see due to low frame frequency when you
shoot while swaying the unit to the right and the
left.

In this case, you can decrease image blur and
make it easier to see by activating the viewfinder
double speed scan function.

To activate the function, set Monitoring > VF
Function > Double Speed Scan (page 66) in the
full menu to On.

[Notes]

e When this function is activated, the shutter angle of the
electronic shutter function is limited to 180 degrees or
lower.

e This function is set to Off during variable speed shooting.

e This function is enabled for the following combinations of
image size and project frame rate.
3.8K 16:9 (23.98p, 24p, 25p, 29.97p)
4K 17:9 (23.98p, 24p, 25p, 29.97p)
3.8K16:9 Surround (23.98p, 24p)
4K 17:9 Surround (23.98p, 24p)
4K 4:3 (23.98p, 24p)

User 3D LUT

You can load a CUBE file (*.cube) for a 17-point

or 33-point 3D LUT created using RAW Viewer or
DaVinci Resolve (by Blackmagic Design Pty. Ltd.)
(page 35).

Set Input Color Space to match the input color
space of when the CUBE file was created.

If the file was created using S-Gamut3.Cine/S-Logs,
set Project category > Basic Setting > Input Color
Space (page 58) in the menu to S-Gamut3.
Cine/S-Logs.

Save the User 3D LUT file in the following directory
on the SD card.

PRIVATEASONY\PRO\LUT\

ASCCDL

You can import ASC CDL (The American Society of
Cinematographers Color Decision List) files (*.cdl)
created by external tools into the unit.

This allows you shoot with ASC CDL parameters
applied to the Look.

Save the ASC CDL file in the following directory on
the SD card.

PRIVATEASONYAPRO\CDL\
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Connecting a Remote Control Unit

When an RM-B170 Remote Control Unit, RCP-
1001/1501 Remote Control Panel, or other
control unit is connected, some functions can be
controlled from that unit.

Connecting a Remote Control Unit

Connect the camera connector of the control unit
to the REMOTE connector (8-pin) of the unit using
a remote control cable.

When you turn on the unit after making the
connection, the unit enters remote control

mode, enabling menu operations and shooting
operations.

[Notes]

e Do not connect or disconnect the remote control unit
when the unit is on.

e Aremote control cable is not supplied with the RCP-
1001/1501 Remote Control Panel.

Releasing Remote Control Mode

Turn off the unit, and disconnect the remote
control unit.

Setting the Paint Function

Technical > System Configuration > RM/RCP Paint
Control (page 68) must be set to On in the full
menu to enable the paint function.
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Main Functions Controllable using the RCP-1001/1501 or RM-B170/B750

Table legend

The following indicate remote control support on the display.

Yes: Control supported
—: Control not supported

Item

Sub-item

Sub-item

Selection option

RCP-1001

RCP-1501

RM-B170

RM-B750

Shooting

FPS

Fixed/Variable Select

On/Off

Yes

Yes !

Yes

FPS Select

1FPS to 110FPS

Yes

Yes"

Yes

Shutter Select?

Shutter ON/OFF

On/Off

Yes

Yes

Yes

ECS ON/OFF

On/Off

Yes

Yes

Yes

Shutter Speed

Values registered for Step.
The following values can be displayed.
1/32

1/33

1/48

1/50

1/60

1/96

1/100

1/120

1/125

1/250

1/500

1/1000

1/2000

1/3000

1/4000

1/5000

Yes

Yes

Yes

ECS Frequency

Yes

Yes

Yes

ND

ND Position

1: (CLEAR)

2:(0.3 density
3: (0.6 density
4: (0.9 density
5:(1.2 density
6: (1.5 density
7:(1.8 density
8: (2.1 density
9: (2.4 density

Yes

Yes

Yes

Yes
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Item Sub-item Sub-item Selection option RCP-1001 RCP-1501 RM-B170 RM-B750
White Balance? Color Temp 2000K to 15000K? - Yes - Yes
Color Temp Balance (Tint equivalent) -99 to +0 to +994 - Yes - Yes
R Gain -99 to £0 to +99 Yes Yes Yes Yes
B Gain -99 to £0 to +99 Yes Yes Yes Yes
Auto White Balance - Yes Yes Yes Yes
Paint? Switch Status Gamma On/Off - Yes Yes" Yes
Black Gamma® On/Off - Yes Yes" Yes
Flare On/Off - Yes Yes" Yes
Black Master Black -99 to +0 to +99 Yes Yes Yes Yes
R Black -99 to £0 to +99 Yes Yes Yes Yes
B Black -99 to £0 to +99 Yes Yes Yes Yes
Flare Setting On/Off - Yes Yes " Yes
Master Flare -99 to +0 to +99 - Yes Yes" -
R Flare -99 to +0 to +99 - Yes - Yes
G Flare -99 to £0 to +99 - Yes - Yes
B Flare -99 to £0 to +99 - Yes - Yes
Gamma Setting On/Off - Yes Yes" Yes
Black Gamma Setting On/Off - Yes Yes" Yes
Range Low/L.Mid/H.Mid - Yes - Yes
Master Black Gamma -99 to +0 to +99 - Yes Yes" Yes
Technical Test Signals Color Bars On/Off On/Off Yes Yes Yes Yes
Rec - - - - - Yes Yes
Play - - - - - Yes Yes
Stop - - - - - Yes Yes
F.Rev - - - - - Yes Yes
F.Fwd - - - - - Yes Yes
Rec Review - - - - - Yes Yes
Next - - - - - Yes -
Prev. - - - - - Yes -
Gain? Gain(Step) - —-6dB/-3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB Yes Yes Yes Yes
White Mode? Preset ON/OFF - On/Off - - Yes Yes
Iris Iris Level - (Control range of target lens) Yes Yes Yes Yes
Close - On/Off Yes Yes - Yes
Zoom?® Remote - On/Off - Yes " Yes" -
Speed - - - - - -
Tele to Wide - - - Yes" Yes" -
Zoom Value[%] - - - Yes " Yes?" -
Focal Length[mm] - - - Yes " Yes" -
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Item Sub-item Sub-item Selection option RCP-1001 RCP-1501 RM-B170 RM-B750
Focus® Remote - On/Off - Yes ! Yes ! -

Focus Position - - - Yes " Yes" -

Focus Value[%] - - - Yes " Yes" -

Focus Length[m] - - - Yes " Yes" -

o R R

Controllable when assigned to operation block of controller.
Controllable only when Technical > System Configuration > RM/RCP Paint Control (page 68) is set to On in the full menu.

Since Color Temp is clipped at 2000K and 15000K during R/B Gain operation, it may not be possible to display the correct Color Temp value for the R/B Gain value.

Since Color Temp Balance is clipped at £99, it may not be possible to display the correct Color Temp Balance value for the R/B Gain value.
Configurable only when Project > Basic Setting > Input Color Space (page 58) is set to Rec.2020/HLG_Rec.2100 in the menu.
The zoom and focus drive instructions from a remote control unit are disabled when an E mount lens is attached.
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Connecting External Monitors and Recording Devices

To display the recording/playback image on an
external monitor, select the output signal and
use an appropriate cable for the monitor to be
connected.

The output signal from the unit can be recorded
by connecting a recording device, such as a VTR.
The same status information and menus can be
displayed on the external monitor as those on
the viewfinder screen. Set the content to display,
according to the output signal for the monitor,
using the Monitoring menu (page 63).

[Note]

When FPS is set to Variable, horizontal image shift may occur

with 4K output only. This phenomenon may be noticeable
for faster frame rates (FPS). However, this does not affect the

recorded image, and the playback image is displayed correctly.

SDIOUT Connector (BNC Type)

Set the output format using the Monitoring menu
(page 63).

Use a commercially available 75-ohm coaxial cable
for connection.

[Note]

Check that the ground connection between the unit and
external device is securely grounded before turning the
power on. (We recommend turning on the unit and external
device after connecting a 75-ohm coaxial cable.)

When connecting an external device to the unit while the
unitis turned on, connect to the unit after connecting a 75-
ohm coaxial cable to the external device.

To start synchronized recording on an external
device

With SDI signal output selected, synchronized
recording is possible by feeding a REC

trigger signal to an external recording device
connected to the SDI OUT connector. Enable
synchronized recording by setting Technical >
System Configuration > SDI Rec Remote Trigger
(page 68) in the menu to HD SDI Remote I/F or
Parallel Rec.

[Note]
When a connected external device does not support a REC
trigger signal, the device cannot be operated.

MONITOR OUT Connector (BNC Type)

Outputs an HD SDI signal.

Set the output format using the Monitoring menu
(page 63).

Use a commercially available 75-ohm coaxial cable
for connection.

[Note]
Audio and timecode are not superimposed on this output.

HDMI OUT Connector (Type A
Connector)

Set the output format using the Monitoring menu
(page 63).

Use a commercially available HDMI cable for
connection.

If the output format has the same resolution as the
MONITOR OUT connector signal, the same video
signal is output.

12V 0UT Connector (DCOUT 12V,
Hirose 4-pin)

24V OUT Connector (DCOUT 24V,
Fischer 3-pin)

Supplies 12V DC power to an accessory when the
power switch is set to ON. You can output a REC
Tally signal and input a REC Trigger signal through
the 12V OUT connector.

Supplies 24V DC power to an accessory when the
power switch is set to ON. You can output a REC
Tally signal and input a REC Trigger signal through
the 24V OUT connector.

olo 50
©J6 ©)
No. Signal /0 Specification No. Signal Specification
1 UNREG GND - GND for UNREG 1 GND
2 REC TALLY OUT  Open-collector 2 24V-AUX 11Vto 17 Vinput
output Output voltage : 24 V
(Max. 50 mA) Maximum output current:
Low: REC 1.0A
3 RECTRIGGER IN  Openor+5VDC 22Vto 32 Vinput
Normal Output voltage: Same as
GND: Active (RECQ) the input voltage
4  UNREG+12V  OUT +11V1to17VDC Maximum output current:
ouT output 20A
11Vto 17 Vinput 3 R/S
Output voltage:
Same as the input
voltage

Maximum output
current: T.OA

22 Vto 32 Vinput
Output voltage : 15V
Maximum output
current: 0.8 A
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AUX Connector (LEMO 5-pin)

Outputs the timecode signal.

%
©]0)
No. Signal
1 Factory Use
2 NC
3 —
4 TCOUT
5 GND
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External Synchronization

When shooting with multiple units, synchronized
recording can be performed using a specific
reference signal to synchronize the timecode
among all the units.

Synchronizing the Phase of the Video
Signal (Genlock)

Genlock operation is enabled by supplying one of
the following reference signals to the GENLOCK IN
connector (page 11) of the unit.

® HDSDI 1.5G digital (Interlaced or PsF)

® HD Y analog

® SDVBS analog

Set the genlock input signal using Technical >
Genlock > Input Source (page 70) in the full
menu.

Valid input reference signals vary depending on
the project frame rate setting.

Project frame rate  Valid reference signal

23.98P 1920x1080 47.95i (23.98PsF)
24P 1920x1080 48i (24PsF)
25P 1920%1080 50i
720x576 50i
29.97P 19201080 59.94i
720x486 59.94i
47.952 1920x1080 47.95i (23.98PsF)
50i 1920%1080 50i
720x576 50i
50P 1920x1080 50i
720x576 50i
59.94i 19201080 59.94i
720x486 59.94i
59.94P 19201080 59.94i
720x486 59.94i

You can check the genlock status using Technical
> Genlock > Reference Lock Type (page 71) in
the menu.

[Notes]

o |f the reference signal is unstable, genlock is not possible.

® The subcarrier is not synchronized.

Synchronizing the Timecode with
Another Device

Set the unit that supplies the timecode to a mode
in which the timecode output keeps advancing
(Free Run mode).

1 Set TC/Media > Timecode > Mode (page 61)
in the menu to Preset F-Run (Ext-Lk).

2 Supply an HD or SD reference video signal to
the GENLOCK IN connector (page 11) and a
reference timecode synchronized with that
signal to the TC IN (page 11) connector.

The built-in timecode generator of your unit locks
to the reference timecode, and the message “Ext-
Lk" is displayed on the screen.

Once about ten seconds have elapsed after

the timecode locks, the external lock state is
maintained even if the external timecode source is
disconnected.

[Notes]

e Check that the reference timecode and the reference
video signal are in a phase relationship that complies with
the SMPTE timecode standards.

e When you finish the above procedure, the timecode is
immediately synchronized with the external timecode,
and the time data indication will show the value of the
external timecode. However, wait for a few seconds until
the timecode generator stabilizes before recording.

e |[fthe frequency of the reference video signal and the
frame frequency are not the same, lock cannot be
acquired, and the unit will not operate properly. If this
occurs, the timecode will not acquire successful lock with
the external timecode.

e \When the connection is removed, the timecode advance
may shift one frame per hour with respect to the
reference timecode.

To release external lock

Change the TC/Media > Timecode > Mode
(page 61) setting in the menu.
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7. Appendix

Usage Precautions

Read this section in conjunction with the
information provided in the supplied “Before Using
This Unit” document.

Use and Storage

Do not subject the unit to severe shock

The internal mechanism may be damaged or the
body warped.

Do not cover the unit while operating

Putting a cloth, for example, over the unit can
cause excessive internal heat build-up.

After use

Always set the power switch to OFF.

Before storing the unit for a long period

Remove the battery pack.

Do not leave the unit with the lens facing the sun

Direct sunlight can enter through the lens, be
focused in the unit, and cause fire.

Shipping

® Remove the memory cards before transporting
the unit.

e |f sending the unit by truck, ship, air or other
transportation service, pack it in the shipping
carton of the unit.

(are of the Unit

If the body of the unit is dirty, clean it with a soft,
dry cloth. In extreme cases, use a cloth moistened
in a little neutral detergent, then wipe dry.

Do not use organic solvents, such as alcohol or
thinners, as these may cause discoloration or other
damage to the finish of the unit.

Refrain from cleaning with high air pressure
equipment, such as an air duster, as these may
damage optical components.

In the event of operating problems

If you should experience problems with the unit,
contact your Sony dealer.

Periodic Replacement of Fan and
Battery

If usage exceeds the above normal usage
frequency, the life expectancy may be reduced
correspondingly.

Note about the Battery Terminal

The battery terminal of this unit (the connector for
battery packs and AC adaptors) is a consumable
part.

Power may not be supplied to the unit properly

if the pins of the battery terminal are bent or
deformed by shock or vibrations, or if they become
corroded due to prolonged outdoor use.

Periodic inspections are recommended to keep
the unit working properly and to prolong its
usable lifetime. Contact a Sony service or sales
representative for more information about
inspections.

The fan and battery are consumable parts that will
need periodic replacement.

When operating at room temperature, a

normal replacement cycle will be about 5 years.
However, this replacement cycle represents only
a general guideline and does not imply that the
life expectancy of these parts is guaranteed. For
details on parts replacement, contact your dealer.

Life Expectancy of the Electrolytic
Capacitor

The life expectancy of the electrolytic capacitor

is about 5 years under normal operating
temperatures and normal usage (8 hours per day;
25 days per month).

Use and Storage Locations

Store in a level, ventilated place.

Avoid using or storing the unit in the following

places.

® |n excessive heat or cold (operating temperature
range: 0 °C to 40 °C (32 °F to 104 °F))
Remember that in summer in warm climates
the temperature inside a car with the windows
closed can easily exceed 50 °C (122 °F).

® |n damp or dusty locations

® | ocations where the unit may be exposed to
rain

® | ocations subject to violent vibration

® Near strong magnetic fields

® (lose to radio or TV transmitters producing
strong electromagnetic fields.

® |n direct sunlight or close to heaters for
extended periods

To prevent electromagnetic interference from
portable communications devices

The use of portable telephones and other
communications devices near this unit can result
in malfunctions and interference with audio and
video signals.

It is recommended that the portable
communications devices near this unit be
powered off.

Note on laser beams

Laser beams may damage the CMOS image
sensor. If you shoot a scene that includes a laser
beam, be careful not to let the laser beam be
directed into the lens of the unit. Specifically, high-
power laser beams from medical devices or other
devices may cause damage due to reflected light
and scattered light.

About the Screens

® Do not leave the screens facing direct sunlight,
as this may damage the screens.

® Do not press/swipe the screens forcefully, or
leave objects on the screens, as it may cause a
malfunction, such as picture irregularity, etc.

® The screens may become warm in use. This is
not a malfunction.

LCD Panels

The LCD panel fitted to this unit is manufactured
with high precision technology, giving a
functioning pixel ratio of at least 99.99%. Thus a
very small proportion of pixels may be “stuck”,
either always off (black), always on (red, green, or
blue), or flashing. In addition, over a long period
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of use, because of the physical characteristics of
the liquid crystal display, such “stuck” pixels may
appear spontaneously.

These problems are not a malfunction.

Note that any such problems have no effect on

recorded data.

OLED Panels

The OLED panel fitted to this unit is manufactured
with high precision technology, giving a
functioning pixel ratio of at least 99.99%. Thus a
very small proportion of pixels may be “stuck’,
either always off (black), always on, or flashing.

In addition, over a long period of use, because

of the physical characteristics of the organic
light-emitting diode, such “stuck” pixels may
appear spontaneously. These problems are not a
malfunction. Note that any such problems have no
effect on recorded data.

Due to the characteristics of the material used in
the OLED panel, permanent burn-in or reduction
in brightness may occur.

These problems are not a malfunction.

On Condensation

If the unit is suddenly taken from a cold to a warm
location, or if ambient temperature suddenly

rises, moisture may form on the outer surface of
the unit and/or inside of the unit. This is known

as condensation. If condensation occurs, turn off
the unit and wait until the condensation clears
before operating the unit. Operating the unit while
condensation is present may damage the unit.

Phenomena Specific to CMOS Image
Sensors

The following phenomena that may appear in
images are specific to CMOS (Complementary
Metal Oxide Semiconductor) image sensors. They
do not indicate malfunctions.

White flecks

Although the CMOS image sensors are produced

with high-precision technologies, fine white

flecks may be generated on the screen in rare

cases, caused by cosmic rays, etc. This is related

to the principle of image sensors and is not a

malfunction.

The white flecks especially tend to be seen in the

following cases.

® \When operating at high environmental
temperatures

Aliasing

When fine patterns, stripes, or lines are shot, they
may appear jagged or flicker.

Focal plane

Owing to the characteristics of the pickup
elements (CMOS sensors) for reading video signals,
subjects that quickly move across the screen may
appear slightly skewed.

Flashbanding

The luminance at the top and bottom of the
screen may change when shooting a flashlight
beam or a light source that quickly flashes.

Flicker

If recording is made under lighting produced

by discharge tubes, such as fluorescent, sodium,
or mercury-vapor lamps, the screen may flicker,
colors may vary, or horizontal stripes may appear
distorted.

Notes on the Display

® Pictures on the viewfinder screen may be

distorted by the following operations.
- Changing the video format

® \When you change the line of sight in the
viewfinder, you may see primary colors red,
green, and blue, but this is not a defect of the
unit. These primary colors are not recorded on
any recording media.

Fragmentation

If pictures cannot be recorded/reproduced
properly, try formatting the recording medium.
While repeating picture recording/playback with
a certain recording media for an extended period,
files in the media may be fragmented, disabling
proper recording/storage. In such a case, make

a backup of clips in the media then perform
formatting of the media using TC/Media > Format
Media (page 62) in the menu.

Output Voltages of the Unit

The total output power that can be supplied to
peripheral devices from the unit varies depending
on the input voltage to the unit and the state of
the connected accessories. The maximum output
capacity ratings of the following connectors

that can supply power may not be achieved
depending on the conditions.

LENS connector: 1 A max.

12V OUT connector (4-pin):
0.8 A max. (Input voltage: 22 Vto 32 V)
1 Amax. (Input voltage: 11 Vto 17 V)

24V OUT connector (3-pin):
2 A max. (Input voltage: 22 Vto 32 V)
1 Amax. (Input voltage: 11 Vto 17 V)

The power delivery rating available for accessories
(AXS-R7, DVF-EL200, and CBK-3610XS) and
peripheral devices is limited depending on the
input voltage to the unit.

Voltage of power supply to the unit: X [V]

Total power rating of peripheral devices: Y [W]

Power consumption of the unit: Approx. 60 W

@ Power consumption of the AXS-R7: Approx.
24 W

@ Power consumption of the DVF-EL200:
Approx. 2.5 W

® Power consumption of the CBK-3610XS:
Approx. 3.9 W

Y [W] =X [V] x 9.0 [A]" - (60 + @ + @ + @)z) W]

When supplying power to the above attached
accessories and peripheral devices, make sure that
the value Y given by the equation above does not
become negative.



095

7. Appendix: Usage Precautions

(Note that the equation does not apply if the
calculated result Y exceeds the sum of the
maximum allowable output power of each power

output connector.)

V6.0 [A]l when using the AC-DN10A.

2 When using an AC-DN10A, do not use units @) and @) at
the same time. Depending on the usage environment, the
power supply rating may be exceeded.

Notes on Security

e SONY WILL NOT BE LIABLE FOR DAMAGES OF
ANY KIND RESULTING FROM A FAILURE TO
IMPLEMENT PROPER SECURITY MEASURES
ON TRANSMISSION DEVICES, UNAVOIDABLE
DATA LEAKS RESULTING FROM TRANSMISSION
SPECIFICATIONS, OR SECURITY PROBLEMS OF
ANY KIND.

® Depending on the operating environment,
unauthorized third parties on the network may
be able to access the unit. When connecting the
unit to the network, be sure to confirm that the
network is protected securely.

® From a safety standpoint, when using the unit
connected with the network, it is strongly
recommended to access the Control window
via a Web browser and change the access
limitation settings from the factory preset values
(page 69).

Changing the password regularly is also
recommended.

® Do not browse any other website in the Web
browser while making settings or after making
settings. Since the login status remains in the
Web browser, close the Web browser when you
complete the settings to prevent unauthorized
third parties from using the unit or harmful
programs from running.
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Recording Formats and Output Signals

SDIOUT Connector Output Formats

The serial digital signal from an SDI OUT connector is output according to the Project category and Monitoring category settings in the menu.
For details about Project category settings combinations, see “Recording Format Settings” (page 48).

Default values are shown underlined and in bold text.

Project Monitoring > Output Format Output format
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI'1 SDI 2 SDI 3 SDI 4
59.94/50 6K 3:2/ XAVC-1 4K Class300/ 4096x2160P 12G - 4096x2160P YPbPr 12G | 4096x2160P YPbPr 12G No output No output
4K2.39:17/ Rec Off 4096x2160P Square  4096x2160P Square
4K 4:3/ Level B Level B 4096x2160P YPbPr 3G Level B-DL
4K 17:9
gO96><2160P 2SI Level 481096><21 60P 2SI Level 4096x2160P YPbPr 3G Level B-DL
1920x1080P 1920x1080P
2048x1080P 1920x1080P Level B 2048x1080P 2048x1080P YPOPr 3G Level B YPbPr 3G Level B
- YPbPr 3G Level B-DL YPbPr 3G Level B-DL - -
1920%1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
1920x1080P 1920x1080P
19201080 Levelp | 20X1080P LevelB 1920x1080P 1920x1080P YPbPr 3G Level B YPbPr 3G Level B
- YPbPr 3G Level B-DL YPbPr 3G Level B-DL - -
1920%1080i 1920x1080i YPbPr 1.5G 1920x1080i YPLPr 1.5G
1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G | 1920%1080i YPbPr 1.5G | 1920x1080i YPbPr 1.5G 1920%x1080i YPbPr 1.5G
38K 16:9 XAVC-l QFHD Class300/ 3840x2160P 12G - 3840x2160P YPbPr 12G | 3840x2160P YPbPr 12G No output No output
Rec Off
3840x2160P Square 3840x2160P Square 3840%2160P YPbPr 3G Level B-DL
Level B Level B
3840><2160P 2SI Level §S40><2W 60P 2SI Level 384052160P YPbPI 3G Level B-DL
1920x1080P 1920%1080P
1920%1080P Level B 1920x1080P 1920%1080P
YPbPr 3G Level B YPbPr 3G Level B
1920x1080P Level B : YPbPr 3G Level B-DL YPbPr 3G Level B-DL o0 eve 29 eve
1920x1080i 1920x1080i YPbPr 1.5G 1920%1080i YPbPr 1.5G
1920x1080i 1920%1080i 1920%1080i YPbPr 1.5G | 1920x1080i YPbPr1.5G | 1920x1080i YPbPr 1.5G 1920%1080i YPbPr 1.5G
6K 3:2/ ProRes 422 HQ HD P/ 1920x1080P 1920x1080P
4K 43/ ProRes 422 HD P/ 1020x1080P Level p | 20X 1080P Level B 1920x1080P 1920x1080P YPOPr 3G Level B YPbPr 3G Level B
, - YPbPr 3G Level B-DL YPbPr 3G Level B-DL . .
4K17:9/ ProRes 422 Proxy HD P 1920x1080i 1920%1080i YPbPr 1.5G 1920%1080i YPbPr 1.5G
38K16:9 MPEG 1920x1080i/ProRes
422HQHD i/ A A . . i )
1920%1080i 1920%1080i 1920%1080i YPbPr 1.5G | 1920x1080i YPbPr 1.5G | 1920x1080i YPbPr 1.5G 1920%1080i YPbPr 1.5G

ProRes 422 HD i/
ProRes 422 Proxy HD i
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Project Monitoring > Output Format Output format
Project Frame Rate Imager Mode  AXS Rec Format SDI1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
47.95 4K 4:3/4K17:9 RAW SQ/ 4096x2160P Square 4096x2160P Square
%-OCN XT/ Lovel B Lovel B 4096x2160P YPbPr 3G Level B
X-OCN ST/ 4096x2160P 25| Level ~ 4096x2160P 2SI Level
X-OCN LT/ B B 4096x2160P YPbPr 3G Level B
Rec Off 2048x1080P Level B 1920x1080P 2048%1080P YPbPr 3G Level B 1920x1080P YPbPr 1.5G
1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P YPbPr 1.5G
Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
29.97/25 6K 1.85:1/ XAVC-1 4K Class480/ 4096x2160P 6G - 4096x2160P YPbPr6G | 4096x2160P YPbPr 6G No output No output
6K239:1/ XAVC-| 4K Class300/ 4096x2160P 28| - 4096x2160P YPbPr 3G Level B-DS No output No output
ZE ?722 ) Rec Off 4096x2160P Square  4096x2160P Square 4096x2160P YPBPr 1.5G
- 1920x1080P 1920x1080P
. 1920x1080P
>/K 169/ 2048x1080PsF 2048x1080PsF YPbPr 1.5G YPbPr 1.5G
4K 2.39:1V/ 2048x1080PsF
. YPbPr 1.5G YPbPr 1.5G 1920x1080PsF 1920x1080PsF
4K 4:3/ 1920x1080PsF
4K 65/ YPbPr 1.5G YPbPr 1.5G
4K 179 1920x1080P 1920x1080P 1920x1080P 1920x1080P
1920x1080P 1920x1080P YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF
1220x1080PsF 1920x1080PsF YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
3.8K16:9 XAVC-I QFHD Class480/  3840x2160P 6G - 3840x2160P YPbPr 6G 3840x2160P YPbPr 6G No output No output
é:cvgf_'f QFHD Class300/ ~3g40,7160p 25 _ 3840x2160P YPbPr 3G Level B-DS No output No output
3840x2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G
1920x1080P 1920x1080P 1920x1080P 1920x1080P
1920x1080P 1920x1080P YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF
1920x1080PsF 1920x1080PsF YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
6K 1.85:1/ MPEG 1920x1080P/
6K 2.39:1/ ProRes 422 HQ HD P/
1920x1080P 1920x1080P 1920x1080P 1920x1080P
6K 3:2/ ProRes 422 HD P/ 1920x1080P 1920x1080P YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
6K 17:9/ ProRes 422 Proxy HD P
57K 16:9/
4K 4:3/
4K 6:5/ 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF
4K 179/ 1220x1080PsF 1920x1080PsF YPBPr 15G YPBPr 15G YPbPr 1.5G YPbPr 1.5G

3.8K16:9
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Project Monitoring > Output Format Output format
Project Frame Rate Imager Mode SxS Rec Format SDI1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
24 6K 1.85:1/ XAVC-1 4K Class480/ 4096x2160P 6G - 4096x2160P YPbPr 6G 4096x2160P YPbPr 6G No output No output
6K239:1/ XAVC-1 4K Class300/ 4096x2160P 2SI - 4096x2160P YPbPr 3G Level B-DS No output No output
ZE ?722 y Rec Off 4096x2160P Square  4096x2160P Square 4096x2160P YPBPr 1.5G
' 2048x1080PsF 2048x1080PsF 1920x1080P 1920x1080P
o o v 2048x1080P 1920x1080P YPBPr 1.5G YPbPr 1.5G YPbPr 1.5G YPBPr 1.5G
1920x1080P 1920x1080P
ji ?;g 192010807 YPbPr 1.5G YPbPr 1.5G 1920x1080P 1920x1080P
: 1920x1080P
1920%1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G YPbPr 1.5G
YPbPr 1.5G YPbPr 1.5G
ProRes 422 HQ HD P/ 1920%1080P 1920x1080P 1920x1080P
ProRes 422 HD P/ 1990%1080P YPbPr 1.5G YPbPr 1.5G 1920x1080P 1920x1080P
ProRes 422 Proxy HD P 192051 030P<F 1920x1080PsF 1920%1080PsF YPbPr1.5G YPbPr1.5G
YPbPr1.5G YPbPr 1.5G
3.8K 169 Rec Off 3840x2160P 6G — 3840x2160P YPbPr 6G 3840x2160P YPbPr 6G No output No output
3840%2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G
3840x2160P 3840x2160P
3840x2160P 2SI - VPbPr 3G Level-B VPbPr 3G Level-B No output No output
1920x1080P 1920%x1080P YPbPr 1.5G | 1920x1080P YPbPr 1.5G
1920x1080PsE 1920x1080P 1920x1080PsF 1920x1080PsF 1920x1080P YPbPr 1.5G 1920x1080P YPbPr 1.5G
YPbPr 1.5G YPbPr 1.5G
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Project Monitoring > Output Format Output format
Project Frame Rate Imager Mode SxS Rec Format SDI1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
23.98 6K 1.85:1/ XAVC-1 4K Class480/ 4096x2160P 6G - 4096x2160P YPbPr 6G 4096x2160P YPbPr 6G No output No output
6K239:1/ XAVC-1 4K Class300/ 4096x2160P 2SI - 4096x2160P YPbPr 3G Level B-DS No output No output
6K 3:2/ Rec Off 4096x2160P Square  4096x2160P Square 4096x2160P YPBPr 1.5G
Ny oA 080P ) 20481080PSF 2048 1080PSF 1920x1080P 1920x1080P
4'K 5 39:} oy YPbPr 1.5G YPbPr1.5G YPbPr1.5G YPbPr 1.5G
o 1920x1080P 1920x1080P
4K 4:3/ 1920x1080P
) YPbPr1.5G YPbPr1.5G 1920x1080P 1920x1080P
4K 6:5/ 1920x1080P
4K 17:9 1920%1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G YPbPr 1.5G
YPbPr 1.5G YPbPr 1.5G
3.8K16:9 XAVC-1 QFHD Class480/  3840x2160P 6G - 3840x2160P YPbPr 6G 3840x2160P YPbPr 6G No output No output
;(Avé:f QFHD Class300/ “3g40,5160p 25 - 3840x2160P YPbPr 3G Level B-DS No output No output
ecC
3840%2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G
1920x1080P 1920x1080P
1920x1080P
YPbPr 1.5G YPbPr1.5G 1920x1080P 1920x1080P
1920x1080P
1920%1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G YPbPr 1.5G
YPbPr 1.5G YPbPr 1.5G
6K 1.85:1/ MPEG 1920x1080P/
SE ?-722/ iroies fé; ;‘D P/HD . YPbPr 1.5G YPbPr 1.5G
oK 165/ fORes fec rroxy 102010808 1920x1080P 1920%1080P
4K 43/ YPbPr 1.5G YPbPr 1.5G
4K 6:5/ 1920x1080PsF 1920x1080PsF
4K17:9/ 1920xT080Ps YPbPr 1.5G YPbPr 1.5G
3.8K16:9

U SxS Rec Format is set to Rec Off when Imager Mode is set to 4K 2.39:1.
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MONITOR OUT Connector/HDMI OUT Connector Output Formats

The digital signal from the MONITOR OUT and HDMI OUT connectors is output according to the Project category and Monitoring category settings in the menu.

For details about Project category settings combinations, see “Recording Format Settings” (page 48).

Default values are shown underlined and in bold text.

Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
59.94/50 6K 3:2/ XAVC-I 4K Class300/ 4096x2160P 4096x2160P
K239/ Rec Off 1920x1080P Level A —————— 1920x1080P YPbPr3G Level A |————
4K 2.39: ec 1920x1080P 1920%1080P
4K 43/ 4096x2160P 12G -
) 4096x2160P ) 4096x2160P
4K17:9 1920x%1080i ———————11920%1080i YPbPr 1.5G NP E—
1920%1080i 1920x1080i
4096x2160P 4096x2160P
1920x1080P Level A ——————— 1920x1080P YPbPr3G Level A ——————
1920x1080P 1920x1080P
4096x2160P 2SI 4096x2160P 2SI
) 4096x2160P ) 4096x2160P
1920x1080i ————————— 1920x1080i YPbPr 1.5G I —
1920x1080i 1920x1080i
1920x1080P Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P
4096x2160P Square 4096x2160P Square - - - -
1920x1080i 1920%1080i 1920%1080i YPbPr 1.5G 1920x1080i
2048x1080P 1920%x1080P Level B 1920x1080P Level A 1920x1080P 1920%1080P YPbPr 3G Level A 1920x1080P
1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920x1080P 1920x1080P Level B 1920x1080P Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P
1920x1080i 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
38K 16:9 XAVC-1 QFHD Class300 3840x2160P 3840x2160P
Q 23300/ 1920%1080P Level A ———— = 11920x1080P YPbPr 3G Level A o
Rec Off 1920x1080P 1920x1080P
3840%2160P 12G -
, 3840%2160P A 3840%x2160P
1920x1080i ———————————11920%1080i YPbPr 1.5G —_—
1920x1080i 1920x1080i
3840%2160P 3840x2160P
1920x1080P Level A ———————1920x1080P YPbPr 3G Level A
1920x1080P 1920x1080P
3840%2160P 25| 3840x2160P 2SI
‘ 3840%2160P A 3840%x2160P
1920x1080i —————————1920x1080i YPbPr 1.5G e
1920x1080i 1920x1080i
1920x1080P Level A 1920x1080P 1920x1080P YPbPr 3G Level A | 1920x1080P
3840x2160P Square 3840x2160P Square - - - -
1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920510807 1920x1080P Level B 1920x1080P Level A 1920x1080P 1920%1080P YPbPr 3G Level A | 1920x1080P
1920x1080i 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
6K 3.2/ ProRes 422 HQ HD P/ 1920x1080P Level B 1920x1080P Level A 1920x1080P 1920x1080P YPbPr 3G Level A | 1920x1080P
4K 2.39:1/ ProRes 422 HD P/ 1920x1080P
4K 4:3/ ProRes 422 Proxy HD P 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
4K ]7:9'/ ProRes 422 HQ HD i/
38K16:9 ProRes 422 HD i/ 1920x1080i 1920x1080i 1920%1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
ProRes 422 Proxy HD i
MPEG 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 720x480P 1 No output 720x480P
720X576P 1 No output 720x576P
Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode AXS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
4795 4K 4:3/4K 179 RAW SQ/ 4096x2160P Square Level B 4096x2160P Square Level B 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
X-OCN XT/ 4096x2160P 25| Level B 4096x2160P 25| Level B
X-OCN ST/ 2048x1080P 1920x1080P
X-OCN LT/ 1920x1080P 1920x1080P

Rec Off
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
29.97/25 6K 1.85:1/ XAVC-I 4K Class480/ 19205 1080P 4096x2160P 1920%1080P YPbPr 1.5G 4096x2160P
6K 2.39:1/ XAVC-| 4K Class300/ 09652160 6G x 1920x1080P x r 1920x1080P
. 4 X -
6K 32/ Rec Off 4096x2160P 4096x2160P
6K 17:9/ 1920x1080PsF ————=———11920%1080PsF YPbPr 1.5G —_——
57K 16:9/ 1920x1080PsF 1920x1080PsF
' i 4096x2160P 4096x2160P
4K2.39:1/ 1920x1080P ———————————11920%1080P YPbPr 1.5G —
4K 43) 1920x1080P 1920x1080P
: 40962160 251 B 4096x2160P 4096x2160P
K65/ 1920x1080PsF ————— 1 1920x1080PsF YPbPr 1.5G N —
4K 17:9 1920x1080PsF 1920x1080PsF
1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
4096x2160P Square 4096x2160P Square
1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF
2048x1080PSF 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
> 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF
1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920%1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF
3.8K16:9 XAVC-I QFHD Class480/ 1920%1080P 3840x2160P 1920 1080P YPbPr 15G 3840x2160P
XAVC-I QFHD Class300/ 1920x1080P ’ 1920x1080P
Rec Off 3840%2160P 6G -
3840x2160P 3840x2160P
1920x1080PsF —————— 1 1920x1080PsF YPbPr 1.5G T —
1920x1080PsF 1920x1080PsF
3840x2160P 3840x2160P
1920x1080P ———————1 1920x1080P YPbPr 1.5G U —
1920x1080P 1920x1080P
3840%2160P 2SI -
3840%x2160P 3840x2160P
1920x1080PsF — 1 1920x1080PsF YPbPr 1.5G N —
1920x1080PsF 1920x1080PsF
1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
3840x2160P Square 3840x2160P Square
1920x1080PsF 1920x1080PsF 1920%1080PsF YPbPr 1.5G 1920x1080PsF
1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF
6K 1.85:1/ MPEG 1920x1080P/
6K 2.39:1/ ProRes 422 HQ HD P/
6K 3:2/ ProRes 422 HD P/ 1920%1080P 1920x1080P 1920%1080P 1920x1080P 1920%1080P YPbPr 1.5G 1920%1080P
6K 17:9/ ProRes 422 Proxy HD P
5.7K16:9/
4K 2.39:1/
4K 4:3/
4K 6:5/ 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF
4K 17:9/

3.8K16:9
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
24 6K 1.85:1/ XAVC-I 4K Class480/ 4096x2160P 4096x2160P
6K 2.39:1/ XAVC-1 4K Class300/ 4096x2160P 6G - 1920x1080P iﬁﬁﬁ;ﬁfﬁﬁ;““*1920X1OSOPYPbPrLSG 7256;iiiﬁ;444*
6K 32/ Rec Off 4096x2160P 4096x2160P
6K 17:9/ 4096x2160P 25| - 1920%1080P ————————1920x1080P YPbPr 1.5G ——
4K 2391/ 1920x1080P 1920x1080P
4K4é/' 4096x2160P Square 4096x2160P Square 1920x1080P 1920x1080P 1920%x1080P YPbPr 1.5G 1920x1080P
4K 65/ 2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
- 1920x1 p
AKT7:9 920x1080 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF
ProRes 422 HQ HD P/ 1920x1080P
ProRes 422 HD P/ 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
ProRes 422 Proxy HD P 1920x1080PsF
3.8K16:9 Rec Off 3840%x2160P 3840%x2160P
£c 3840x2160P 6G - 1920%x1080P ——— 1 1920x1080PsF YPbPr 1.5G P —
1920x1080P 1920x1080PsF
3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
3840x2160P 3840x2160P
3840x2160P 2SI - 1920x1080P — 1 1920x1080P YPbPr 1.5G S —
1920x1080P 1920x1080P
1920x1080P
1920x1080P 1920x1080PsF 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

1920x1080PsF
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
23.98 6K 1.85:1/ XAVC-I 4K Class480/ 4096521 60P 6G 1920%1080P 4096x2160P 192051080P YPbPr 1.5G 4096x2160P
6K 2.39:1/ XAVC- 4K Class300/ x - x 1920x1080P x o 1920x1080P
6K 32/ Rec Off 4096x2160P 4096x2160P
6K 17:9/ 4096x2160P 25| - 1920x1080P ————=————11920%1080P YPbPr 1.5G —_——
iy 1920x1080P 1920%x1080P
4k 5 39:1/ 4096x2160P Square 4096x2160P Square 1920x1080P 1920x1080P 1920%x1080P YPbPr 1.5G 1920x1080P
4K 43/ 2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
. 1920x1080P
K65/ X 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
4K 17:9 1920x1080PsF
3.8K16:9 XAVC-I QFHD Class480/ 3840%2160P 6G 1920%1080P 3840x2160P 19201080 YPBPr 155G 3840x2160P
XAVC-1 QFHD Class300/ 1920x1080P ’ 1920x1080P
Rec Off
3840%x2160P 3840%x2160P
3840%x2160P 2SI - 1920x1080P — 1 1920x1080P YPbPr 1.5G S —
1920x1080P 1920x1080P
3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920%1080P YPbPr 1.5G 1920x1080P
1920x1080P
1920x1080P 1920x1080P 1920x1080P 1920%x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF
6K 1.85:1/ MPEG 1920x1080P/
6K 2.39:1/ ProRes 422 HQ HD P/
6K 3:2/ ProRes 422 HD P/ 1920x1080P
6K 17:9/ ProRes 422 Proxy HD P
5.7K16:9/
4K 239:1/ 1920x1080P 1920x1080P 1920x1080P 1920%x1080P YPbPr 1.5G 1920x1080P
4K 4:3/
4K 6:5/ 1920x1080PsF
4K 17:9/
3.8K16:9

U When AXS Rec Format is set to Rec Off, this output is selected when Technical > System Configuration > SD HDMI is set to On in the menu.

2 When Project Frame Rate is 59.94.
3 When Project Frame Rate is 50.0.
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Error/Warning Indications

If a warning, caution, or operating condition that requires confirmation occurs on the unit, a message is
displayed on the sub display, the REC lamp starts flashing, and a warning sound is emitted.
The buzzer is output to the built-in speaker or to the headphones connected via the headphone

connector.

When the unit is turned on, a message appears on the sub display screen prompting you to execute APR
if the auto adjustment for the image sensor (APR) has not been performed for a certain period of time. In
this case, follow the on-screen instructions to execute APR (page 70).

Error Display

The unit will stop operation when the following kind of display occurs.

Error display Buzzer

indication

REC lamp

Cause and Solution

E + Error code Intermittent  High-speed

flashing

The unit may be defective. Recording stops even if
@REC is displayed on the viewfinder/monitor screen.
Turn off the power and check the connected
equipment, cables, and media. If the error persists
when the unit is turned on again, contact your Sony
service representative. (If power cannot be turned off
by setting the power switch to OFF, remove the
battery pack or the DC IN source.)

Warning Display

When one of the following messages occurs, use the following table to resolve the problem.

Warning display Buzzer REC lamp Cause and Solution
indication
Media Full " Continuous  High-speed Clips could not be recorded, copied, or split because
flashing there is no remaining capacity on the SxS memory
card.
Replace immediately.
Battery End " Continuous  High-speed The battery pack is dead. Recording is disabled.
flashing Stop operation and recharge the battery pack.

Temperature High” Intermittent  Flashing

The internal temperature is high.
Turn off the unit and allow it to cool down before
operating it again.

Warning display Buzzer REC lamp Cause and Solution
indication
Insufficient Voltage " Continuous  High-speed The DCIN voltage is too low. Recording is disabled.
flashing Connect another power source.
EXT. I/F Signal Error Intermittent  High-speed An error was detected with the signal on the
flashing mounting terminal for an expansion unit.
Check the connection to the AXS-R7 or other device.
AXS Firmware Continuous  High-speed The AXS-R7 cannot be operated correctly.
Mismatch flashing Update the firmware version of the AXS-R7.
AXS Recorder Temp. Intermittent  High-speed The internal temperature of the AXS-R7 is high.
High" flashing Turn off the unit and allow it to cool down before

operating it again.

Lens Signal Error - -

An error was detected with the signal on the
mounting terminal for an expansion unit.
Check the connection to the lens or other device.

) Message is not displayed on the monitor screen.

About temperature warnings

The Temperature High and AXS Recorder Temp High warnings may be displayed when operating
within the guaranteed operating temperature of the unit, depending on the operating mode and
usage environment. Recording does not immediately stop when these messages are displayed, but the
suggestions given in the Cause and Solution column of the table should be implemented promptly.

Caution and Operation Confirmation Display

The following caution and operation confirmation messages may appear on the monitor screen or sub
display, and warning icons may be displayed and messages displayed in the Info category > Camera
Condition in the menu. Follow the instructions provided to resolve the issue.

Display indication

Cause and Solution

Battery Error
Please Change Battery

An error was detected in the battery pack.
Replace with a normal battery pack.

Backup Battery End
Please Change

The remaining capacity of the backup battery is
insufficient.
Replace the backup battery.

Cannot Use SxS(A)*
Please Change

A memory card that has been partitioned or a
memory card containing more clips that can be
handled by the unit was inserted.

The card cannot be used in the unit, and must be
replaced.
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Display indication

Cause and Solution

Cannot Use SxS(A)*
Unsupported File System

A card using a different file system or an unformatted
card was inserted.

The card cannot be used in the unit, and must be
replaced or formatted using the unit.

Media Error
SxS(A)* Needs to be Restored

An error occurred with the memory card. The card
requires restoration.
Restore the card.

SxS(A)* Error
Recording Stopped
Playback Stopped

Recording or playback stopped because an error
occurred on the memory card.
If the problem persists, replace the memory card.

Input AES/EBU is Invalid Emphasis

Emphasis signal that is not compatible with the AES/
EBU input was input.
The unit is compatible with 50u-15u Emphasis only.

Input AES/EBU is not Pro Use

A signal other than Professional Use was input to the
AES/EBU input.
The unit is compatible with Professional Use only.

Fan Stopped

The fan in the unit has stopped.
Avoid use under high temperature conditions. Turn
the unit off and contact a Sony service representative.

AXS Recorder Fan Stopped

The fan in the AXS-R7 that is connected to the unit
has stopped.

Avoid use under high temperature conditions.
Remove the AXS-R7 from the unit and contact a Sony
service representative.

Unsupported FPS
Change AXS(A) to AXS S48 Memory

Unsupported AXS memory was detected.

Recording cannot be performed. Change the
recording format for the AXS memory card, or change
the card to an AXS-A512548 or AXS-A1TS48.

Abnormal Lens Communication
Please Check “Lens IF” Setting

The type of the connected lens does not match the
unit’s setting.

Check the Technical > Lens Configuration > PL-Mt
Interface Position setting in the full menu.

Please Execute APR

The auto adjusting of the image sensor (APR) has not
been executed for a certain period.
Execute APR by pressing the MENU dial.

XXXX License Y days Remaining
(XXXX: Type of license, Y: Number of days remaining)

There are 2 days remaining before the license for the
software option will expire.

Lens I/F Error

A fault was detected in the lens I/F communication
when an E-mount lens is attached.
Check the connection to the E-mount lens.

* "SxS(B)" is displayed for the SxS memory card in slot B, “AXS(A)" is displayed for the AXS memory card in slot A of the AXS-R7,
and "AXS(B)" is displayed for the AXS memory card in slot B of the AXS-R7.
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ltems Saved in Files

Table legend
Yes: Saved
No: Not saved

- Not saved (temporary setting)

Shooting Menu

Iltem Sub-item

File type

All

Look File Load User 3D LUT

Reset User 3D LUT

Reset All User 3D LUTs

Load ASC CDL

Reset ASC CDL

Reset All ASC CDLs

! Selection options added or edited by a user are also saved.

Item Sub-item File type
All
FPS Fixed/Variable Select Yes
FPS Select Yes
Shutter " Shutter Select Yes
Step/Cont. Select Yes
Add/Change Step Yes
Delete Step Yes
ND ND Position Yes
Exposure Index El Select Yes
White Balance” Color Temp. Select Yes
Add/Change Step Yes
Delete Step Yes
Auto White Balance -
LUT Select SDI1/2 Yes
SDI 3/4 Yes
Monitor Yes
HDMI Yes
VF LUT Yes
SxS Rec Yes
Sub Rec Yes
Look Category Yes
Preset Look Select Yes
User 3D LUT Select Yes
ASC CDL Process Yes
ASC CDL Select Yes

ASC CDL Information
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Project Menu TC/Media Menu
Item Sub-item File type Item Sub-item File type
All All

Basic Setting Imager Mode Yes Timecode Mode Yes
Project Frame Rate Yes Manual Setting -
Input Color Space Yes Reset -
AXS Rec Format Yes TC Format Yes
SxS Rec Format Yes TC Source -
Sub Rec Format Yes Time Data Display Yes
Base ISO Yes Clip Name Format Camera ID Yes
SxS/Output De-Squeeze No Reel Number Yes

Special Recording Cache Rec Select Yes Camera Position Yes
Max Cache Rec Duration Yes SXS Root Folder Name Yes

Assignable Button <1> Yes Format Media AXS Slot A -
<2> Yes AXS Slot B -
<3> Yes SxS Slot A -
<4> Yes SxS Slot B -
<VF A> Yes SD Card -
<VF B> ves Update Media AXS Slot A -
<VFC> Yes AXS Slot B -
<User 1> Yes SXS Slot A -
<User 2> Yes SxS Slot B -
<User 3> Yes
<User 4> Yes
<User 5> Yes

All File Load SD Card -
Save SD Card -
File ID Yes

Format SD Card
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Monitoring Menu
Item Sub-item File type
All
Output Format SDI'1/2 Yes
SDI 3/4 Yes
Monitor Yes
HDMI Yes
OSD Appearance VF Yes
SDI Yes
SDI1/2
SDI 3/4
Monitor Yes
HDMI -
Status Info A/B Setup Yes
Frame Line A/B Setup Yes
Monitor Display Focus Distance Format Yes
Frame Line Center Marker Yes
Aspect Ratio Yes
Aspect Safety Zone Yes
Safety Zone Yes
Color Yes
Surround View Type Yes
Aspect Ratio Type Yes
Mask Level Yes
Frame Line on Playback Yes
User Frame Line Width Yes
Height Yes
H Position Yes
V Position Yes

Item Sub-item File type
All
False Color Level Yes
Red Yes
Red Upper Limit Yes
Red Lower Limit Yes
Yellow Yes
Yellow Upper Limit Yes
Yellow Lower Limit Yes
Orange Yes
Orange Upper Limit Yes
Orange Lower Limit Yes
Pink Yes
Pink Upper Limit Yes
Pink Lower Limit Yes
Light Pink Yes
Light Pink Upper Limit Yes
Light Pink Lower Limit Yes
Cyan Yes
Cyan Upper Limit Yes
Cyan Lower Limit Yes
Green Yes
Green Upper Limit Yes
Green Lower Limit Yes
Light Blue Yes
Light Blue Upper Limit Yes
Light Blue Lower Limit Yes
Blue Yes
Blue Upper Limit Yes
Blue Lower Limit Yes
Purple Yes
Purple Upper Limit Yes
Purple Lower Limit Yes
Reset -
VF Display VF LUT Yes
Status Info Yes
Frame Line Yes
VF Magnifier Ratio Yes
Color Yes
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Item Sub-item File type :
A Audio Menu
VF Function Double Speed Scan Yes

Peaking Frequency Yes Item Sub-item File type

Zebra Yes All

Zebra Select Yes Audio Input CH-1 Audio Select Yes

Zebral Level Yes CH-2 Audio Select Yes

Zebral Aperture Level Yes CH-1 Audio Level Yes

Zebra2 Level Yes CH-2 Audio Level Yes

Assign<VF A> Yes MIC Reference Yes

Assign<VF B> Yes Audio Monitor Monitor CH Yes

Assign<VF C> Yes Monitor Level Yes

Audio Configuration Alarm Level Yes

Input Limiter Mode Yes

AGC Level Yes

AGC Mono/Stereo Yes

MIC Input Mono/Stereo Yes

Phantom Power +48V Yes

Monitor Output CH Pair Yes

Headphone Mono/ST Yes
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TeCtha| MenU Item Sub-item :illle type
DC Voltage Alarm DC Low Voltagel Yes
ltem Sub-item File type DC Low Voltage2 Yes
All DC(24V) Low Voltage1 Yes
Test Signals Color Bars Yes DC(24V) Low Voltage2 Yes
Color Bars Type Yes Control Display Brightness level Yes
1kHz Tone on Color Bars Yes Genlock Input Source Yes
Test Saw Yes Reference Lock Type -
Switch & Rec Light Lock Operator Side Yes ! The following items are not saved.
Lock Assistant Side Yes : zgﬁg Networks
Rec Light Yes ® Password
Rec Start/Stop Beep Yes ® WPS
System Configuration Fan Control Yes * MAC Address
® Regenerate Password
RM/RCP Paint Control Yes
SDI Rec Remote Trigger Yes
SD HDMI Yes
Shutter Mode Yes
Special Configuration Flip Image Yes
NR(4K 17:9/16:9 AXS) Yes
Lens Configuration PL-Mt Interface Position Yes
Lens 12pin Yes
E-Mount Shading Comp. Yes
E-Mt Chro. Aber. Comp. Yes
Authentication User Name No
Password No
Network Setting Yes
LAN Yes
Wireless Yes"
APR APR -
Reset -
Battery Near End:Info Battery Yes
End:Info Battery Yes
Near End:Sony Battery Yes
End:Sony Battery Yes
Near End:Other Battery Yes
End:Other Battery Yes

Detected Battery
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Maintenance Menu

Item Sub-item File type
All
Clock Set Time Zone Yes
Date Mode Yes
Date -
Time -
Language Select Yes
Hours Meter Camera(System) -

R7 Recorder(System) -

Camera(Resettable) -

R7 Recorder(Resettable) -

Reset-Cam(Resettable) -

Reset-R7(Resettable) -

Reset to Default Reset -
License Options Install: xxx -
Anamorphic -
Full-Frame -

High Frame Rate -

Unique Device ID -

Firmware Camera -

AXS -

FW Update-camera -

FW Update-AXS-R7 -

[Note]

When Technical > System Configuration > RM/RCP Paint Control (page 68) is set to On in the full menu, the following
remote control unit items (page 87) are also saved in an All-settings file.

® Black

® Flare

e Gamma"

® Black Gamma"
® Gain

) Except when set to S-Log3.
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Licenses

MPEG-4 Visual Patent Portfolio
License

THIS PRODUCT IS LICENSED UNDER THE MPEG-4
VISUAL PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL USE OF A
CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE WITH THE
MPEG-4 VISUAL STANDARD ("MPEG-4 VIDEQO")
AND/OR

(i) DECODING MPEG-4 VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL AND NON-COMMERCIAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE. ADDITIONAL INFORMATION
INCLUDING THAT RELATING TO PROMOTIONAL,
INTERNAL AND COMMERCIAL USES AND
LICENSING MAY BE OBTAINED FROM MPEG LA,
LLC. SEE HTTP://WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/
sales of any storage media storing MPEG-4 Visual
video information (ii) distribution/broadcasting of
MPEG-4 Visual video information in any manner
(such as online video distribution service, internet
broadcasting, TV broadcasting).

Other usage of this product may be required to
obtain license from MPEGLA. Please contact MPEG
LA for any further information. MPEG LA. LL.C, 250
STEELE STREET, SUITE 300, DENVER, COLORADO
80206

http://www.mpegla.com

MPEG-4 AV( Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL
USE OF A CONSUMER OR OTHER USES IN WHICH IT
DOES NOT RECEIVE REMUNERATION TO

(i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC
STANDARD (“AVC VIDEO") AND/OR

(if) DECODE AVC VIDEO THAT WAS ENCODED BY

A CONSUMER ENGAGED IN A PERSONAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE. ADDITIONAL INFORMATION
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE
HTTP://WWW.MPEGLA.COM

On Accessing Software to which the
GPL/LGPL Applies

This product uses software to which the GPL/LGPL
applies. This informs you that you have a right to
have access to, modify, and redistribute source
code for these software programs under the
conditions of the GPL/LGPL.

The source code is provided on the internet.

Use the following URL and follow the download
instructions.
http:.//www.sony.net/Products/Linux/common/
search.html

We would prefer that you do not contact us about
the contents of the source code.

For the content of these licenses, connect the unit
to a network and view the OSS Information screen
(page 82) on the web remote control screen.

Open Software Licenses

On the basis of license contracts between Sony
and the software copyright holders, this product
uses open software.

To meet the requirements of the software
copyright holders, Sony is obligated to inform you
of the content of these licenses.

For the content of these licenses, connect the unit
to a network and view the OSS Information screen
(page 82) on the web remote control screen.
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Specifications

General Specifications

Mass Approx. 3.9 kg (8 Ib 9.6 0z) (excluding
handle, VF attachment, bottom
cover)

Dimensions

See page 116.
Power requirements
12VDC(11Vto17V)
24V DC(22Vto32V)
Power consumption
Approx. 60 W (when recording XAVC)
Operating temperature
0°Cto40°C (32 °F to 104 °F)
Storage temperature
—-20°Cto +60 °C (-4 °F to +140 °F)
Continuous operating time
Approx. 60 minutes (using BP-FLX75)
Recording format (video)
X-OCN XT (when the AXS-R7 is attached)
RAW SQ (4K 17:9, 3.8K 16:9) (when the AXS-R7
is attached)
X-OCN ST (when the AXS-R7 is attached)
X-OCN LT (when the AXS-R7 is attached)
XAVC-I Class480 (4K, QFHD)
XAVC-I Class300 (4K, QFHD)
MPEG HD422 (HD)
Apple ProRes 422 HQ (HD)
Apple ProRes 422 (HD)
Apple ProRes 422 Proxy (HD)
Recording format (audio)
LPCM 8CH (2CH recording/playback), 24-bit,
48 kHz
Recording project frame rate
RAW SQ (when the AXS-R7 is attached):
4K 17:9/3.8K 16:9
59.94P/50P/29.97P/25P/24P/
23.98P
X-OCN (when the AXS-R7 is attached):
6K 3:2
25P/24P/23.98P
6K 17:9/6K 1.85:1/6K 2.39:1/5.7K
16:9/4K 6:5/4K 17:9 Surround

View/4K 4:3/4K 4:3 Surround
View/3.8K 16:9 Surround View
29.97P/25P/24P/23.98P

4K 17:9/4K2.39:1/3.8K 16:9
59.94P/50P/29.97P/25P/24P/
23.98P

4K 4:3/4K17:9
47.95P

XAVC-| Class480:

4K: 4096x2160
29.97P/25P/24P/23.98P

QFHD: 3840x2160
29.97P/25P/ 23.98P

XAVC-| Class300:

4K: 4096x2160
59.94P/50P/29.97P/25P/24P/
23.98P

QFHD: 3840x2160
59.94P/50P/29.97P/25P/23.98P

MPEG HD422(50Mbps):

HD: 1920x1080

29.97P/25P/23.98P/59.94i/50i
Apple ProRes 422 HQ:

HD: 1920x1080
23.98P/24P/25P/29.97P/50i/59.94i/
50P/59.94P

Apple ProRes 422:

HD: 19201080
23.98P/24P/25P/29.97P/50i/59.94i/
50P/59.94P

Apple ProRes 422 Proxy (HD)

HD: 19201080
23.98P/24P/25P/29.97P/50i/59.94i/
50P/59.94P

Recording/playback time
XAVC-I Class480 23.98P

Approx. 34 minutes when using

SBP-128B/C/D
XAVC-| Class300 23.98P

Approx. 54 minutes when using

SBP-128B/C/D
MPEG2 HD422

Approx. 108 minutes when using

SBS-64G1A/B

Apple ProRes 422 HQ (HD) 23.98P
Approx. 33 minutes when using
SBP-64A/B/C/D/E
Apple ProRes 422 (HD) 23.98P
Approx. 49 minutes when using
SBP-64A/B/C/D/E
Apple ProRes 422 Proxy (HD) 23.98P
Approx. 145 minutes when using
SBS-64G1A/B/C

[Notes]

® The recording and playback times are for a continuous
recording as a single clip. The actual times may be
shorter, depending on the number of clips recorded.
The recording/playback time may vary due to usage
conditions and memory characteristics.

® 6K 3:2 50P/59.94P and 4K 4:3 50P/59.94P X-OCN recording
is supported, but playback is not supported on the unit.

Camera

Imaging device
35 mm full size, single-chip CMOS
image sensor
Number of pixels
24.8 M (total)

Built-in filters
ND filter A
Clear 0.3 0.6
(1/2) (1/4)
ND filter B Clear Clear 03 06
(172) (1/4)
0.9 09 1.2 15
(1/8) (1/8) (1/16) (1/32)
1.8 1.8 2.1 24
(1/64) (1/64)  (1/128)  (1/256)
ISO sensitivity

ISO 500 (D55 light source)
ISO 2500 (D55 light source)

Lens mount

PL mount (with lens mount adaptor)

E mount (without lens mount adaptor)
Flange focal length

PL mount: 52 mm

E mount: 18 mm

Latitude 15+ stops
Input/Qutput
Audio input
CH-1/CH-2: XLR-type 5-pin (female) (1),
LINE / AES/EBU / MIC / MIC+48V
selectable
DCinput
XLR-type 4-pin (male), 11 Vto 17V or
22V 1032V DC
DCoutput (12 V)
Hirose 4-pin (1),
11Vto 17V DC (Output voltage:
Same as input voltage, Maximum
output current: 1.0 A), 22 V to
32V DC (Output voltage: 15V,
Maximum output current: 0.8 A),
Using battery adaptor
[Notes]

® You can output a REC Tally signal and input a REC Trigger
signal through the 12V OUT connector.

e Connect to the 12V OUT connector only devices with
current consumption of 1.0 A or lower when the input
voltageis 11 Vto 17V, or 0.8 A or lower when the input
voltage is 22 Vto 32 V.

DC output (24 V)
Fischer 3-pin (2),
11 Vto 17V DC (Output voltage:
24V, Maximum output current:
1.0 A), 22 V1o 32V DC (Output
voltage: Same as input voltage,
Maximum output current: 2.0 A)
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[Note]

Connect to the 24V OUT connector only devices with current
consumption of 1.0 A or lower when the input voltage is
11Vto 17V, or 20 A or lower when the input voltage is 22 V
t032V.

SDI output BNC type (4)
3G-SDI: SMPTE ST424/425 Level B-DL/
DS
HD SDI: SMPTE ST292 compliant
AUX
LEMO 5-pin (1)
Viewfinder output
LEMO 26-pin (1)
Network
RJ45 type (1)
Remote control
8-pin (1)
MONITOR output
BNC type (1)
HD SDI: SMPTE ST292 compliant
Timecode input
TCIN: BNC type (1)
GENLOCK input
BNC type (1)
HDMI output
Type A(1)
External device connector
USB host: Type A (1)
Headphones output
Stereo minijack (1)
Speaker output
Monaural

Media Slots

Type ExpressCard/34 slot (2)
SD card slot (1)

Supplied Accessories

VF attachment (1)

Handle (1)

VF cable (A-2203-745-A) (1)

Shim (circular) (4-730-328-11) (1)
Shim (1/3 arc) (4-730-328-21) (15)

E mount lens cover (1)

Before Using This Unit (1)

Operating Instructions (CD-ROM) (1)

Optional Accessories

0.7-inch type viewfinder
DVF-EL200
7-inch type viewfinder
DVF-L700
VF cable for attaching DVF-L700
A-2201-632-A or A-2201-633-A
Camera Extension System
CBK-3610XS
Wireless LAN Adaptor
CBK-WA02
Remote Control Unit
RM-B170/B750
RCP-1000/1500/1530
RCP-1001/1501
Portable Memory Recorder
AXS-R7
SXS memory cards (SxS Pro+/5xS-1)
SBP-64/128/256E,
SBS-32/64/128G1C
Card Reader
SBAC-US30, SBAC-UT100, AXS-AR1
Shoulder Adaptor (attaches to VCT-14 using V
shoe)
VCT-FSA5

PL mount lens
SCL-PK6/F (Feet), SCL-PK6/M (Meters)
(6-lens kit: 20, 25, 35, 50, 85,
135 mm),
SCL-P11X15 (11 mm to 16 mm
zoom)
E mount lens
SELP28135G, SEL1635GM, SEL2470GM,
SEL70200GM, SELT100400GM,
SEL1224G, SEL35F14Z, SEL50F14Z,
SEL85F14GM, SELOOM28G,
SELT00F28GM
Battery Pack
BP-FL75, BP-FLX75
AC Adaptor
AC-DN2B, AC-DNT0A
Microphone  ECM-680S, ECM-678%, ECM-674*
(*: EC-0.5X3F5M 3-pin XLR to 5-pin
XLR adaptor cable required)
Dual Battery Adaptor
BKW-L200 (connection via battery
connection adaptor)
SDI/HDMI Monitor
BVM series, PVYM series, LMD series
XQD memory cards (QDA-EX1 XQD to SxS
ExpressCard Adaptor required)
QD-S64E, QD-S32E, QD-N64, QD-
M128A, QD-M64A, QD-M32A, QD-
G128A/E, QD-G64A/E, QD-G32A/E

Design and specifications are subject to change
without notice.

Notes

e Always make a test recording, and verify
that it was recorded successfully. SONY
WILL NOT BE LIABLE FOR DAMAGES OF ANY
KIND INCLUDING, BUT NOT LIMITED TO,
COMPENSATION OR REIMBURSEMENT ON
ACCOUNT OF FAILURE OF THIS UNIT OR ITS
RECORDING MEDIA, EXTERNAL STORAGE
SYSTEMS OR ANY OTHER MEDIA OR STORAGE
SYSTEMS TO RECORD CONTENT OF ANY TYPE.

® Always verify that the unit is operating
properly before use. SONY WILL NOT BE LIABLE
FOR DAMAGES OF ANY KIND INCLUDING,
BUT NOT LIMITED TO, COMPENSATION OR
REIMBURSEMENT ON ACCOUNT OF THE LOSS
OF PRESENT OR PROSPECTIVE PROFITS DUE
TO FAILURE OF THIS UNIT, EITHER DURING THE
WARRANTY PERIOD OR AFTER EXPIRATION OF
THE WARRANTY, OR FOR ANY OTHER REASON
WHATSOEVER.

® SONY WILL NOT BE LIABLE FOR CLAIMS OF
ANY KIND MADE BY USERS OF THIS UNIT OR
MADE BY THIRD PARTIES.

® SONY WILL NOT BE LIABLE FOR THE LOSS,
REPAIR, OR REPRODUCTION OF ANY DATA
RECORDED ON THE INTERNAL STORAGE
SYSTEM, RECORDING MEDIA, EXTERNAL
STORAGE SYSTEMS OR ANY OTHER MEDIA OR
STORAGE SYSTEMS.

® SONY WILL NOT BE LIABLE FOR THE
TERMINATION OR DISCONTINUATION OF ANY
SERVICES RELATED TO THIS UNIT THAT MAY
RESULT DUE TO CIRCUMSTANCES OF ANY
KIND.
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Trademarks

® XAVC and are registered trademarks of
Sony Corporation.

® The terms HDMI and HDMI High-Definition
Multimedia Interface, and the HDMI Logo are
trademarks or registered trademarks of HDMI
Licensing Administrator, Inc. in the United States
and other countries.

® All system names and product names are
registered trademarks or trademarks of their
respective owners. Trademarked items are not
indicated by ® or ™ symbols in this document.
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